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Project Management
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Enterprise Architect has been built from the ground up with
the Project Manager in mind. Organizational repositories are
valuable corporate assets and must be managed and
maintained accordingly. Risk can be modeled and managed
in a variety of locations, and project effort can be
determined with built in support for Metrics and Estimation.
Tasks can be created and assigned to Resources performing
particular roles, and these can be conveniently viewed 1n a
built-in Gantt Chart. There 1s an Audit function that allows
changes to be tracked at a fine grained level, and a Team
Library facility and Element Reviews and Discussions that
allow users to work collaboratively on models.

“.&QW‘@

Each element in Enterprise Architect has a number of
default properties that are useful for project management,
such as phase, version, status, author and creation and
modified dates. Using these, coupled with the powerful
reporting engine, the information can be extracted easily
even by a novice user. The Project Manager and other users
have the ability to create elegant charts that depict the
information 1n the repository in a compelling visual format.
For example, a pie chart could be created to show the status
of stakeholder requirements for a particular phase of the
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project.

Facilities

Facility Detail

Metrics and | Project estimation 1s working out how
Estimation much time and effort is required to build
and deploy a solution.

Enterprise Architect provides the Use
Case metrics facility as a means of:

e Measuring the complexity of a system

e Getting an indication of the effort
required to implement the model

e Getting an indication of the project
timescale

Y ou base these estimates on
carefully-calibrated metrics.

Resource Resources are the people who work on a
Management | project.

You can assign roles to resources and
allocate tasks on specific model elements,
which enables tracking of effort and
estimation of time to complete.

Project During a project you monitor and manage
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Maintenance @ the development and progress of
individual model elements.

You can record problems, changes, 1ssues
and tasks that affect these individual
clements as they arise, and document the
solution and associated details.

Similarly, Enterprise Architect helps you
to manage changes and issues that apply
to the whole system.

Process Developing a model of a system or

Guidance architecture can include any number of
complex processes that require common,
structured methods and carefully
organized checkpoints at important
stages. Enterprise Architect helps you to
define and represent the organization of
such a process by providing a range of
Process Guidance templates, each of
which includes stages, annotated steps for
the procedures at each stage, links to
supporting information, and Checklists to
be completed as the required objectives
have been achieved.

Project Tasks = In the course of a project, there are

and Issues various non-technical tasks that are vital
to the successful management and
completion of the project, such as
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meetings.

Enterprise Architect helps you to record
and monitor these, and to manage
non-technical project issues as they arise.
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Kanban Features

Background

Kanban, which literally translates as Visual (Kan) Card
(Ban) or billboard, is an operational method used to increase
efficiency. It was originally developed by the industrial
engineer Taiichi Ohno while working at Toyota. Ohno
analyzed the way supermarket shelves are stocked and
applied the lessons learnt to the factory floor, creating
unprecedented efficiency. The visual card (Kanban) was
used to signal the need for more items to upstream suppliers
on the production line. The Kanban method can be applied
to any field, including strategic planning, sales and
marketing, and human skills management, but more recently
Kanban has been applied to the process of developing
software-centric solutions in an attempt to ensure that value
1s delivered to the customer as quickly as possible. The
information technology industry has been plagued since its
beginning with projects running over schedule and over
budget, but more significantly failing to deliver value to
customers in a time frame that enables them to compete and
be successful. These endemic issues have become a critical
element of business in an age dominated by digital
disruption and unprecedented change.

Principles
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Kanban is fundamentally very simple and relies on a small
number of principles, the origins of which can be attributed
to the engineers at Toyota:

e Make work visible
Traditional project management methods hide the work
items from the people who carry out the work; Kanban
exposes the work to everyone, allowing any team member
to contribute to the way work items flow through the
board and ultimately deliver value to the customer

Backlog Queue In Progress (4/6) Test/Review

As a Customer | want to be As a Sale Representative |
able to add new orders to want to be able to view
existing ones if they have not historical leads

As an Administrator | want to
be able to have a
maintenance window to

As a Warehouse Manager |
want to be able to determine
the best product location to
update online web pages and minimize picking errors

content

shipped

UserStory
Defect UserStory
lane Ward

Paulene Dean B ] Devel..

E 1 Busin

UserStory
Yuki Ketabashi

e Limit work in progress
Project managers and team leads have traditionally been
under pressure to get products finished or to include more
features, and have responded to this pressure by
burdening the team with more work items; this results in
lots of focus switching and inevitably half-finished items
and reduced efficiency
Paradoxically, Kanban encourages the number of items in
progress to be limited, resulting in greater efficiency and
more finished items; the reduced number of in-progress
items allows team members to concentrate on one thing at
a time without having to switch focus
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MName Max ltems Colar Default Unbound

Backlog 0 |:| Default W
Queue 20 |:| Default
{In Progress B |:| Default
Test/Review 3 [ ] pefaut
Daone 20 |:| Default
Deploy 50 |:| Default

e Manage the flow of work
Using traditional project management methods,
bottlenecks or blockers are hard to identify and typically
only surface at the time of a post project review, often
only after the product is delivered late and missing
features
Using Kanban, the visibility of work and the ability to
identify stalled processes - whether because of bottlenecks
or lack of work items - allows a flow problem to be
identified and rectified quickly
The next diagram shows the way the Kanban facility in
Enterprise Architect responds when the number of items
in a lane exceeds the number specified in the max items
(Work in Progress or WIP limit) value for that lane; the
header 1s highlighted in a configurable color and the
numbers (number of items/max items) also provide a
visual cue that will prompt the team to respond by
swarming (a number of team members focusing) on the
lane to reduce the number of items
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a4
As a Customer | want to be
able to add new orders to
existing ones if they have not
shipped

Defect

Paulene Dean
1 Busin..

As a Customer | 'want to be
ahle to view the status of my
order

UserStory

User Guide - Project Management

In Progress (7/6)

dig:
As a Sale Representative |
want to be able to view
historical leads

UserStory

lane Ward
""" Devel.

As a Reviewer | want to be
able to be able to add and edit
rules in the online grammar
checker

UserStory

Pat Taylor
[— | (++Pr..

21 December, 2018

Test/Review

A
As a Warehouse Manager |
want to be able to determine
the best product location to
minimize picking errors

UserStory

Yuki Kotabashi
[—— ] TestA..

L

As a Customer | want to be
ahle to rent an item for a
specified duration

UserStory

Paulene Dean
=" TestA.

Example

A high priority User Story that is at the top of the backlog
could be pulled into the 'In Progress' lane and a developer
could immediately commence work on it. The work might
entail the coding of business rules, the review of detailed
requirements, changes to a database schema or the addition
of an element or attribute to an information schema, and the
creation of a new or updated deployment environment.
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In Progress (5/6)

-0

As A Student | want to buy
books at Academic Prices

Userstory

Pat Taylor
— C++ Pr...
L o

All of these artifacts can be found inside the same repository
without the need to launch other tools or schedule meetings
to locate the needed information. The strategic drivers can
be seen 1n the context of their business owners, architectural
design and principles can be viewed, Business Rules can be
visualized in relation to the policies they qualify, a live
connection can be made to the databases and their schemas
analyzed and altered, XML schemas can be inspected and
messages constructed, programming code can be written and
deployment targets detailed, and all of this achieved in a
single collaborative platform.

c) Sparx Systems age 150
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Rules Analyzer

=

This is a customer built rules
engine used to manage
configuration items. It has been
extended to allow rules to be
viewed and updated through a
business web interface.

|
.
«trace»

As AStudent | want to buy
books at Academic Prices

Requirement «UserStory»
Version: 1.0 Phase: In Progress
Priority: High

A

|

|

|
«trace»

1

|

S|

Student Verification

«column»
ID: NUMBER(8,2)
INSTITUTION NAME: NVARCHAR(50)
YEAR: NUMBER(4,2)
STUDENT NUMBER: VARCHAR2(20)

Example

21 December, 2018

«goal» []:)
Provide customers with a
competitive online shopping = ST~~~ "~~~ -7~ 1
experience |
|
|
(from Goals) «tra‘ce»
|
|
|
|
|
!
«business rule» ( «policy» ()]
Any person studying who is under The bookstore will provide
theage of 27 with student =~ = +~——————— discounts to students to
————— identification is considered a «enforces» encourage learning
trace student
(from Buszp\?ss Rules) (from Policies)
|
|
|
«tra‘ ce»
|
|
1 T\
REQ117 - The system must provide E ° o
= amechanism allowing studentsto | — _ _ _ _ _ _|
Name
(from Take Orders) | |
Institution
A United States
Stanford
Harvard
: Student Number
This Requirements diagram
shows a User Story that has
b.een added toa‘Kanban
diagram expressing the
relationships to a number of
business and technical e (=] =
elements.

This diagram demonstrates a Backlog diagram in a two or
three stage workflow. The entire diagram 1s used to manage
the backlog and items can be dragged within a lane to define
their order in that lane, or between lanes to define their
importance and position in the backlog.

(c) Sparx Systems 2018
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Backlog

Eakaban Digram: "Badog

21 December, 2018

Low Medium High Critical
A .
As a Customer | want to be Prices for some publishers do As a Marking Manager | want As a Customer | want to be
able to read peer reviews for not include internal storage to be have a dashboard that able track my item on a map
items before purchasing costs shows sales by demographics
and regions Userstory
UserStory Defect Proposed
Proposed Proposed UserStory Version 1.0Ph 10
Version 1.0 Pha 10 Version: 1.0 Ph 10 Proposed
Version 1.0FPh 10
A &
As a Warehouse Manager | As an operation manager |
want to be able to find ‘ ) want to be able find picking
unallocated space for future The default purchase date errors caused by system
dates order should be reversed in all glitches
Product reports
UserStory UserStory
Proposed Change Proposed
Version 10Ph 10 Proposed Version 10Ph 10
Version: 1.0 Ph 10
Flexibilit

Enterprise Architect has a flexible and integrated Kanban
facility built into the core product, allowing projects of any
size and vertical market to benefit from the profound
efficiencies that come with this simple, elegant and lean
project management approach. Regardless of the type of
process that is being used, Enterprise Architect’s Kanban
features can be quickly and seamlessly integrated into any
method, creating a compelling visual solution and team
collaboration platform that will result in products, services
and solutions being delivered to customers with efficiency
and 1n record time - delighting both product owners and
customers alike.

The Kanban features in Enterprise Architect are highly
configurable and can be altered to suit any team and
process, including Agile, iterative and incremental, and even

c) Sparx Systems age 170
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waterfall projects. There is a very low barrier to adoption
and teams can commence with Kanban immediately. The
most basic Kanban board consists of a diagram divided into
a small number of lanes; a range of work items can be added
to the diagram, including Features, User Stories, Defects,
Changes, Use Cases, Requirements and more. Work Items
can be drawn with a compelling visual style representing a
colored card, and can be dragged anywhere in the diagram
to change order in a given lane, or from lane to lane
progressing from left to right through the board,
representing progress towards value for the customer. The
lanes are typically bound to the values of a 'project
management aware' property such as status or phase, and as
the item 1s dragged from lane to lane the value of the bound
property 1s automatically changed.

Resource Allocation

Any number of resources, performing specified roles, can be
allocated to work items as they flow through the Kanban
board, and the progress can be visualized as one or more
progress bars displayed at the bottom of the card. The
allocation 1s driven by Enterprise Architect's practical and
simple resource allocation facility, which can be used to
define the relationship between resources (team members)
and work items (cards). Any number of team members can
assign themselves to a work item, indicating the role they
will perform, and the start date, finish date, and the expected
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time can be used to record estimates of how long the task
will take.

In Progress (5/6)

As a Sales Representative |
want to be able to view
historical leads

UserStory

lane Ward
= ] Devel...
Pat Taylor
— ] C++ Pr...

Progress can be updated as a percentage of completion,
which can be displayed visually on the card. The Kanban
board (like any diagram) can also be displayed as a Gantt
chart or a list view, supporting alternative project
management representations.

Resource Allocation

BEHEX o BE @

Resource Role Regource: Jane Ward - | Stat Date:  09-062016 ~  Expected Time: 3
éJane Ward Developer _ Rele or Task: | Developer - || End Date: 13062016 *  AMlocated Time: 3
Pat Taylor C++ Programmer |* Complete %: 15 : Time Expended: 2

Drescription | History

Configuration

The Kanban cards can be configured to display an extensive
set of properties, with compelling icons, colors and progress
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bars to communicate the important aspects of the work item,
resource allocation and work item progress. The properties
include the item name, type, status, version, priority,
stereotype, phase, author and more.

In Progress (2/8)

dm o
As a Stock Control Manager | want to be
able to list stock levels for a selection of

titles.

Userstory
Version: 1.0

Paulene Dean
I Business A .
. #

The names, colors and number of lanes can be configured,
in addition to a range of other properties such as the overfill
limits, defaults and the definition of sub-lanes. The
appearance of the board and the work items can all be
configured, using different colors, fonts and styles including
a hand-drawn mode that might appeal to teams more
accustomed to using a physical board with colored notes. It
1s also possible to set the chart appearance to highlight
elements that come from the same hierarchies.

Enterprise Architect has built-in Kanban diagrams, and a
number of workflow Patterns that are pre-built and that can
be used 'As-Is' or configured to suit any project or initiative.
The workflow Patterns define one, two or three stage
workflows; for example, the two stage workflow defines a
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Kanban board solely for managing the prioritization of the
backlog, and items from the backlog are then moved from
the backlog Kanban to the first lane of the iteration Kanban.
If necessary, the Product Owner can use Enterprise
Architect's security facility to lock the backlog Kanban,
ensuring that the order of items in the backlog is not
inadvertently changed.

There are a number of commercial tools that allow Kanban
to be used to manage projects visually, but Enterprise
Architect’s Kanban facility 1s incredibly powerful because
the tool is also a sophisticated modeling platform for
strategic and business analysis, architecture, design,
implementation, testing and deployment. This means that
work items on a Kanban Board can be linked to strategic
decisions, business rules, policies, requirements,
architecture and design elements, wireframes and UX
models, programming code, database tables, procedures,
tests, virtual or physical deployment nodes, and more. For
the first time everyone in the team can collaborate in the
same environment using a toolbox of facilities purpose built
for their discipline, while at the same time being able to
visualize and manage the value being delivered to the
customer in a powerful and visually compelling set of
Kanban boards.

Charts and Dashboards

Enterprise Architect has a sophisticated charting facility that
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can be used to create powerful and expressive charts and
dashboards that will provide insights into the Kanban
process and enable Product Owners and other team
members to monitor performance and determine ways of
fine tuning how the team is working. There is a range of
built-in charts including bar and pie charts, heat maps and
more but a team 1s free to create any number of user-defined
charts and these can be incorporated into team processes and
reviews.

Completed Tasks Last Week

Ali Evans

Alma Cogan

Billy Bunter
Bob Brown
Brett Chambers

Carlos Wallace

H Test

Eric Burns

Ethan Rogers

Frank Mclver
Josh Morgan i 30
Liam Cross
Nigel Molesworth
Pat Taylor |
Penny Dark |
Peter Ryan

Philip Marlowe

Application

H Rework

H Review

H Proposal
Investigate

B Implement

The Kanban project management methodology helps you to

(c) Sparx Systems 2018
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develop a dynamic, easy-to-view progress summary of the
stages of development of a project, where the stages are
represented as lanes and sub lanes of a diagram - a Kanban
Board. In Enterprise Architect, you can apply a form of this
methodology to your project administration diagrams to
monitor and manage the flow of work in a particular area.

The stages of development can be defined by the value of a
project management property of an element, such as Phase,
Version or Status, or a user-defined Tagged Value. The
clements that represent each task or object of a task are
initially placed in the lanes for the earlier stages of the
project, and work on the task is reflected by moving the
corresponding element to a different lane on the diagram. If
a diagram 1s linked to a project management property,
dragging an element from one lane to another automatically
changes the value of the property to the value that the lane
represents.

In this illustration, the lanes identify what work is being
performed in each stage of development.
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Backlog Queue In Progress (4/6) Test/Review Done Deploy

ssssss

New tasks will usually begin in the left-most lane, and
completed tasks will usually pass through all lanes before
coming to rest in the right-most lane and then being moved
off the diagram. A typical workflow is to choose the next
task that you are going to work on by starting in the
right-most lane and seeing if it has any tasks that you are

able to progress; if not, move to the next lane and repeat,
and so on
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MDG Technology for Kanban

The MDG Technology for Kanban Diagrams provides
diagram types and patterns that underpin the creation of
Kanban diagrams. Whilst it is possible to create Kanban
diagrams from most UML diagram types and design the
workflows on them from scratch, these diagram types and
patterns help you to generate a Kanban that matches your
requirements and then adjust the settings to suit, thus saving
time and effort.

Access

On the 'MDG Technologies' dialog, in the "Technology’
panel, select 'Kanban' then click on the 'Enabled' checkbox
and on the OK button.

Ribbon Specialize > Technologies > Manage

Kanban Diagram Types

The MDG Technology for Kanban Diagrams provides four
kinds of pre-defined Kanban diagram, as described here. To
create one of these diagrams, open the 'New Diagram'
dialog, use the 'Select From' header to select the 'Software
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Construction > Kanban Perspective' in the left-hand pane
and choose one of the diagram types from the right-hand

pane.

Diagram
Type

Basic

Backlog

Iteration

(c) Sparx Systems 2018

Description

The Basic Kanban diagram contains these
lanes:

. Backlog

. Queue

. In Progress
. Done

The Basic Kanban diagram doesn't have a
lane binding to any element property.

The Backlog Kanban diagram contains
these lanes:

. Low

. Medium
. High

. Critical

The lanes are bound to the element
Priority, so that moving elements
between lanes will automatically update
their Priority to the name of the lane.

The Iteration Kanban diagram contains
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these lanes:

. Queue

. In Progress
. Test/Review
. Done

The lanes are bound to the element Phase,
so that moving elements between lanes
will automatically update their Phase to
the name of the lane.

Complete The Complete Kanban diagram contains
these lanes:

. Ready for Release
. Staging

. Production

. Done

The lanes are bound to the element Phase,
so that moving elements between lanes
will automatically update their Phase to
the name of the lane.

Kanban Workflow Patterns

Kanban Workflow model Patterns help you to very quickly
set up a one, two or three stage workflow, using and linking

c) Sparx Systems age 270
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the Backlog, Iteration and Complete Kanban diagrames.

Workflow Description

Pattern

1-stage The 1-stage Workflow Pattern consists of

Workflow a single Kanban diagram with the

Pattern Backlog, Queue, In Progress,
Test/Review, Done, and Deploy lanes.
These lanes are linked to the Phase
property of elements, so that moving
clements between lanes will
automatically update their Phase to the
name of the lane.

2-stage The 2-stage Workflow Pattern consists of

Workflow two related Kanban diagrams:

Pattern . A Backlog Kanban diagram with Low,

Medium, High and Critical lanes linked
to the Priority property of elements, so
that moving elements between lanes
will automatically update the Priority
to the name of the lane, and

. An Iteration Kanban diagram with
Queue, In Progress, Test/Review, Done
and Deploy lanes linked to the Phase
property of elements, so that moving
elements between lanes will
automatically update their Phase to the
name of the lane
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Each diagram also has a drop zone that
helps you to move elements easily
between diagrams. Simply drag the
elements onto the appropriate zone
(having the name of the diagram to move
clements to) and select either 'Move to' to
move the element to the new diagram, or
'Create link on diagram' to create a link
on the second diagram without removing
it from the current diagram.

3-stage The 3-stage Workflow Pattern consists of
Workflow three related Kanban diagrams:
Pattern . A Backlog Kanban diagram with Low,

Medium, High and Critical lanes linked
to the Priority property of elements, so
that moving elements between lanes
will automatically update the Priority
to the name of the lane

. An Iteration Kanban diagram with
Queue, In Progress, Test/Review, and
Done lanes linked to the Phase property
of elements, so that moving elements
between lanes will automatically
update their Phase to the name of the
lane, and

. A Complete Kanban diagram with
Ready for Release, Staging and
Production lanes linked to the Phase
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property of elements, so that moving
clements between lanes will
automatically update their Phase to the
name of the lane

Each diagram also has a drop zone that
helps you to move elements easily
between diagrams. Simply drag the
elements onto the appropriate zone
(having the name of the diagram to move
clements to) and select either 'Move to' to
move the element to the new diagram, or
'Create link on diagram' to create a link
on the second diagram without removing
it from the current diagram.
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Kanban Tasks

Create a Kanban Diagram

A Kanban diagram 1s a board that allows team members to
visualize work items that are represented as colored cards.
The board 1s divided into a number of lanes and team
members move the cards from left to right as work is
completed towards providing value to the customer.

You can create a Kanban diagram by taking an existing
diagram and setting its Kanban properties, but it is easier to
use one of the diagram types provided by the MDG
Technology for Kanban Diagrams as a starting point and
then change its properties to suit your own project.

Ste Action
p

1 | Inthe Project Browser, right-click on the parent
Package and select the 'Add Diagram' command.

2 Inthe 'New Diagram' dialog, use the 'Select From'
header to select the 'Software Construction > Kanban
Perspective' in the left-hand pane and choose one of
the diagram types from the right-hand pane (Basic,
Backlog, Iteration and Complete). Give the new
diagram a name in the 'Diagram' field and click on
the OK button.

(c) Sparx Systems 2018 Page 31 of 333



User Guide - Project Management 21 December, 2018

Package : |Project Core ==

Diagram :  Project Core Auto
Type
Select From: -~ Diagram Types:
&l Entity Helationship Diagram ’EIE Baere
EIErikssu:un-Penker Extensions : 'EIE Backlag
EFE&F Diagrams 'EIE Tteration

(Ef cm B Complete
(S} GRA-UML

@ Kanban

= LieberLieber Autosar Engineer
[=]Mind Mapping

[=} MIEM

[SfMIEM 3.0

(=7 oDm

[EF] Owner (Zachman Framework)
EE]Planner (Zachman Framewaork)

Kanban

QK Cancel Help

3 | If you cannot find 'Kanban' in the list, you must
enable the Kanban MDG Technology.

Add Elements to a Kanban Diagram

Work items are represented visually on a Kanban diagram
but first must be added to the diagram. They can be
clements that already exist in the repository or new elements
dragged from the Kanban toolbox and dropped onto the
diagram. Any element type can appear on a Kanban board
but the most typical types are Features, User Stories,
Defects and Changes, Use Cases, Scenarios and
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Requirements are also sometimes added.

When you drop an element onto a Kanban diagram, the lane
it 1s added to depends on whether the diagram has a property
value defined, and also whether it has a default lane. If the
Kanban diagram has a property value defined and the new
element's property matches one of the lanes, then it will be
added to that lane. Otherwise, it will be moved into the
default lane, or to the right of the last lane if no default lane
has been nominated.

You can define the Default lane on the 'Lanes' page of the
'Kanban Options' dialog.

The Kanban Toolbox page will open automatically
whenever you open a diagram created from the MDG
Technology for Kanban Diagrams. The Toolbox page
provides a default set of elements that you can use to
represent units of work on your Kanban diagrams, but any
type of element can be added.

Ste Action
p

1 | Open your Kanban diagram. The Diagram Toolbox
should appear with the Kanban page selected
automatically.

. Ifthe Diagram Toolbox doesn't appear, click on
the >> button in the top left corner of your
diagram

. If the Kanban page isn't automatically selected,
click on = to display the 'Find Toolbox Item'
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dialog and specify 'Kanban'

2 | Drag elements from the Kanban page onto the
Kanban diagram. The page provides these element

types:
Toolbox v 1 ox
Search L0 =
Elements
”'Hﬂ Change
Defect
I Feature

User Story

Import a Kanban Workflow Pattern

Each organization or team will typically want to define their
own workflow that is appropriate for the initiatives they
work on, and each might have a number of workflows
defined for different types of initiative. While this can be
done from scratch it 1s much easier to use one of the built-in
Patterns, either 'As-Is' or as a starting point. A workflow can
be made up of any number of Kanban boards linked together
into a single workflow; for example, a three stage workflow
would contain three separate boards. Each board can be
configured with any number of lanes and sub-lanes
representing the stages in that part of the workflow. Team
members can move Work Items between lanes in a single
board and also between the boards that make up the entire
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workflow.

Kanban Workflow model Patterns help you to very quickly
set up a one-, two- or three-stage workflow, using and
linking the Backlog, Iteration and Complete Kanban
diagrams.

Ste Action

P

1

In the Project Browser, select the Package under
which to create the Workflow Pattern.

Click on the Project Browser header and select the
'New Model from Pattern' option, or press
Ctrl+Shift+M. The Model Wizard window displays.

Select the 'Model Patterns' tab, then click on the
Perspective drop-down arrow and select 'Project
Management > Kanban'. The panel header changes
to 'Kanban Perspective' and the panel shows the
three workflow patterns you can select.

. Kanban One Stage Workflow
. Kanban Two Stage Workflow

. Kanban Three Stage Workflow

When you click on one of the patterns, the right hand
panel displays an example diagram and several
sections of useful information on using the pattern.
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®5tan:F‘age @SpecificationManager ngheGame I\r1oc|el‘.'."izard x 4 F

Model Patterns | Process Guidance Executable Patterns Application Patterns  VEA Examples

Kanban Perspective hd -~
P Panand Zoom
4 Kanban Workflows The Pan and Zoom facility is one of the tools that can be used to navigate
[E] Kanban One Stage Workflow around a large diagram. Often the resolution of a diagram must be reduced to
[E] Kanban Two Stage Workflow ensure it is wholly visible but by using the Pan and Zoom window you can leave
{ [2] Kanban Three Stage Workflow . the diagram at a readable resolution and pan around to areas of interest
zooming in when necessary. For more details see the Pan and Zoom help
topic.

Diagram Legends

The Diagram Legend facility is useful for manually or automatically changing
the appearance of elements and connectors on a diagram. A legend can be
added from the Common Toolbox and configured to codify the fill and line color
and line thickness. This is a powerful way to add meaning and expression to a
diagram and is particularly expressive when applied automatically based on
element or connector properties. It can be used with a number of specialized
diagrams such as roadmaps to create a powerful visualization. For more

details see the Diagram Legends help topic.

Create Pattern(s) Add To:  Kanban for Manage Users | Customize Pattern on import

4  If you have the 'Customize Pattern on import'
checkbox selected, prompts display to select the
Packages to import in the Patterns. Each Pattern
contains one Package, which is automatically
selected. Click on the OK button for each Pattern.

5 | Open each of the new diagrams and consider
whether they fit with your own workflow
preferences. The diagrams provided can be changed
to suit your style of working.

Moving Kanban Items

Work Items flow through Kanban boards typically from left
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to right as work 1s performed, moving the item closer to
delivering business value for the customer. In a one-stage
workflow, work items will be moved through a series of
lanes through a single board, but in workflows that consist
of more than one Kanban board the items will also jump
from one board to the next. For example, in a two stage
workflow there 1s a backlog board and items will be
prioritized in the board based on their priority. The work
items that have the highest priority in the Backlog then need
to be moved to the Iteration Board, where implementers will
pull them into the In-Progress lanes.

Moving Items in a Kanban Diagram

Moving items within a Kanban diagram 1s simple and
intuitive and can be achieved by dragging and dropping a
work item from one location to another. If an item is moved
within the same lane its position 1s simply changed in that
lane. If an item is dragged to a different lane and the lanes
are bound to an element property or user defined Tagged
Value the value of the item's property or tag will also be
changed.

Ste Action
p

1 | Select the item in the Kanban diagram.
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2 Drag and drop it into a new position either in the
same lane or a different lane.

Notes

When an item is moved between lanes and the lanes are
bound to a property or Tagged Value, the value of the
property or Tag will be automatically changed.

Example

Backlog Queue

As a Reviewer | want to be As a Customer | want to be able to delete
able to be able to add words items from my order before it is shipped

to the online dictionary
UserStory

UserStory

L " L. "

B Z % T

Stock levels on financial <f
reports don't include returned § O,
items i

Defect

—
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Moving Iltems between Kanban Diagrams

Items can be moved between Kanban boards by using a drop
zone positioned to the right of the diagram. Each drop zone
has the name of another diagram in the workflow, and
elements on the current board can simply be moved by
dragging and dropping them on the appropriate drop zone.

To create a drop zone, simply drag the target Kanban board
onto the current Kanban diagram and release the mouse
button. In response to the prompt, select the 'Drop Diagram
as Diagram Reference' option. You can have more than one
drop zone, one for each of the other Kanban boards in the
work flow. If you generate a set of Kanban workflow
diagrams using the Patterns in the Model Wizard, the drop
zones are automatically generated on each diagram.

Ste Action
p

1 | Select the item in the Kanban diagram.

2 | Drag the item to the right of the Kanban diagram
Lanes.

3 | Drop the item onto the zone with the name of the
diagram you are moving the element(s) to.

4  Select 'Move to' to move the element to the new
diagram or 'Create link on diagram' to create a link
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on the second diagram without removing the element
from the current diagram.

Example

In this diagram a work item representing a defect is being
moved from the critical lane of a Backlog Kanban board to
the Iteration board.

High Critical

R £l

ilteration
1

.

As a Marking Manager | want é As a Customer | want to be
to be have a dashboard that able track my item on a map
shows sales by demographics
and regions

RN RN
O M
R

As a Customer | want to be
‘ @ able to add new orders to
As a Warehouse Manager | existing ones if they have not
want to be able to find shipped
unallocated space for future
dates

Paulene Dean
E_—_— 1 Busin..

Search for Kanban Diagrams

A well organized repository will assist in quickly locating
specific Kanban diagrams, but in large and complex
initiatives it 1s common for some team members to need to
search for Kanban Boards. Enterprise Architect has an
easy-to-use yet sophisticated search facility with a built-in
search to find all Kanban diagrams in the repository. Having
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located a diagram the user can continue moving objects
from left to right across the board, contributing to the team's
effort focused on providing value to the customer.

Ste | Action
p

1 | Select the 'Construct > Task Management > Kanban
> Find Kanban Diagram' ribbon option.

The search is immediately executed and the located
diagrams are listed in the Find in Project view.

2 Double-click on any Kanban diagram that you want
to open.

Layout Filter Panel

A project of any appreciable size will typically have a large
number of in-flight work items, and product owners and
team members will often want to filter the selection of items
based on a set of conditions, such as high priority
requirements or those applying to particular stakeholders or
people. This can be achieved using filters at two levels;
either the expedient ribbon Filter or the more sophisticated
and persistent Diagram Filters facility.

Kanban diagrams with a large number of elements can be
quickly filtered in real time using the Layout ribbon Filter
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panel.
1. Access the Filter panel.

2. Select the Filter property and the operator (if appropriate),
and specify a search term.

Mame / Alias - -

Filter

Elements not matching the specified condition will be
obscured in the filtered diagram.

Backlog Queue In Progress (3/6) Test/Review

As a Custormer | want to be
able to add new orders to
existing ones if they have not
shipped

Defect

Paulene Dean
1 Busin..

¥
As a Customer | want to be
able to delete items from my

Li

- LT As a Customer | want to be As a Custormer | want to be
order before it is shipped able to view the status of my able to rent an item for a
order specified duration
UserStory
UserStory UserStory

Paulene Dean
— ] TestA
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Enterprise Architect provides a number of options for
generating a new Kanban diagram or for opening an existing
Kanban diagram. Having opened the diagram, you can
define its structure, content and appearance. It 1s also
possible to configure a diagram of any other type to be a
Kanban diagram, by simply adding Kanban properties to it.
This powerful design feature means that a diagram
containing, for example, a set of User Stories could simply
be changed to a Kanban diagram and the team could
immediately begin using this flexible, lean, project
management method.

To define the structure, content and appearance of a Kanban
diagram, you use the 'Kanban' dialog.

+ Configuration

Sub-lanes

Appearance

Advanced
Filters

Use this page to bind a Kanban to a property or tagged value (moving elements into a
lane will change the property) and to create the main lanes for the diagram.

Properties

~| Enabled Show Names in Title Bar Swimlane width locked

Bind Kanban to:

Name Max Items Color Default Unbound

ToDo 0 [] deear1
In Progress 0 D desdfl
Review 5 D deesdfl
Done 0 |:| deedfl
New Modify Delete

Help
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When you display the 'Kanban' dialog, it defaults to the
'Configuration' page. You use this page to:

. Set up basic Kanban properties, such as whether Kanban
is enabled on the diagram, if the names are shown in the
title bar of the diagram and if the width of each swimlane
1s locked, and

. Create, modify and delete the primary lanes on a Kanban
diagram; you can:
- Create the lanes manually, or define a property that
the lanes bind to, so that the lanes
are generated automatically from that property when
you click on the Fill from binding button
- Add lanes that are not bound to the property
For each lane you can define:
- The maximum number of elements that can be placed
in the lane before triggering
the 'Overfilled' indicator
- The fill color of the lane
- Whether it 1s the default lane that new elements are
added to

Access

Ribbon Construct > Task Management > Kanban
> (options to generate and/or open a
Kanban diagram) or
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Context
Menu

Start > Collaborate > My Kanban
(displays personal default Kanban
diagram)

Then
Design > Diagram > Edit > Kanban (on
an open Kanban diagram)

On a Kanban diagram, double-click on a
lane

On any other type of diagram, right-click
on background | Kanban

Configuration Options

Option
Enabled

Show Names
in Title Bar

(c) Sparx Systems 2018

Action

Select the checkbox to apply any of the
Kanban functionality to the diagram. If
the checkbox 1s not selected, the diagram
will behave as a non-Kanban diagram.

Select this checkbox to display the lane
names (but not the sub-lane names) in the
diagram title bar, above the lanes. These
will be visible once the lanes are defined.
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Swimlane
width locked @ Select this checkbox to prevent the lanes

in the diagram from being made narrower

or wider.

Bind Kanban B

to Click on the [-) button and select the
property to bind lanes to. This will be one
of:

. Element, or

. Tagged Value (enumeration or string
types only), or

. None (makes all lanes unbound).

If you select 'Element’, also select one of
the properties 'Phase’, "Version', 'Priority’
(for Requirement-type elements), 'Status'
or 'Author’.

If you select "Tagged Value', also choose
to either 'Create' a new tag (and simply
type in the name) or 'Select' an existing
one.

In the latter case, the 'Kanban Tagged
Value selection' dialog displays, on which
you click on the appropriate radio button
to select either from a list of 'Global
Tagged Values', or from a list of 'Tagged
Values from a selected element'. Click on
the Select Element button to browse for
the element anywhere in the model.

The Global Tagged Values or those from
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the element are provided to the "Tagged
Value' field. Click on the drop-down
arrow on the right of the field and select

the reference Tagged Value from those
listed. Click on the OK button.

The 'Bind Kanban to' field now displays
either the element property or the Tagged
Value you have selected.

Fill from
binding If you have chosen an element property

to bind the Kanban lanes to, click on the
Fill from binding button to fill the lane
list with existing values of that property.
This will delete all old lanes before
creating a new lane for each of the new
values. Once the lanes have been created
in this way, they can be renamed,
reordered and added to.

Name
The name of each lane can be filled

automatically using the Fill from binding
button. You can overtype the names;
these do not have to be unique but they
cannot be blank.

Max Items
You can set the maximum number of

clements that can be placed in each lane.
If someone tries to move an element into
a lane that has reached or exceeded its
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maximum number, the heading of the
lane will be displayed in the 'Overfilled'
color you define and enable on the
'Appearance’ page. This gives a visual
indication that action might have to be
taken to clear what appears to be a
bottleneck in the workflow process.

Color
Several or all of the lanes can have the

same fill color, or you can set a different
color for each lane independent of the
other lanes. Either:

. Leave the 'Color' value set to 'Default’
(set on the 'Preferences' dialog,
'Gradients and Background' page), or

. Overtype 'Default’ with the hex code
number for the required color, or

. Click on the drop-down arrow and
select a color from the displayed palette

The actual color is shown in the box at
the left of the field.

Default
You can nominate one of your lanes as

the default; that 1s, the lane to which new
elements are added if they don't match
the binding property. For example, if a
Kanban diagram is bound to 'Priority' and
has the lanes 'Low', 'Medium' and 'High',
with 'Low' as the default, when an

(c) Sparx Systems 2018 Page 48 of 333



User Guide - Project Management 21 December, 2018

Unbound

(c) Sparx Systems 2018

clement with a Priority of 'Undetermined'
1s added, 1t will be placed into the default
'Low' lane. You can only select one
'Default' checkbox; clicking on a

checkbox clears any previously-selected
checkbox.

The Unbound property essentially makes
a primary lane the same as a sub-lane.
Moving an element into an unbound lane
will set the element's bound property to
the left most bound lane. Consider a
'Phase' Kanban diagram with these lanes,
in order:

. To Do (Default, Unbound)
. Implement (Bound)
. To Do (Unbound)
. Review (Bound)
. To Do (Unbound)
. Deploy (Bound)

Newly added elements will be added to
the left-most 'To Do' lane with whatever
priority value they previously had.
Moving them to the Tmplement' lane will
then set the phase to 'Implement'. When
the implementation 1s complete, the
element can be moved to the "To Do' lane
before 'Review' without updating the
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New

Modity

Delete
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element's phase until it is moved into the
'Review' lane.

Click on this button to define a new lane
on the Kanban diagram.

Click on a line in the 'Lanes' list and click
on this button to position the cursor in the
'Name' field in update mode, and to
highlight the lane you are modifying to
make it easier to focus on the fields you
might change.

Click on a line in the 'Lanes' list and click
on this button to delete the lane.

Click on an entry in the 'Lanes' list and
click on this button to move the entry one
line up 1n the list, and one lane to the left
on the diagram.

Click on an entry in the 'Lanes' list and
click on this button to move the entry one
line down 1in the list, and one lane to the
right on the diagram.
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Notes

. The elements in a Kanban diagram individually represent
work 1n progress; you cannot create connectors between
elements on the diagram

. If you apply a Kanban definition to a current diagram, all
connectors on the diagram are hidden; when you
de-activate the definition, the connectors are shown again

. When you first set up a Kanban diagram, any element on
the diagram that does not have one of the defined property
values 1s moved to the right-hand side of the diagram

. Moving an element into a lane automatically sets the
appropriate property of that element to the value
represented by the lane; for a Tagged Value, if the
clement does not have that tag, adding the element to the
lane adds the tag and sets it to the lane value

. Elements on a Kanban diagram are automatically adjusted
to match the width of the lane they are in, both when the
element 1s moved into a lane and when the lane width 1s
changed

. Certain types of element are automatically excluded from
a Kanban diagram search; these are:

- Constraint

- Port

- ProvidedInterface

- RequiredInterface

- Boundary

- Hyperlink
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- State Node (such as Choice and Junction)
- Text

- Win32

- Wireframing

- Package

- Diagram Frame

- Activity Region

- Sequence Element
- Note

- Standard Chart

- Model View

- Time Series Chart
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Kanban Diagram Options - Sub-Lanes

Sub-lanes are a useful device for defining another level in
the workflow; for example, you might want to divide the
'In-Progress' lane into a number of sub-lanes representing
the individual developers, or any lane into 'In-Progress' and
'Complete'. The 'Sub-lanes' page helps you to quickly and
casily create any number of new sub-lanes for a Kanban
diagram.

Use this page to create sub-lanes for the diagram.

Sub-lanes can be added to the parent lanes once created by checking the appropriate
checkbox

Check all Uncheck all

MName To Do In Progress Review Done
Bruce bl

selina had

New Modify Delete di &

Access
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Ribbon Construct > Task Management > Kanban
> (options to generate and/or open a
Kanban diagram) or

Start > Collaborate > My Kanban
(displays personal default Kanban
diagram)

Then

Design > Diagram > Edit > Kanban >
Sub-lanes (on an open Kanban diagram)

Context On a Kanban diagram, double-click on a
Menu lane > Sub-lanes

On any other type of diagram, right-click
on background | Kanban > Sub-lanes

Creating Sub-Lanes

You add sub-lanes simply by clicking on the New button
and, in the 'Name' column, typing the sub-lane name.
Alternatively, you can leave the default string
'<anonymous>' to create an un-named sub-lane, which can
be useful for organizing lanes that have lots of elements.
The names of the lanes on the diagram are then
automatically added across the panel.

Once you have created sub-lanes, you apply each one to one
or more parent lanes, by selecting the checkbox under the
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name of each lane that is to contain the sub-lane. To assign
every sub-lane to every lane, you can click on the Check all
button, and to clear this total assignment click on the
Uncheck all button. You can also change the order of the
sub-lanes across all their parent lanes in the Kanban
diagram, by clicking on the sub-lane names and on the
up-hand and down-hand buttons.

Within a specific parent lane column you can apply custom
sorting to the sub-lanes, so that the sub-lanes in that lane are
in a different sequence to the same sub-lanes in a different
lane. For a column that has assigned sub-lanes (that is, it
contains selected checkboxes) right-click on the header and
select the 'Set lane order' option. A small dialog displays, in
which you click on the sub-lane names and use the up-hand
and down-hand buttons to put them in the required
sequence. Click on the OK button to clear the dialog and
apply the sub-lane. If a sub-lane order has been customized,
you can return it to the 'across-the-board' order by
right-clicking the header again and selecting the 'Reset lane
order' option.

Notes

. Sub-lanes are not backwards compatible with earlier
releases of Enterprise Architect; if you open a Kanban
diagram containing sub-lanes in a release of the system
earlier than Release 12.1, the sub-lanes will be
permanently deleted from the diagram
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. Elements on a Kanban diagram are automatically adjusted
to match the width of the sub-lane they are in, both when
the element 1s moved into a sub-lane and when the
sub-lane width 1s changed
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Kanban Diagram Options - Appearance

Using the 'Appearance' page, you can set the Kanban
diagram appearance options, such as the line and font colors
and use of the Hand Drawn mode.

& Kanban

- Configuration
-lanes
i Appearance;

o~ Advanced Line Color: | I—
+ Filters
Font Color: I -
Title Caolor: O Default -

Overfilled Color: |0 Default -
Underfill Color: OO0 Default -
Line Width: 1 -

Vertical Spacing: Medium -

Use Kanban drawing style

Type
Status
Version
Priority
Bold name
Motes

Capitalize Name

Hide Names

A Bold Font

Hand Drawn
Enable Overfill Highlight
Enable Underfill Highli...

Highlight Hierarc...

MNative Element Draw Sty...

Stereotype

Phase

Authar

Truncate name
L Icon

Checkboxes

Help

Objects on a Kanban diagram are, by default, drawn using

the Info View style.

. i

Location 1 NPC design

Task
Version: 1.0
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This style displays an icon on the top right corner of the
element, representing the element type, with a triangular
icon to the left of it representing the priority - red for High
priority, and yellow for Medium priority. No icon shows for
Low priority. The Priority, as for various other element
properties, 1s also represented by a line of text in the body of
the element. You can specify which properties are shown by
selecting the appropriate checkbox from the list at the
bottom of the 'Appearance' page.

Appearance Options

Option Action

Line Color Click on the drop-down arrow and select
the color in which to display lane
borders. This color does not apply to sub
lane borders, which are automatically set
to a pale or dark color to contrast with the
lane fill color.

If the color you require 1s not shown,
click on the More colors button and either
select from a wider range of standard
colors or define a custom color.

The border style 1s automatically set to
the 'chiseled' effect to give the
appearance of 3D blocks on a

c) Sparx Systems age 580
(c)S S 2018 P 58 of 333



User Guide - Project Management 21 December, 2018

Font Color

Title Color

(c) Sparx Systems 2018

background, the color of the background
being the line color. The effect 1s more
obvious if you set the line to a pale color
and not black.

Click on the drop-down arrow and select
the color in which to display the text in
the Kanban lane and sub lane headings.

If the color you require 1s not shown,
click on the More Colors button and
either select from a wider range of
standard colors or define a custom color.

Click on this button to display the 'Font'
dialog, through which you define the font
and the style, size and effects of the text
in the Kanban lane and sub lane headings.

If you also change the text color here, it

overrides the setting of the 'Font Color’
field.

Click on the drop-down arrow and select
the color to use across the lane heading
cells (separate from the fill colors you
can apply individually to each of the
lanes themselves).

If the color you require 1s not shown,
click on the More Colors button and
either select from a wider range of
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standard colors or define a custom color.

Overtfilled Click on the drop-down arrow and select

Color the color with which to fill a lane heading
cell if the lane contains more than the
maximum number of elements. You set
the maximum number of elements when
you define the lanes to work with, in the
'Lanes’' page.
If the color you require 1s not shown,
click on the More colors button and either
select from a wider range of standard
colors or define a custom color.

Underfill Click on the drop-down arrow and select

Color the color with which to fill a lane heading
cell if the column contains fewer than the
maximum number of elements, in other
words there is available capacity. You set
the maximum number of elements when
you define the lanes to work with, in the
'Lanes' page.
If the color you require is not shown,
click on the More Colors button and
either select from a wider range of
standard colors or define a custom color.

Line Width Click on the drop-down arrow and select
the line width of the Kanban lane borders
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Vertical
Spacing

Hide Names

Bold Font

Hand Drawn

Enable
Overfill
Highlight

Enable
Underfill
Highlight

Highlight
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- either 1 (thinnest), 2 or 3 (thickest).

Set this to 'Small’, 'Medium' or 'Large' to
define the degree of vertical separation
between elements in a Kanban lane.

Select this checkbox to hide the lane
names and the column heading cells.

Select this checkbox to display the lane
headings in bold (if their font definition
does not already set them to bold).

Select this checkbox to display the
Kanban lanes and the elements on the
diagram in 'Hand-drawn' mode.

Select this checkbox to apply the
'overfilled' color to the lane header cell if
1t contains more elements than the
defined maximum number (see New).

Select this checkbox to apply the
'underfilled' color to the lane header cell
if the lane contains fewer elements than
the defined maximum number; that is, 1f
it has any spare capacity.

Select this checkbox to highlight
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Hierarchies

Use Kanban
drawing style
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clements on the Kanban diagram that are
part of the same hierarchy, by drawing a
colored rectangle behind each element. If
there are elements from two or more
hierarchies on the same diagram, each
hierarchy is represented by background
rectangles of a different color to the
others. In this illustration, Class 1 and
Class 2 are both in one hierarchy, and
Class 5 and Class 6 are both 1n a second
hierarchy.

Approved Implemented

(

Classib Class1

Approved Implemented

Class2 Class5

Approved Implemented

Select this option 1f you want to apply the
Kanban style to the elements on this
Kanban diagram. Also, select the
checkbox against each element property
or characteristic to be shown in the
elements:

. Type - displays the element type
Status - displays the element status
. Version - displays the element version
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. Priority - displays the element priority
. Bold name - displays the element name

in bold

. Notes - displays element notes in the

elements on the Kanban diagram

. Capitalize Name - displays element

names in capitals on the Kanban
diagram

. Stereotype - displays the element

stereotype

. Phase - displays the element phase
. Author - displays the name of the

element's author

. Truncate name - cuts off the element

name as it approaches the element
border, instead of allowing it to wrap
around

. Icon - selected by default; deselecting

this checkbox hides the Type and
Priority icons in the top right corner of
the element

. Checkboxes - when Checklist elements

are displayed on the Kanban diagram,
show the Checklist checkboxes and
items; Checklist Artifacts can be bound
to Priority on a Kanban diagram, and
this option makes it easy to view any
Checklists organized by Priority
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The property checkboxes are directly
linked to the 'Use Kanban drawing style'
option. If you do not select the option, the
element on the Kanban diagram has a
more basic appearance with no properties
shown other than the author and element
names.

Alfred
Location 1 NPC design

Native Select this option to render the elements

Element on the Kanban diagram in their native,

drawing style = rectangular notation style, displaying any
compartments the elements might have.
The Resources compartment 1s
particularly useful for Kanban elements,
if compartments are to be shown. This
compartment lists allocated resources,
including those that are 100% complete.

Note that the element width is limited by
the width of the lane the element 1s in, so
features in compartments might be shown
truncated.

Notes
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. All elements added to a Kanban diagram initially have the
same height and spacing, but the height can change as
displayable information is added to an element

. In a Kanban diagram, the normal element appearance
option 1s not operational; only the Kanban appearance
options take effect
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Kanban Diagram Options - Advanced

If you do not want to manually add elements to a Kanban
diagram, you can use the 'Advanced' page to set up either
Package searches or SQL searches to automatically fill the
diagram. It 1s not possible to use both a Package search and
a custom SQL search at the same time; if both are specified,
the Package search is ignored.

Select how you would like to fill this Kanban diagram (leave blank to manually add Run Search
elements)

Package Custom SOL

Remove Add

Source Details Include hild Packages

The dialog automatically opens at the 'Package' tab. If you
want to create a SQL Search, click on the 'Custom SQL' tab.

Access
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Ribbon Construct > Task Management > Kanban
> (options to generate and/or open a
Kanban diagram) or

Start > Collaborate > My Kanban
(displays personal default Kanban
diagram)

Then
Design > Diagram > Edit > Kanban >
Advanced (on an open Kanban diagram)

Context On a Kanban diagram, double-click on a
Menu lane > Advanced

On any other type of diagram, right-click
on background | Kanban > Advanced

Kanban Options - Advanced

To fill a diagram based on a Package, simply click on the
Add button and on the 'Add Package' option, then select the
required Package or Packages from the 'Select a Package'
browser.

If you want to include elements from child Packages, select
the 'Include Child Packages' checkbox against each Package
in the list. Click on the Run Search button. This will

automatically add elements, based on the search. The search
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is additive and will only add elements not currently on the
diagram; it will not remove elements that no longer match
the search. You can refine the Package search by creating it
on the 'Filters' page and adding filters (see the Kanban
Diagram Options - Filters Help topic).

To fill the diagram from the results of a custom SQL search,
click on the 'Custom SQL' tab and type or paste the
appropriate SQL. In order for the diagram to be filled, you
must include in the SQL Select statement:

Object ID as Element ID
For example:

Select Object ID as Element ID From t object Where
Object Type = 'Requirement’

Option Action

Run Search When you have set up either a Package
search or a custom SQL search, click on
the Run Search button to fill the diagram.
All elements found by the SQL search are
added to the diagram.

If you have not applied a filter to a
Package Search, all elements from the
selected Packages are added to the
diagram. If you have used a filter, only

those elements that meet the filter criteria
are added.

A 'Progress' dialog displays during the
search. If the search is taking a long time
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or 1s finding too many elements, click on
the Cancel button; any objects already
added to the diagram are removed.

Add On the 'Package' tab, if you are using a
search or filter (from the 'Filters' page of
the dialog) you must define a Package or
Packages for the search or filter to work
on. You do this by clicking the Add
button and choosing either 'Add Package
to browse to a selected Package, or
'Search Model' to search or filter from all
elements in the current model.

'

Remove If you want to clear a Package from the
list (or the whole-model selection) click
on the item line and click on this button.

Include Child @ If you have selected a Package with a

Packages child structure, select this checkbox to
also include the elements from the
structure in the Kanban diagram, or clear
the checkbox to include elements from
the selected Package only.
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Kanban Diagram Options - Filters

The 'Filters' page can be used in conjunction with the
Package search defined on the 'Advanced' page, should you
want to apply additional filtering.

Kanban

¢ Configuration
Sub-lanes
é----Appearance Element Filter
Advanced

. Filters

MNarrow the Kanban results to elements matching these conditions.

Import Search Add Filter Edit Filter Remowve Filter

Search In Condition Look For Required
There are noitems to show in this view.

Element Features

*) Dptional Required

It 1s possible to import a Model Search that has already been
created, or to create new filters here exactly as you would
for any other Model Search.

When adding any of these searches or filters, you must also
select at least one Package for the search or filter to work 1n;
you do this on the 'Advanced' page of this 'Kanban' dialog.

Access
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Ribbon

Context
Menu

Construct > Task Management > Kanban
> (options to generate and/or open a
Kanban diagram) or

Start > Collaborate > My Kanban
(displays personal default Kanban
diagram)

Then
Design > Diagram > Edit > Kanban >
Filters (on an open Kanban diagram)

On a Kanban diagram, double-click on a
lane > Filters

On any other type of diagram, right-click
on background | Kanban > Filters

Filter Options

Option

Import
Search

(c) Sparx Systems 2018

Action

Click on this button to import a search
from either an external XML file ('"From

File') or from the current model ('From
EA").
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Add Filter

Edit Filter

Optional /
Required

Remove
Filter

(c) Sparx Systems 2018

Click on this button to define the
properties of elements that you want to be
added automatically to your Kanban
diagram.

. Note that not all element types will be
added to Kanban diagrams; the list of
excluded types includes Constraint,
Note, Port, ProvidedInterface,
RequiredInterface, Boundary,
Hyperlink, StateNode, Text,
GUIElement, Package, UMLDiagram,
InterruptibleActivityRegion and
ExpansionRegion

Click on this button to edit the currently
selected filter in the list.

Choose 'Optional' if the filters will be
applied with a logical OR relationship.
Choose 'Required' if the filters will be
applied with a logical AND relationship.

Click on this button to delete the
currently selected filter from the list.
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Default Kanban Diagrams

A default Kanban diagram can be set for the entire
repository, and each individual user can also set their own
default Kanban diagram; in both cases there are specific
options to locate and open the diagrams. These defaults help
you to quickly and easily get access to a Kanban board and
immediately start contributing to work items that will
deliver value to the customer.

To track your own work, you can select:
. The 'Start > Collaborate > My Kanban' ribbon option, or

. The 'Construct > Task Management > Kanban > Open My
Kanban' ribbon option, or

. The 'User Default Kanban' menu option from the diagram
Caption Bar

To track the team's work, you can select:

. The 'Construct > Task Management > Kanban > Open
Project Kanban' option or

. The 'Model Default Kanban' menu option from the
diagram Caption Bar
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v *| Toolhox > 1
@ Show 5tart Page

User Default Diagram
User Default Kanban
Maodel Default Diagram
Model Default Kanban

'Eg Backlog
'Eg Specification Manager

Set the Model Default Kanban

A default model Kanban diagram can help you to visually
track a range of work items and their current stage of
development through an initiative. This feature ensures that
all team members can visualize the important work items in
a consistent way and allows them to track the work items as
they move from an idea in the backlog through to
completion ultimately delivering business value to the
customer.

Ste Action
p

1 | Ensure the preferred Kanban diagram is open in the
main view.

2 | Select the 'Configure > Security > Administer > User
Settings > Set User Default Kanban' ribbon option.
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Set My Default Kanban

In a shared security-enabled model environment it is
possible to set a user-specific default Kanban diagram. A
personalized Kanban diagram can help each member of a
team to visually keep track of a range of elements of
particular relevance to them, and their current stage of
development.

Ste Action
p

1 | Ensure your preferred Kanban diagram is open in the
main view.

2 | Select the 'Configure > Security > Administer > User
Settings > Set User Default Kanban' ribbon option.

Notes

. The model must have user security enabled in order to
define a user default Kanban diagram
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Allocating Resources to Work Items

Enterprise Architect not only helps you to define the work
items for a Kanban diagram or workflow but also acts as a
sophisticated platform for the allocation and management of
resources and the flow of items through the board. This
functionality uses both Kanban diagrams and the Resource
Allocation features.

Resources are the people who work on a project; they can be
assigned roles and allocated tasks, and these roles and tasks
can be visualized on a Kanban diagram.

In Progress (5/6) Test/Review
As a Sales Representative | As a Warehouse Manager |
want to be able to view want to be able to determine
historical leads the best product location to
minimize picking errors
Userstory
Validated Userstory
Medium Proposed
Low
Adam Goaodchild
[—— ] Soluti... Yuki Kotabashi
lane Ward [—— ] Test
=] ] Devel... b ’
Pat Taylor - L]
E— | C++Pr. As aCustomerlwant to be able
. - to rent an item for a specified

This example shows a number of Kanban work items, one
with three resources allocated to it. The tasks performed by
the resources are at varying stages of completion,
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represented by the green progress bars that show the
percentage of the work completed.

When a resource allocation 1s set to 100% complete, 1t will
no longer be displayed in the Kanban object. When all tasks
have been set to 100%, 1t might be time to move the task to
the next Kanban lane, changing its status so that the next
resources can be allocated. In this example, that might be
resources with a 'Review' or 'Testing' role.

Resource Allocation

To allocate a resource to a Kanban object, you must first
open the Resource Allocation window (‘Construct > Task
Management > Resources'). You then select the object on
the Kanban diagram or in the Project Browser and click on
the 'New' icon in the Resource Allocation window. Add
these details as necessary:

. Resource

. Role or Task

. Start Date

. End Date

. Complete %

. Expected Time
. Allocated Time
. Time Expended
. Description

. History

(c) Sparx Systems 2018 Page 77 of 333



User Guide - Project Management 21 December, 2018

Click on the Save icon to create the resource allocation - a
progress indicator will instantly appear on the work item in
the Kanban diagram. This 1s an important visual cue to show
that a resource has been assigned to work on this task or has
chosen it themselves. Other team members will immediately
be able to see the allocation on the Kanban diagram and
make decisions about what work items they will work on.
Therefore, 1t 1s important not to allocate resources too early
as this could slow down the workflow.

The resource allocations for the Kanban Work Item in the
previous diagram are shown in this example:

Resource Allocation O x
BEHEX: o BE @

Resource Role Allocated Time Expended Time % Completed Start End

Jane Ward Developer 14 2 15 15-Jun-16 20-Jun-1&6

Pat Taylor C++ Programmer 7 3 50 16-Jun-16 22-lun-16
Adam Goodchild Solution Architect & 3 30 14-Jun-16 16-Jun-16

Completed Tasks

Once you have completed a task, you set its 'Complete %'
value to 100. This has the effect of preventing the task's
progress bar from being drawn in the object in the Kanban
diagram. As well as setting the completion percentage on
the task, you might also want to fill in other information,
such as the end date and time expended. It might also be
time to move the object into the next Kanban lane.
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Resource Tracking

The Kanban features in Enterprise Architect can be used
with any project management method. How the features are
used will depend largely on what works best for individual
teams; the teams might be self organizing without any
formal project management controls and other teams might
work with a more formal structure. Either way Enterprise
Architect provides a number of facilities that will assist with
visualizing resources and their allocations to work items.

Enterprise Architect provides searches to allow you to track
resources. You can get a list of tasks that each resource is
working on, overdue tasks, recently completed tasks,
summaries, and more. A team or individual can also write
their own custom searches to retrieve any required
information from the repository.

Access
Ribbon Construct > Task Management > Active
Tasks
Construct > Task Management >
Completed Tasks

Construct > Task Management >
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Summary

Resource Tracking Searches

« Find in Project

21 December, 2018

®5tartF‘agE Finu:lin Project X

Resource Tracking

Drag a column header here to group by that

|] Object

Search

Active Tasks
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= 30 Day Resources

-

Resources
Tasks Overdue
Type |Active Tasks

Tasks Completed

Recently Finished Tasks

Tasks Ending Today

Tasks Starting Today

Authors with no Active Tasks

30 Day Task Summary (Simplified)
30 Day Task Surnmary (Full)

30 Day Resources

30 Day Roles

Description

=<5Search Term:=

Scope

Searches the project for elements with
assigned resources, where the end date is
in the future and the percentage
completion is less than 100.

The output lists all elements with
currently active tasks, and shows the
details of the resource allocation to each

task.
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Tasks Ending
Today

Tasks
Starting
Today

Overdue
Tasks

Recently
Completed
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Searches the project for elements with
assigned resources, where the task end
date is today.

The output lists all elements with tasks
ending today, whether the task is
complete or not, and shows the details of
the resource allocation to each task.

Searches the project for elements with
assigned resources, where the task start
date is today.

The output lists all elements with tasks
starting today, and shows the details of
the resource allocation to each task.

Searches the project for elements with
assigned resources, where the end date is
in the past and the percentage completion
1s less than 100.

The output lists all elements with overdue
tasks, and shows the details of the
resource allocation to each task.

Searches the project for elements with
assigned resources, where the end date 1s
in the recent past and the percentage
completion 1s 100. In the 'Search Term'

field, specify the number of days over
which to check back.
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The output lists all elements with tasks
completed within the specified period,
and shows the details of the resource
allocation to that task. The output does
not include tasks that have already been
finished in advance of a future
completion date.

All Searches the project for elements with
Completed assigned resources, where the percentage
completion is 100.

The output lists all elements with
completed tasks, and shows the details of
the resource allocation to each task.

30 Day Task | Provides a brief summary of the tasks
Summary performed by resources over the previous
(Brief) month.

The output groups tasks with similar
project role and calculates for each
resource: the count, the sum of expected
time, and the sum of expended time for
all tasks that have started in the last 30
days. To look at or change the master list
of project roles that this search uses for
grouping tasks, select 'Configure >
Reference Data > Project Types > People
> Project Roles'. Grouping by similar
project role means that, for example,
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'Review 1' and 'Review 2' would be
grouped together under 'Review' if and
only if the current project's list of project
roles includes one called 'Review'.

30 Day Task | Provides a full summary of the tasks
Summary performed by resources over the previous
(Full) month.

The output groups tasks by project role
and resource, and lists the count, sum of
expected time, and sum of expended time
for all tasks that have started in the last

30 days.
30 Day Searches the project for tasks that have
Resources started 1n the last 30 days where the

resource name matches (fully or partially)
the text in the <Search Term>.

30 Day Roles @ Searches the project for tasks that have
started in the last 30 days where the role
name matches (fully or partially) the text
in the <Search Term>,

Charts and Dashboards
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Enterprise Architect has a sophisticated charting facility that
allows a wide range of charts to be created, through which
you can visualize and analyze repository information. This
1s particularly useful with Kanban diagrams and resource
allocations, and provides an alternative view of the Kanban
cards, allowing a Product Owner, Project Manager or other
team member to get a visual image of things such as the
Number of Active Tasks by developer, the Phases the Work
Items are in by developer, the Number of Work Items at
cach stage of a Kanban Board and much more. The charts
can provide powerful information that will help improve the
teams performance and ultimately result in high value
product or service features being available to customers in
the shortest possible time frame. Any number of charts can
be created from built-in Patterns, but a team 1s also free to
create user defined charts, dashboards and reports.

Example - Active Work Items by Team
Member

This bar chart shows the number of active tasks by team
member. The names of the team members are listed on the
vertical axis and the Number of Tasks on the horizontal
axis. A small numerical value indicates the number of active
tasks allocated to each team member.
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Active Tasks

Ali Evans
Anna Howe
Buck Gold
Carlos Wallace
Carmen McRae
Elinor Dashwood
Eric Burns
Leon Major
Liam Cross
Penny Dark

Peter Ryan

Example - Completed Work Items by Team
Member

This compelling bar chart shows the number of work items
completed by the members of a team in a particular phase of
the process. The team members are represented on the
vertical axis and the number of completed work items on the
horizontal axis. Color has been used to help visualize the
work items completed in a given phase; a Diagram Legend
lists the relationship between color and phase. A small
numeric indicator indicates the number of items completed
in each phase for each team member.
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Completed Tasks Last Week

Ali Evans
Alma Cogan
Billy Bunter

Bob Brown

David Kelly
H Test

H Rework

H Review

Donna Campbell

Eric Burns

Ethan Rogers H Proposal

Frank Mclver ] 1 '

[ Investigate

B Implement

Josh Morgan 30| |

Liam Cross

Nigel Molesworth
Pat Taylor --
Penny Dark |1
Peter Ryan _

Philip Marlowe -
T
5

Example - Weekly Work Item Summary by
Phase

This expressive bar chart provides a weekly summary of the
number of Work Items completed by phase. The Phases are
represented on the vertical axis and the Number of Work
Items on the horizontal axis. The chart can provide powerful
information that will help improve the teams performance.
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Task Summary (1 Week)
Implement
Investigate |
Proposal |
Review ﬁ
Rework ﬁ
Test |
T T T T T T T T T 1
0 10 20 30 40 50 60 70 80 90
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Related Model Elements

There 1s a wide range of tools that allow teams to create
Kanban diagrams, but Enterprise Architect stands on its own
as a tool that not only allows a team to use the powerful
Kanban features but 1s also a sophisticated platform for
managing the work products of every discipline working on
Enterprise, Business or Technology initiatives. This means
that instead of having to access other tools or out-of-date
documentation or schedule meetings the information related
to a work 1items i1s immediately available inside the same
repository. An analyst, developer, tester or other team
member working on a User Story, Feature, or Defect can
locate the related Requirements, Business Rules Policies,
Standard Operating Procedures, Strategies, Drivers, Goals,
Stakeholders Requirements, Architectural designs,
Principles, Programming Code, Database and Information
Schemas, XML definitions, Messages, Test Cases,
Applications, Deployment Targets and Specifications and
more.
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«goal» []:]

Provide customers with a

competitive online shopping <<-—-—————————————- 1

experience |

|

|

(from Goals) «tra‘ce»

|

|

|

|

|

"

Rules Analyzer «business rule» l «policy» —
Any person studying who is under The bookstore will provide
the age of 27 with student = discounts to students to
———— identification is considered a «enforces» encourage learning
This is a customer built rules «trace» SR

engine used to manage (from Buszp\?ss Rules) (from Policies)
configuration items. It has been |

extended to allow rules to be |
viewed and updated through a |

business web interface. « tra; ce»
| |
ol ‘
«trace» 1 Kﬁ
As AStudent | want to buy REQ117 - The system must provide E ° o
books at Academic Prices || ||-————= amechanism allowing studentsto | — _ _ _ _ _ |
Requirement «UserStory» «trace» identify themselves «trace»
Version: 1.0 Phase: In Progress Name
Priority: High (from Take Orders) | |
Institution
A A United States
} Stanford
«trace» Harvard
]
|
‘ Student Number
Student Verification % O |
This Requirements diagram
«column» shows a User Story that has
ID: NUMBER(8,2) been added to a Kanban -
INSTITUTION NAME: NVARCHAR(50) diagram expressing the
YEAR: NUMBER(4,2) relationships to a number of
STUDENT NUMBER: VARCHAR2(20) business and technical e =] =
elements.

Relating Model Elements

Enterprise Architect allows a user to create any number of
connections between model elements, using the connectors
that form part of the chosen modeling language. Any item
that appears in a Kanban diagram can be dragged onto any
other diagram and then connections can be added. For
example, a User Story that is coming to the top of a backlog
or is in a Queue lane 1n a Kanban diagram could be added to
a Business or Stakeholder Requirements diagram, and Trace
relationships could be added between the User Story and the
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Requirements, indicating which requirements relate to the
Story.

Finding Related Model Elements

The work 1items in a Kanban board can be related to any
other elements in the model, allowing a powerful and
expressive graph to be defined. While it is possible to add
your own connections, quite typically other team members
working in related disciplines and parts of the repository
will have already added relationships to other model
elements, which in turn will be related to still other elements
and so on.

These connections can all be visualized in existing
diagrams, but a modeler can create a new diagram and place
the work item 1in the center of the diagram, choosing the
Insert Related Elements feature to insert the graph of related
clements that can be configured to draw an expressive
diagram reaching out to the very corners of the repository.

This diagram shows the result of using the Insert Related
Elements feature to find the important information needed
when working on a User Story.
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Rules Analyzer

P . « »
This is a customer built rules «trace>

engine used to manage
configuration items. It has been
extended to allow rules to be
viewed and updated through a
business web interface.
1
«trace»

As AStudent | want to buy
books at Academic Prices
Requirement «UserStory»
Version: 1.0 Phase: In Progress
Priority: High

«trace»
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«trzice» N
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|
Student Verification %

«column»
ID: NUMBER(8,2)
INSTITUTION NAME: NVARCHAR(50)
YEAR: NUMBER(4,2)
STUDENT NUMBER: VARCHAR2(20)

(]

«goal»
Provide customers with a
competitive online shopping
experience

(from Goals)

o

«business rule»

Any person studying who is under
the age of 27 with student
identification is considered a
student

«enforces»

(from Bus/:*ss Rules)
|
|
|

«tralce»

|

|

1
REQ117 - The system must provide E
amechanism allowing students to
identify themselves

«trace»

(from Take Orders)

(@

This Requirements diagram
shows a User Story that has
been added to a Kanban
diagram expressing the
relationships to a number of
business and technical
elements.
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A United States
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Student Number
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Managing a Backlog

The Backlog (or Product Backlog, as it is called by some
Agile methods such as Scrum) is an ordered list of items
that will deliver business value to the customer. It can
consist of a heterogeneous list of item types ranging from
Features, User Stories and Requirements (including
Non-functional Requirements) to Defects, Changes and
more. In fact, in Enterprise Architect any element can be
placed onto a Backlog; the ones that are listed and those that
appear in the Toolbox are simply the most common. The
Backlog is an ordered list based on the business value, with
the higher value items percolating to the top of the list. The
list 1s owned and managed by the Product Owner or their
equivalent; that is, someone acting as a surrogate for the
customer.

Ordering Items in a Backlog Lane

When working with a one-stage workflow, the Backlog
items will typically be contained in the first lane of the
Kanban and can be dragged to a new location in the lane to
change the order of items in the backlog.

Ste Action
p

1 | Select the Item to be moved in the Backlog diagram.
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2 | Drag-and-drop it into a new location in the backlog
lane.

Prioritizing a Backlog

The order of the items in the Backlog typically is carefully
and thoughtfully determined by the Product Owner and
reflects the business value - the items promising high
business value are located at the top. The prioritization of
the Backlog is the Product Owner's responsibility, but it 1s
not decided in isolation from other team members and the
Product Owner relies on access to important information
from a range of stakeholders, from senior executive level
stakeholders, business and operation managers,
requirements and business analysts down to implementation
teams.

A range of strategic diagrams and materials provide a source
for many of the prioritization decisions. These include:
Strategy Maps, Business Drivers, Goals and Objectives, and
Roadmap diagrams that describe the time-based sequencing
of packages of work. The example Roadmap diagram could
be used by the Product Owner as an input to what is of high
priority to the Business, or what has been planned by the
Enterprise or Business Architecture teams. The diagram will
prove useful in discussions with both the business
stakeholders and the implementers, who can gain a business
context for the work they are completing.
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Unit: Quarterly Product Architecture

Q3'16 Q4'16 Qi1'i7 Q2'17 Q3'17 @4'17 Q1'18 Q2'1
T T T T T O O

Academic Titles

Item Real-Time Tracking

Sales and Marketing Dashboards

Warehouse Optimization

Logistics Rationalization

Legend

[:] Planning

[:] Implementation

C] Production

Implementers' and other stakeholders' comments will also
provide a valuable source of information and input into the
prioritization of the backlog. Enterprise Architect has a
Collaborate window, which 1s a highly collaborative facility
through which any team member can enter discussion posts
against an element and other users can reply and join the
discussion. This can create a rich and useful tapestry of
knowledge that will not only help the Product Owner in
deciding the item's position in the backlog list but will also
assist implementers when they are ready to implement the
item.
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M 4 F M | Element Discussions . Model Chat
As a Stock Manager | want to be able to predict product demand -
= | » ‘_.FI._:||_||Ene Dean 16-Jun-16 4:35 PM

(1] Is this related to peak demand times like the beginning
of the Academic Year or is it more general?

* Greg Michols 16-Jun-16 4:38 PM

It is being driven by the upcoming Academic Titles
launch but it applies more generally as well.

Another critical piece of information that will help the
Product Owner is the item estimates completed by
implementers, who make their best estimation of how long
the item is likely to take. Agile teams using User Stories
tend to use Story Points, but any unit of measure can be
used as long as the team agrees upon a standard. Some
teams will use actual times based on units such as number of
hours, whilst others will use effort-based estimates.
Enterprise Architect has a flexible and integrated resource
allocation facility where team members can add estimates,
allowed time, actual times, completion percentages and
more. This will be invaluable for the Product Owner, who
might have a broad idea of the time required to complete an
item but who relies heavily on the details supplied by the
team. The time estimate can be entered in the 'Expected
Time' field of the Resource Allocation window.
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Resource Allocation
BEEHEX: S BE @

Resource Rale Resource: Jane Ward

EJane Ward Developer . Role or Task: | Developer

Pat Taylor C+= Programmer E

Drescription | History

Example

-

Start Date:
End Date:
Complete %

09-062016
13062016

15

4k 4 4

21 December, 2018

Expected Time:
AMlocated Time:
Time Expended:

This diagram shows how a backlog can be defined in a
one-stage workflow, allowing items to be dragged and
dropped 1n a single column to define the order of the items

in the backlog.

Backlog

AsaCustomerlwant tobe able
to viewthestatusof my order

Userstory
Validated
High

L -

r A
As aReviewer wantto beable
to beableto addwordsto the

online dictionary

Userstory
Proposed
Medium

L .

Prices for some publishers do
not include internal storage
costs

Defect
Proposed
Low

L .
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Ordering Items in a Backlog Diagram

When working with two or three stage workflows the
Backlog items are contained in a Kanban board representing
the entire Backlog, allowing them to be moved between
lanes from low to medium, high or critical or using any user
defined lane names or bound property.

Ste Action
p

1 | Ensure the Backlog Kanban diagram 1s open.
2 Select the work item to be prioritized in the diagram.

3 | Drag and drop the item into a new location, either in
the containing lane or in another lane.

Securing a Backlog

The Backlog 1s a communication tool that insulates the
implementers from the need to decide what they should be
working on. It 1s owned and managed by the Product
Owner, who ultimately decides what should be on the
Backlog and the order of the items it contains. It therefore
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must be secured from inadvertent changes. The
implementation team should have access to the Backlog, but
for the purposes of pulling items from a work queue to the
In-Progress lane, which could be continuous flow-based
(Kanban) or time-boxed (such as a Sprint). The
development team also need to provide time estimates for
the items in the Backlog, which will help the Product Owner
decide upon the order of items, particularly when two or
more items have comparable business value. The item with
the lowest completion estimate will typically be given a
higher position. Developers are also expected and
encouraged to comment on the items in the Backlog so that
the Product Owner can understand any issues or have access
to learning from prior 1initiatives or insights.

Enterprise Architect's security system can be used to lock
the Backlog while still allowing people to make the
necessary contributions of time estimates and comments in
the form of discussions.

With the Security System enabled and either a group for
Product Owners or individual users who are Product Owners
added, a Backlog diagram can be locked by the individual
Product Owner user or a member of the Product Owner
group. This example shows the Backlog being locked by the
Product Owner group, but for a repository that is accessed
by a number of Product Owners it could be more expedient
to lock the diagram to an individual.
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Lock Diagram >

Lock Type

) No lock, general editing allowed

) Full lock, no-one may edit

1 User lock, locking user may still edit
@ Group lock, locking group may still edit

GrouplD: | Product Owners w

When the Backlog diagram has been locked by the Product
Owner, other team members will be able to view the
diagram but a small red marker to the left of the diagram
name in the Project Browser will indicate that it is locked.
The Project Manager will see a blue marker indicating that
they have access to edit the diagram.

Project Browser v B X
1O + 4+ =~

Global Context

4 [ Online Shop Example o
i Backlog
5 Online Shop Example
b [£31 Stage Workflow
4 (72 Stage Workflow
1 Fg Backlog
:E'E Iteration
ElEackIDg
Cliteration

Securing a Backlog Diagram
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Secure a Backlog diagram, remembering that it can be
locked at a user or a group level.

Ste Action
p

1 | Locate and select the Backlog diagram in the Project
Browser.

2 | Right-click on the diagram name and select the 'Lock
Diagram' option. The 'Lock Diagram' dialog
displays.

3 | Select the 'User Lock' or 'Group Lock' option from
the 'Lock Type' list.

4 Select the User, or the Group from the 'Group ID'
drop-down list.

5 | Click on the OK button to save the changes.

Notes

. The model must have user security enabled in order to
lock the backlog Kanban diagram

. To secure a Backlog a two or three stage workflow is
required where the Backlog is a separate Kanban diagram
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Elaboration and Grooming

During the process of prioritizing the backlog and as work
items move closer to the top of the Backlog or onto the work
Queue they must be prepared for the In-Progress stages of
the workflow - in traditional methods this process 1s termed
'elaboration’, but is known as 'grooming' in Agile methods.
Enterprise Architect has a number of facilities that can assist
with the grooming of work items so that when they are
pulled onto an In-Progress lane the right information is
available for an implementor to immediately start work.

Enterprise Architect has a form of requirement that is
internal to an element and allows supplementary and more
specific requirements to be added to a Work Item. These
requirements are created in addition to the business,
stakeholder, functional and non functional requirements that
might exist for the work item.
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[&f' UserStory : As A Student | want to buy books at Academic Prices X
=g P.VUPE’tiES Requirement:
- General An item needs to be idertified as an academic title
cenarios : == = Req
B/U&-Zi|l2%@
- Related - 2 Status Proposed
""" Ffles Students should not be permitted to buy any titles that are not D"fﬁc_“h Me‘j?“m
""" lnts marked as academic so a new property must be added to the item Prority Medium
. . . . Stability Moderate
information model and related tables to categorize these titles. h
Type Functional
Last Updated 17-Jun-16 5:...
New Save Delete
Requirement Type Extemal
An item needs to be identified as an academic title: Functional
Student numbers need to be verfied Functional
The Academic Price discount needs to be configurable at rurtime Functional
Cancel Apphy Help

There 1s also a wide range of information that can be entered
as Change Management Items for a selected Kanban Work
Item. These 1items include Changes, Defects, Issues, Tasks,
Events, Decisions, Effort, Risk and Metrics, and add rich
additional information that will assist all team members
including the Product Owner and the Implementation team.

BEHEX!io BE @

lssue Priority

The percentage for the academic pr... Medium

EThe database environments are loc... High

4 il

|4

(B T U&- S« %@

MName: The database environments are locked down while the Linux upgrades are being done Puto
Raised by: Greg Nichols ~ || Raised: 15-06-2016 v Status: | New -
Completed by ~ | Completed: [7] - Priority: |High -

Version / |D: 160663CEE1ISS Copy ID

Description | History

There is a Linux Operating system project in progress for the next couple of
weeks and all non critical database changes have been frozen during this
period. This will mean that the addition of the Student Verification table and
associated stored procedures will have to be delayed. A replica environment
will he huilt on anather server to allow develonment to continue.

pf" Defects pg’s’ Changes pg’s’ Events qf" Decisions pfs’lssues

Enterprise Architect also has an Element Browser that 1s a
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convenient tool for viewing all the related information about
an element 1n a single place. The Element Browser can be
kept open as a docked window and items can be selected in
a Kanban diagram, List, Gantt chart or the Project Browser,
and the Work Item's specific information will be displayed.

Element Browser O x
Az A Student | want to buy books at Academic Prices
] Operations
] Attributes
|| Linked Features
] Tagged Values
4 Constraints
i3 The solution must use existing stored procedures where applicable
4 Requirements
The Acadernic Price discount needs to be configurable at runtime
Student nurmbers need to be verified
An item needs to be identified as an academic title
4 Files
U3 E\Projects\Online BookStore\Requirements'List of Academic Institutions.xls:
4 Relationships
*--.J Abstraction:5tudent Verification [Table]
*-, Abstraction:Rules Analyzer [Component]
*., Abstraction::REQ117 - The system must provide a mechanism allowing students to identify themselves [Requirernent]
*'-.J Motelink: [Mote]
] Scenarios
Maintenance
4 Changes

=8 [ New ] Academic Institutions need to register for discount

b

A Issues
T [ New ] The database environment are locked down while the Linux upgrades are being done
71 [ Verified ] The percentage for the academic price discount has not been set by the product team
4 Decisions
= [ Verified ] Mo need to cite or validate a student card
] Testing
4 Project Management
4 Resource Allocation
T8 [30%] Pat Taylor: C++ Programmer
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Alternate Views

Enterprise Architect is a powerful modeling platform that
can be used by any number of stakeholders ranging from
high level executives to implementation teams, providing a
variety of communication devices suitable for each
stakeholder group. There are four other views of a Kanban
diagram that will be appealing to many stakeholders,
particularly project managers, schedulers, development
managers and product owners; these can be viewed by
simply toggling from view to view:
. Gantt View
This view provides a visualization of the work items and
the assigned resources in a Gantt Chart, which is
particularly useful for people who might be more familiar
with this more traditional representation or who want to
get an overview of the schedule of tasks

. List View
This view is a spreadsheet representation, where the work
items are the rows and the properties and Tagged Values
are the columns

. Specification Manager View
This view lists the work items with the contents of each
element's Notes field

. Traceability Window
This view helps a team member to quickly review
dependencies and other relationships between work items
to any depth, and to locate the items in other diagrams
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Switching between Views

A Kanban diagram, like all diagrams, can be switched to an
alternative view and, once 1n this view, can be switched to
any other view without affecting the underlying layout of
the diagram.

Ste Action
p

1  Ensure the diagram is the active tab or has focus.

2 Ribbon: Design > Diagram > View As > Graphical /
List / Gantt / Specification

+0 o0 B |88 & o

Mew Manage Toolbox = WView Mew Mana
- Mndev - -

Diagram

ment * Kanban Features Ilfl List

r 3 x |®» T Cassi T Gantt
1+ 3 1 Specification
. 1 Traceability

Context Menu (open diagram): Open Diagram in |
Gantt View / List View /Specification Manage-

List View
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The List View provides a spreadsheet-like visualization of
the work 1items and their properties and Tagged Values. It
allows properties to be viewed and compared across the
entire corpus of work items that make up the diagram and
allows properties such as status to be edited inline using
drop-down lists of values where they apply. It also has a
clever mechanism that allows the list to be grouped by
property down to any number of levels and a filter that is
useful when wanting to restrict the view of work items with
a particular property or name - for example, all work items
relating to the Warehouse Manager.

Egh'artar Diagram: "1 stage workflow
HEXEE M rEkEBE- LT @
Priority -
¥ Mame ~ Priority ~ Phase > Status ~ Type ¥  Modified =7
Jol o o Jol o Jol
—| Priority: Critical
As a Customer | want to be able to add new orders to existing ones if they hav... Critical In Progress Proposed  Defect 17-Jun-16
—| Priority: High
As an Administrator | want to be able to have a maintenance window to updat... High In Progress  Validated Requirement  17-Jun-16
As a3 Customer | want to be able to view the status of my order High Backlog Validated Reguirement 17-Jun-16
As A Student | want to buy books at Academic Prices High ([~ In Progress Proposed Requirement 17-Jun-16
= Priority: Medium %'
The Online Shop web site country drop down list is missing a number of small ... !_ow Daone Proposed Defect 14-Jun-16
As a Reviewer | want to be able to be able to add and edit rules in the online ...  Medium InProgress Proposed  Requirement  17-Jun-16
As 3 Sales Representative | want to be able to view historical leads Medium In Progress Proposed  Requirement  17-Jun-16
As a Customer | want to be able to delete items from my order before it is ship... Medium Queue Approved Requirement 17-Jun-1&
As 3 Reviewer | want to be able to be able to add words to the online dictionary Medium Backlog Proposed Requirement 17-Jun-16 3

Access

Ribbon Design > Diagram > View As > List

Context Right-click on diagram background |
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Menu Open Diagram in | List View

Gantt View

The Gantt View provides a traditional Gantt Chart in the
form of bar chart representing the scheduling of the work
items including: their start and finish times and the
percentage complete. It is a graph that provides a time
oriented view of the work items and is useful for project
managers and project schedulers or other team members
who want to view all the work items in a single view.

g Kanban Diagram: "1 stage workflow

June 2016 -

Element Status Role orT.. | C. = @ 5 = = = ]
p p P
(=) I As A Student | want to buy books at Academic Prices  Proposed
& Pat Taylor C++ Prog... 30%

(=) E=] As a Customer | want to be able to add new orders ... Proposed

- —
r
7 Paulene Dean Business .. 10% e ———

(=) L& As a Customer | want to be able to rent an item for ... Proposed

7 Paulene Dean Test Analyst 75 % .
(=1 £ As a Reviewer | want to be able to be able to add a... Proposed F |

7 Pat Taylor C++ Prog.. 63% ¢ ]
(=) I As a Sales Representative | want to be able to view ... Proposed

A Jane Ward Developer 15 % |

& Pat Taylor C+=+ Prog.. 87% G |
=) L4 As a Warehouse Manager | want to be able to dete... Proposed P |

2 Yuki Kotabashi Test Analyst 85 % ( e =

4 11} 3

Access

Ribbon Design > Diagram > View As > Gantt
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Context Right-click on diagram background |
Menu Open Diagram in | Gantt View

Specification Manager View

The Specification Manager 1s a simple document-based
interface to a selected diagram (or Package) in the model,
providing the means of creating and reviewing elements as
text representations of objects in the model, using a process
that 1s familiar to all users including business professionals
and management, who might not have expertise in model
development.

The Specification Manager is also an interactive reporting
tool for displaying, in icon form, the status of various other
features against each entry and providing access to edit each
feature.

Access
Ribbon Design > Diagram > View As >
Specification
Context Right-click on diagram background |
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Menu Open Diagram in | Specification Manager

Traceability View

The Traceability Window provides an insightful view of
how a work item is connected to other elements in the
model including other work items and how these connected
elements are themselves connected down to any level. It is a
general purpose mechanism and so can be used with any
type of element but 1s particularly useful when working with
Kanban boards and for product owners and other team
members who need to understand the dependenies between
work items and to find the related information that will help
with the analysis, grooming, testing and implementation of a
work item.
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Traceability O x

WEE -0

A Az A Student | want to buy books at Academic Prices -~
A -+ needed by

V| Student Verfication
[ --+ dependson
4 2] Rules Analyzer
A -+ depends on
A Any person studying who is under the age of 27 with student identfication is considered a student
4 -+ needed by
[+ REQ117 - The system must provide a mechanism allowing students to identify themselves
[ 2] Rules Analyzer

4 -+ depends on

A The bookstore will provide discounts to students to encourage leaming
4 -+ needed by
Ary person studying who is under the age of 27 with student identification is considered a student
4 -+ depends on
A Provide customers with a competitive online shopping experience
A -+ needed by
[ REGQ014 - Shopping Basket
[ The bookstore will provide discounts to students to encourage leaming
[ REQ012 - Provide Online Sales -

Access

Ensure a Work Item i1s selected in a diagram or other view.

Ribbon Design > Impact > Traceability
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Other Processes and Methods

Kanban 1s not a process in traditional classification but more
of a way of visualizing work items, and a method for
creating efficiencies and ensuring customer value is
delivered as soon as possible. Kanban can be used in
isolation or in combination with any existing processes,
including Scrum, Iterative and Incremental and Waterfall
Processes. Each of these processes has their place and can
be used with Kanban even though much of the literature
about process 1s currently focused on iterative families of
processes such as Agile.

The compelling thing about Kanban is that it provides a
visualization of the flow of Work Items from the i1deas stage
through to delivering demonstrable value to the customer
transparently to every team member.

Scrumban

Scrumban is a hybrid methodology combing aspects of
Scrum and Kanban. Scrum teams can typically work with
the same process they have always used, including Sprints,
Standups, Retrospectives and Demos, but incorporate
Kanban as a way of visualizing the Work Items, allowing
just-in-time planning and benefiting from being able to set
Work-In-Progress (WIP) Limits. The work items that have
been selected for the Sprint or Iteration can be pulled from a
Backlog Kanban board onto the Queue lane of an Iteration

(c) Sparx Systems 2018 Page 112 of 333



User Guide - Project Management 21 December, 2018

Kanban board.

Using Scrumban overcomes limitations or issues that some
Scrum teams experience such as: excessive time required in
Sprint planning, a loss of focus due to implementers
working concurrently on too many User Stories, Defects or
other items and information being forgotten over the period
of the Sprint. The built-in one, two or three stage workflows
would all be suitable for Scrumban but a team 1s free to
define their own workflow, create their own Kanban boards
and define their own lanes and sub-lanes.

In Progress
Pat Taylor Benjamin Hutton Theresa Moranti
i@ din 3 @
As a Sales Representative | want to be able The Online Shop web site country drop As a Reviewer | want to be able to be able
to view historical leads down list is missing a number of small to add and edit rules in the online grammar
countries checker
UserStory
Version: 1.0 Defect UserStory
Medium Version: 1.1 Version 10
Medium Medium
Pat Taylor
1 C#+Prog Benjamin Hutt Theresa Moranti
e ——es | (++ P (— ] s+ Progra..
As A Student | want to buy books at
Academic Prices As a Customer | want to be able to delete Stock levels on financial reports don't
items from my order before it is shipped include returned items
UserStory
Version: 1.0 UserStory Defect
High Version: 1.0 Wersion 11
High L
Pat Taylor
S ] C+#+Prog Benjamin Hutt Theresa Maranti
1 Applicat [ — | P

Iterative Methods

Iterative and incremental methods have been in use since the
mid nineteen seventies and have been incorporated into a
number of waterfall processes as well as being used in
isolation These processes can all benefit from the use of
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Kanban diagrams as a way of visualizing the work items in
an iteration and any number of Kanban diagrams can be
created to manage concurrent iterations.

Project Browser v X
1ot ¥ =

Project Browser Context Browser

4 £ Multi Iteration Workflow a

iz Backlog
:E'E Iteration One

:E'E Iteration Two
FlBacklog
FIteration One
T Iteration Two
[+ £ Defects
[+ 3 User Stories

Waterfall

Waterfall or modified methods have been in use since the
mid nineteen-seventies and have been baked into a number
of standards, particularly in industries such as the military,
aviation, travel and finance, where outcomes typically need
to be determined in advance of a development cycle.
Waterfall methods are often used when requirements are
locked down and scope 1s determined in advance, the
product 1s stable and the technology platforms are well
known and understood. These processes can all benefit from
the use of Kanban diagrams as a way of visualizing the
work items as they flow from phase to phase.
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The Construct Facility

The Construction Facility 1s an aide to Project Management,
helping you to quickly define the resource, metric, test and
maintenance items of any element in the model, and to
generate a visible representation of those items. The facility
has two main components:

. The Construct window - which you use to define items of
these types for the element:
- Resource Allocations
- Effort
- Risk
- Metrics
- Tests
- Maintenance

. The Construction diagram - which you generate as a child
of the element to show a rendering of the element with
compartments automatically enabled; the compartments
show various Project Management items with Progress
Bars where appropriate, as you define them in the
Construct window

There are a number of Project Management resource, test
and maintenance windows that you can also display
(through the 'Construct' ribbon) to list and display the items
allocated to the element.

Access (Construct window)
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Ribbon Start > Explore > Properties > Construct

The Construct window displays,
defaulting to the 'Resource Allocation'

page.

Construct - Resource v 1 x
=E-fHdE X @

Allocation

Resource

Role or Task Developer
Start Date 01/05/2018
End Date 01/05/2018
Complete % 0

Expected Time 0
Allocated Time 0
Time Expended 0

Allocation

Description  History

B/ U&K-IZ= %@ 5

Access (Construction diagram)

(c) Sparx Systems 2018 Page 117 of 333



User Guide - Project Management 21 December, 2018

Context In Project Browser, right-click on the
Menu clement | Add | Construction Diagram

In a diagram, right-click on the element |
New Child Diagram | Construction
Diagram

The Construction diagram for the element
displays; note the '<' in the bottom right
corner of the element, indicating that it 1s
the Construction rendition of the element.

Registration

[

Creating an item

The Construct window has a toolbar of icons that you use to
create and delete item records for the selected element. Your
use of these icons is explained here.

Item Type @ Click on this icon to display a two-level

- menu of item types, starting with the
main groupings of 'Resources’, "Tests' and
'Maintenance', each opening to a list of
specific types.
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The window heading changes to reflect
the type of item you select. For example,
'Construct - Acceptance Testing'.

New Item | Click on this icon to clear the fields of
i record-specific data so that you can
define a new item. For instructions on
how to complete the fields for the type of
icon you have selected to create, click on
the Help icon (@).

Items display on the Construct window

one at a time, so you can no longer see

the previous item. To see all existing

items on the element, select the

'Construct' ribbon and:

. The 'Task Management > Resources'
option, or

. The '"Testing > Tests > <test type>
option', or

. The appropriate icons in the 'Change
Management' panel, further selecting
the 'Show <itemtype> Window' option
where displayed

If you select an item from any of the lists,

the item details are shown in the

Construct window, where you can edit
them.

Save When you have finished entering or
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|

Delete
X

Help

(c) Sparx Systems 2018

updating field values, click on this icon to
save the data. As you save each item, it is
added to the appropriate compartment of
the element in the Construction diagram.

Registration

test scripts
Unit
LTOO4 Mot Run

FeEsSOUrces

David Steele
[— ] Developer

[

If you do not need an existing item you
have displayed by selecting it from the
relevant list window, or the new item you
have just saved, click on this icon to
delete the item. Depending on the type of
item, a confirmatory prompt might
display; in this case, click on the Yes
button to complete the deletion.

Click on this icon to display the Help
topic appropriate to the type of item you
have selected to create or display. The
topic will explain how to populate the
fields for that specific type of item.
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Task Management

In the life cycle of a project, there are various non-technical
tasks that are vital to the successful management and
completion of the project, such as allocation of resources
and allocation of time to the tasks and to meetings.
Enterprise Architect helps you as a project manager or as a
team member to record and monitor such tasks.

Facilities

Enterprise Architect provides a range of project
management facilities as described in this table.

Facility Description

Manage Resources are the people who work on a
Project project. You can assign roles and allocate
Resources tasks to them, which helps you to track

effort and estimate time to complete
tasks. You can also define the effort, risks
and metrics to support resource
management. You add, modify and delete
resources using the Resource Allocation

window.
The Gantt In Enterprise Architect, you can visualize
View clements and assigned project resources
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Project Task
Allocation

Review
Personal
Tasks

(c) Sparx Systems 2018

casily in a Gantt Chart format, to review
the breakdown of work for a specific
project and for specific sections of the
project. The Project Gantt View
illustrates a project schedule by showing
the start and finish dates of assigned
resources, so that you as Project Manager
can quickly see the current project status
using the percent-complete bar shading
and the percent-complete, resource name
and status columns. Information can be
filtered, and overdue items can quickly be
highlighted and identified. You can also
access specialized versions of the Gantt
View from diagrams, Packages and the
Personal Tasks list.

A particular feature of the Project Gantt
View is the facility to review the
allocation of work to elements in the
project, focusing on either the elements
that require work, or the resources
required to perform the work.

Using the Personal Tasks view, each
team member can record, review and
manage their personal work within the
project.
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Project Enterprise Architect provides four

Management @ specialized windows to help you to define

Windows cach of the management quantities
associated with an element in the model,
namely:

. Resources - the people who work on a
project, who can be assigned roles and
allocated tasks

. Effort - the effort expended in work on
the element

. Risks - the risks associated with the
element, and

. Metrics - the metrics measured for an
element

Notes

. In the Corporate, Unified and Ultimate editions of
Enterprise Architect, if User Security 1s enabled, you must
have 'Manage Project Settings' permission to perform
Resource Allocation
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Project Resources

Resources are the people who work on a project. They can
be assigned roles and allocated tasks, which enables
tracking of effort and estimation of time to complete. You
also define the effort, risks and metrics to support resource
management.

You allocate resources and update and delete the allocations
using the Construct window. You can also review and delete
listed allocated resources using the Resource Allocation
window.

Access

Ribbon Start > Explore > Properties > Construct

The Construct window displays,
defaulting to the 'Resource Allocation'

page.
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Expected Time 0
Allocated Time 0
Time Expended 0

Allocation

Description  History

B 7 U#&- =

Resources

Construct - Resource v I x
=E-EHE X

Allocation

Resource

Role or Task Developer
Start Date 01/05/2018
End Date 01/05/2018
Complete % 0

= 0

Construct > Task Management >

Uses

Use to

Allocate a resource to an element.
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Record additional project management information for an
element.

Obtain a report of resource allocation details.

Configure Project Management data and populate the
drop-down lists used on the Project Management widows.

Notes

. In the Corporate, Unified and Ultimate editions of
Enterprise Architect, if User Security is enabled, you must
have 'Manage Project Settings' permission to perform
Resource Allocation and to update and manage project
resources, effort, metrics and risks
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Resource Allocation

In developing a model, people (or resources) in a number of
roles might perform tasks on model structures. As a Project
Manager, you can assign resources to tasks on elements
(including Packages) in the model, planning and monitoring
the work that they do within the timeframe you have
allocated for that work to be completed. You can do this
using the Project Gantt View and/or Construct facilities.

If you want to assign more than one resource to the role or
task on the element, follow the procedure in the Assign
Multiple Resources Help topic.

Access

First, select an element, then:

Ribbon Start > Explore > Properties > Construct :
=" | Resources | Allocation : (&

Construct > Task Management >
Resources : i - clears Construct window
ready to add resource or

Construct > Task Management > Gantt >
Element View > Click on element - clears
Construct window ready to add resource
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Enter resource allocation details for an
element

Resource
Either:
. Type in the name of the resource being
assigned to work associated with the
element, or

. Click on the drop-down arrow and
click on the name of the resource;

Role or Task
Either:
. Type in the role name or task
performed by the selected resource, or

. Click on the drop-down arrow and
click on the role to be performed by the
resource

Start Date
This field defaults to today's date.

If you want to assign a different start date
for the task:

1. Click on the drop-down arrow.

2. If necessary, click on the Left or Right
Arrow to select the previous or next
month.
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End Date

Complete %

Expected
Time

(c) Sparx Systems 2018

3. Click on the appropriate day of the
month as the start date.

The field immediately changes to the
selected date.

This field defaults to today's date.

If you want to assign a different end date
for the task:

1. Click on the drop-down arrow.

2. If necessary, click on the Right Arrow
to select the next month.

3. Click on the appropriate day of the
month as the end date.

The field immediately changes to the
selected date.

If the task is already in progress, type in
the current percentage completion.

Type 1n the number of whole time units
the task 1s expected to take. (The value
must be an integer, so you cannot record
part units.)

The unit of time you adopt 1s by
agreement within the project, and
depends on the granularity of the work
being recorded. Most tasks are completed
in a number of hours or a number of days;
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Allocated
Time

Time
Expended
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use the smallest practical unit that you
can record as a whole number.

Apply the same units as used for the
'Allocated Time' and 'Time Expended'
fields.

Type in the number of time units the task
can be spread over. (The value must be
an integer, so you cannot record part
units.)

The unit of time you adopt is by
agreement within the project, and
depends on the granularity of the work
being recorded. Most tasks are completed
in a number of hours or a number of days;
use the smallest practical unit that you
can record as a whole number.

Apply the same units as used for the
'Expected Time' and 'Time Expended'
fields.

(When the task is eventually 100%
complete, you will type in the number of
time units it actually took. The value
must be an integer, so you cannot record
part units.)

The unit of time you adopt 1s by
agreement within the project, and
depends on the granularity of the work
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being recorded. Most tasks are completed
in a number of hours or a number of days;
use the smallest practical unit that you
can record as a whole number.

Apply the same units as used for the
'Expected Time' and 'Allocated Time'

fields.

Description
Type (and, if you prefer, format) a
description of the work being done by the
resource.

History
(As the task progresses, you add text to
this tab to record the activities, progress,
problems and outcomes of the task.)

Save

= Click on this icon to save the data you
have entered and to add the entry to the
Resource list in the Project Gantt View,
Element Browser and Resource
Allocation window.

Help

Click on the icon to display this Help
topic.

Notes
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. In the Corporate, Unified and Ultimate editions of
Enterprise Architect, if User Security 1s enabled, you must
have 'Manage Project Settings' permission to perform
Resource Allocation

. If you allocate resources to Use Cases, the information
you enter contributes to the Use Case Estimation
calculation for estimating the project size in terms of time,
resources and cost

. To edit existing Resource Allocation items for this
element, display the allocation in the (already open)
Construct window by either:

- Clicking on the 'Construct > Task Management >
Resources' ribbon option and on the required item 1n the
Resource Allocation window

- Clicking on the item in the Project Management >
Resource Allocation folder in the Element Browser
window or

- Clicking on the item 1n the Element View of the
Project Gantt Chart

. To delete existing Resource Allocation items for an
element, click on the item in the Construct window or
Resource Allocation window and click on % in the
window toolbar
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Assign Multiple Resources

When you have a large unit of work associated with an
element - such as a Package element - you might want to
assign several resources to that element to perform that unit
of work. You can assign each person individually, but if the
resources have the same role or task you can assign all of
them together in one operation, using the 'Assigned
Resources' dialog.

Access

First, select an element, then:

Ribbon Construct > Task Management > Gantt >
Element View > right-click on element >
Assign Resource

Assign multiple resources to an element

Option Action

Resource (To assign a single resource, simply type
in the name or click on the drop-down
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Role or Task
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arrow and select the name from the list.
In Project Management, it 1s simpler to
assign single resources directly through
the Construct window.)

For multiple resources, click on the [
button to display the 'Assign Resource'
dialog.

1. Select the checkbox against each
resource to assign to the element; to
select all resources listed, click on the
Select All button.

2. Click on the OK button to close the
dialog and to add the selected resources
to the 'Resource’ field.

The 'Resource’ field now shows the
selected resources, but grayed out. The
drop-down arrow also is not active. To
change the resources in the field, click on
the [.] button again and select/clear the
appropriate checkboxes.

Either:

. Type in the role name or task that is
common to all the selected resources,
or

. Click on the drop-down arrow and
click on the role that is common to all
the resources

Page 134 of 333



User Guide - Project Management 21 December, 2018

Start Date This field defaults to today's date.

If you want to assign a different start date
for the task:

1. Click on the drop-down arrow.

2. If necessary, click on the Left or Right
Arrow to select the previous or next
month.

3. Click on the appropriate day of the
month as the start date.

The field immediately changes to the
selected date.

End Date This field defaults to today's date.

If you want to assign a different end date
for the task:

1. Click on the drop-down arrow.

2. If necessary, click on the Right Arrow
to select the next month.

3. Click on the appropriate day of the
month as the end date.

The field immediately changes to the
selected date.

Complete %  If the task 1s already in progress, type in
g
the current percentage completion.

Expected Type in the number of time units the task
Time 1s expected to take. (The value must be an
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integer, so you cannot record part units.)

The unit of time you adopt 1s by
agreement within the project, and
depends on the granularity of the work
being recorded. Most tasks are completed
in a number of hours or a number of days;
use the smallest practical unit that you
can record as a whole number.

Apply the same units as used for the
'Allocated Time' and 'Time Expended'

fields.
Allocated Type 1n the number of time units the task
Time can be spread over. (The value must be
an integer, so you cannot record part
units. )

The unit of time you adopt 1s by
agreement within the project, and
depends on the granularity of the work
being recorded. Most tasks are completed
in a number of hours or a number of days;
use the smallest practical unit that you
can record as a whole number.

Apply the same units as used for the
'Expected Time' and 'Time Expended'

fields.
Time (When the task is eventually 100%
Expended complete, you will type in the number of
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time units it actually took. The value
must be an integer, so you cannot record
part units.)

The unit of time you adopt is by
agreement within the project, and
depends on the granularity of the work
being recorded. Most tasks are completed
in a number of hours or a number of days;
use the smallest practical unit that you
can record as a whole number.

Apply the same units as used for the
'Expected Time' and 'Allocated Time'
fields.

Description Type (and, if you prefer, format) a
description of the work being done by the
resources.

History (As the task progresses, you add text to
this tab to record the activities, progress,
problems and outcomes of the task.

Apply Click on this button to apply the changes
to the currently-displayed element on a
diagram, without closing the dialog.

New Click on this button to clear the fields on
the dialog so that you can define a new
resource allocation.
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Previous Click on this button to display the
previous resource record in the sequence.

Next Click on this button to display the next
resource record in the sequence.

OK Click on this button to save the data you
have entered, and close the dialog.

Close Click on this button to discard the data
you have entered, and close the dialog.

Help Click on this button to display this Help
topic.

Notes

. When the resource details are displayed on the Project
Gantt Chart or Resource Allocation window, each
resource has their own record containing, initially, the
same data; however, each resource can be monitored and
their progress recorded separately

. If you assign resources that are already in a multiple
resource assignment to the selected element, a prompt
displays for you to confirm that you are updating the
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assignment of that resource, or now omitting that resource
from the existing assignment
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Effort Management

In Enterprise Architect, the Project Manager can allocate
effort (as time) to work on a given model element. To select
the element to which to allocate effort, click on the required
element 1n the Project Browser or a diagram.

Access

Ribbon Start > Explore > Properties > Construct :
= | Resources | Effort

Construct > Change Management >
Effort : & - clears Construct window
ready to add effort

Enter effort allocation details for an element

Effort
Type the name or a brief description of

the effort.

Type
Type in the effort type or click on the
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drop-down arrow and select the type. The
selection list is drawn from the global
Effort Type list, but any new efforts you
type in this field are not added to the list.

Time
Type 1n the amount of time the effort is
expected to expend.

Description
Type in any additional notes or
description of this effort.

= Click on this icon to save the data you
have entered and to add the entry to the
Effort list in the Element Browser and
Effort window.

Notes

. To edit existing Effort items for this element, display the
record in the (already open) Construct window by either:

- Clicking on the 'Construct > Change Management >
Effort' ribbon option and on the required item in the Effort
window, or

- Double-clicking on the item in the Project
Management > Effort folder in the Element Browser
window
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. To delete existing Effort items for an element, click on the
item 1n the Construct window or Effort window and click
on %X 1n the window toolbar

. Although Enterprise Architect does not currently provide
detailed reports on effort within a model, you can use the
Automation Interface or similar tools to create your own
custom reports based on effort information you enter
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Risk Management

In Enterprise Architect, the Project Manager can allocate the
possible weighting of defined risks that might impact work
on a given model element.

To select the element to which to allocate risk weightings,
click on that element in the Project Browser or a diagram.

Access

Ribbon Start > Explore > Properties > Construct :
=" | Resources | Risks

Construct > Change Management > Risks

: 14 - clears Construct window ready to
add ris«

Enter risk details for an element

Risk
Type the name or a brief description of
the risk.

Type
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Type in the risk type or click on the
drop-down arrow and select the type.

The selection list 1s drawn from the
global Risk Type list, but any new risks
you type in this field are not added to the
list. If there are no global risk types
defined, the drop-down arrow is not
displayed.

Weight
Defaults to the weighting for the defined
type. You can change this weighting if
necessary.

Description
Type in any additional notes or
description of this risk. You can use the
Notes Toolbar at the top of the field to
format the text, if you prefer.

5 Click on this icon to save the data you
have entered and to add the entry to the
Risk list in the Element Browser and Risk
window.

Notes

. The risks described here are not the same as those
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represented by Risk elements; the risks are properties of a
single element, whilst the Risk element represents
something that can impact a range of other elements

. If you select a global risk type from the '"Type' drop-down
list and the associated "Weight' field 1s empty, the default
Weight value 1s allocated to the 'Weight' field on the
Construct window

. To edit existing Risk items for this element, display the
record in the (already open) Construct window by either:
- Clicking on the 'Construct > Change Management >
Risk' ribbon option and on the required item in the Risk
window, or
- Double-clicking on the item in the Project
Management > Risk folder in the Element Browser
window

. To delete existing Risk items for an element, click on the
item 1n the Construct window or Risk window and click
on % 1n the window toolbar

. Although Enterprise Architect does not currently provide
detailed reports on risks within a model, you can use the
Automation Interface or similar tools to create your own
custom reports based on risk information you enter
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Metrics

The Project Manager can allocate the possible weighting of
defined metrics to work on a given model element.

To select the element to which to allocate a metric
weighting, click on the required element in the Project
Browser.

Access

Ribbon Start > Explore > Properties > Construct :
=" | Resources | Metrics

Construct > Change Management >
Metrics : i - clears Construct window
ready to add metri

Enter metric details for an element

Metric
Type the name or a brief description of

the metric.
Type
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Type in the metric type or click on the
drop-down arrow and select the type.

The selection list 1s drawn from the
global Metric Type list, but any new
metrics you type in this field are not
added to the list. If there are no global
metric types defined, the drop-down
arrow 1s not displayed.

Weight
Defaults to the weighting for the defined
type. You can change this weighting if
necessary.

Description
Type in any additional notes or
description of this metric.
You can use the Notes Toolbar at the top
of the field to format the text, if you
prefer.

= Click on this icon to save the data you
have entered and to add the entry to the
Metrics list in the Element Browser and
Metrics window.

Notes
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. If you select a global metric type from the "Type'
drop-down list and the associated "'Weight' field 1s empty,
the default Weight value 1s allocated to the 'Weight' field
in the Construct window

. To edit existing Metric items for this element, display the
record in the (already open) Construct window by either:
- Clicking on the 'Construct > Change Management >
Metric' ribbon option and on the required item in the
Metric window, or
- Double-clicking on the item in the Project
Management > Metrics folder in the Element Browser
window

. To delete existing Metric items for an element, click on
the item in the Construct window or Risk window and
click on % in the window toolbar

. Although Enterprise Architect does not currently provide
detailed reports on metrics within a model, you can use
the Automation Interface or similar tools to create your
own custom reports based on metric information you enter
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Effort Types

When setting up the project management parameters for
monitoring work on elements, you can create types of effort
to add to the global list of effort types that can be assigned
to any element in the model. You can also select and edit
existing effort types. The global list of effort types displays
in the '"Type' drop-down list on the 'Effort' page of the
Project Indicators window.

Access

Open the 'Project Indicators' dialog using one of the
methods outlined here, then select the 'Effort' tab.

Ribbon Configure > Reference Data > Project
Types > Project Indicators : Effort

Add a new effort type to the global list

Click the 'New' button to define a new Effort type
Option Action

Effort Type the name of the effort type. (Or, to
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Description

Weight

<note>

Save

New

Delete

Close
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edit an existing effort type, click on the
effort name in the Defined Effort Types
panel.)

Type a short description of the effort
type.

Type the default weighting to apply to the
effort type.

Type any additional information on the
effort type.

Click on this button to save the changes
that you have made to the dialog.

Click on this button to clear the data
fields ready to define a new effort type.

Click on an entry in the Defined Effort
Types panel, and click on this button to
immediately delete the effort type.

Click on this button to close the 'Project

Indicators' dialog. If you have not saved

your changes, the system prompts you to
save or abort those changes.
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Notes

. Although Enterprise Architect does not currently provide
detailed reports on effort within a model, you can use the
Automation Interface or similar tools to create your own
custom reports based on effort information you enter

. You can transport effort types between models, using the
'Configure > Model > Transfer > Export Reference Data'
and 'Import Reference Data' ribbon options
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Metric Types

Enterprise Architect enables you to add a metric type to the
global list of metric types that can be assigned to any
element in the model. The global list of metric types
displays in the 'Type' field drop-down list on the Metrics
window.

Access

Open the 'Project Indicators' dialog using one of the
methods outlined here, then select the 'Metric' tab.

Ribbon Configure > Reference Data > Project
Types > Project Indicators : Metric

Add a new metric type to the global list

Click the 'New' button to define a new Metric

Option Action
Metric Type @ Type the name of the metric type. (Or, to

edit an existing metric type, click on the
metric name in the Defined Metrics
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Description

Weight

<note>

Save

New

Delete

Close
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panel.)

Type a short description of the metric
type.

Type the default weighting to apply to the
metric type.

Type any additional information on the
metric type.

Click on this button to save the changes
that you have made to the dialog.

Click on this button to clear the data
fields ready to define a new metric type.

Click on an entry in the Defined Metrics
panel, and click on this button to
immediately delete the metric type.

Click on this button to close the 'Project

Indicators' dialog. If you have not saved

your changes, the system prompts you to
save or abort those changes.
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Notes

. Although Enterprise Architect does not currently provide
detailed reports on metrics within a model, you can use
the Automation Interface or similar tools to create your
own custom reports based on metric information you enter

. You can transport metric types between models, using the
'Configure > Model > Transfer > Export Reference Data'
and 'Import Reference Data' ribbon options
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Risk Types

Using Enterprise Architect you can add a risk type to the
global list of risk types that can be assigned to any element
in the model. The global list of risk types displays in the
"Type' field drop-down list on the 'Risks' page of the Project
Indicators window.

Access

Open the Project Indicators window using one of the
methods outlined here, then select the 'Risk' page.

Ribbon Configure > Reference Data > Project
Types > Project Indicators : Risk

Add a new risk type to the global list

Click on the New button to define a new Risk

Option Action
Risk Type Type the name of the risk type. (Or, to

edit an existing risk type, click on the risk
name in the 'Defined Risks' panel.)
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Description Type a short description of the risk type.

Weight Type the default weighting to apply to the
risk type.

<note> Type any additional information on the
risk type.

Save Click on this button to save the changes

that you have made to the dialog.

New Click on this button to clear the data
fields ready to define a new risk type.

Delete Click on an entry in the 'Defined Risks'
panel, and click on this button to
immediately delete the risk type.

Close Click on this button to close the 'Project
Indicators' dialog. If you have not saved
your changes, the system prompts you to
save or abort those changes.

Notes
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. Although Enterprise Architect does not currently provide
detailed reports on risks within a model, you can use the
Automation Interface or similar tools to create your own
custom reports based on risk information you enter

. You can transport risk types between models, using the
'Configure > Model > Transfer > Export Reference Data'
and 'Import Reference Data' ribbon options
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Project Task Allocation

Using the Project Gantt View, you can review the allocation
of work to elements in the project, focusing on either the
elements that require work, or the resources required to
perform the work. The view primarily shows information
that is entered through other windows and dialogs, but once
a record exists in the view you can edit it and, for example,
add to or change the resources on an element.

Access

Ribbon Construct > Task Management > Gantt
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The Project Gantt View

In Enterprise Architect, you can visualize elements and
assigned project resources in a Gantt Chart format, to review
the breakdown of work for a specific project and for specific
sections of the project. The Project Gantt View illustrates a
project schedule by showing the start and finish dates of
assigned resources, so that a Project Manager can quickly
see the current project status using the percent-complete bar
shading and the percent-complete, resource name and status
columns. Information can be filtered, and overdue items can
quickly be highlighted and identified.

You can also access specialized versions of the Gantt View
from diagrams, Packages and the Personal Tasks list.

Access

Ribbon Construct > Task Management > Gantt

Gantt View

This example shows four resources, two of whom are
working in different capacities on one task, and two on
another task. The resource names and roles are listed in the

(c) Sparx Systems 2018 Page 159 of 333



User Guide - Project Management 21 December, 2018

left panel of the chart, together with the actual percentage
completion of each person's work on the task. In the right
panel of the chart, completed work 1s indicated by the green
section of the bar, work yet to be completed but not yet due
is indicated in blue, and work not completed and overdue is
indicated in red (as a result of the option to highlight
overdue work being applied).

(D start Page |34 Project Gantt View X

uuuuuuuuuu
eeeeeeeeeeeeeeeeeeeeeeeeeeeeeeee

Tabs of the Gantt View

The Project Gantt View has three tabs, the first two of which
use the Gantt chart itself to show the progress of work
against the resources performing the work or the elements
having the work performed on them. (Other variations of the
Gantt chart do not have these separate tabs.)

View Detail
Resource When you initially open the Gantt View,
View 1t defaults to the 'Resource View' tab, in

which the focus 1s on the current
commitments of each allocated resource
in the project.
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Element The Element View lists the elements in

View the project that have resources assigned
to them, and the resources assigned to
each element.

Report View = A Resource report shows how your
resources are deployed in your project,
displaying a list of all elements that have
resources allocated to them.

Gantt View Facilities

The facilities of the Project Gantt View are common to the
Resource and Element Views, and in some cases to all three
tabs, as described here.

Option Action

Display tasks = Right-click on the display and select the
for today option:

only, or for . 'Show Only Active Tasks for Today' -
another day to show only tasks that are in progress
only today

. 'Show Only Active Tasks for Other
Day' - to show only tasks that were in
progress on a specific day in the past,
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Display the
properties of
the element
to which a
resource 1s
assigned

Display the
Resource
Allocation
details for an
element or
resource

Display the
Resource
Allocation
records for an
element
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or that are scheduled to be in progress
on a day in the future; a calendar dialog
displays from which you select the day
to examine

Right-click on the element entry and
select the 'Show Element Properties'
option.

The "Properties’ dialog for the element
displays.

Right-click on the entry and select the
'Show Task Properties' option.

The 'Assigned Resources' dialog displays;
you can edit the details and, if necessary,
change the resource allocated to the
element.

(Also available in the Report View.)
Right-click on the entry and select either
of the context menu options:

. 'Show Element Resource Allocation

window' (if the window is closed or
hidden)

. 'Find Task in Element Resource
Allocation window' (if the window 1s
visible but showing the details of
another element)
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Assign a new
resource to
an element

Change the
scale of the
display
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The Resource Allocation window
displays, with the details of the selected
entry shown in the fields and the other
resource allocations for the element listed
in the left-hand panel.

You can edit the details and, if necessary,
change the resource allocated to the
element.

Right-click on an element in the display,
and select the 'Assign Resource' option.

The 'Assigned Resources' dialog displays;
complete this as for the Resource
Allocation window.

By default, the Gantt Chart shows periods
of time 1n units of days of the month,
each date column being approximately
one centimetre wide. Weekends have a
darker fill color.

You can change the scale of the date
columns by clicking on the column
header, pressing Ctrl and rolling the
mouse wheel. As you do this:

. At one extreme the date columns
expand to approximately 2.5
centimetres, and the date header shows
the full date in dd/mm/yyyy format

. Rolling to the other extreme changes
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the scale of the column from date
through week, labeled month,
numbered month and labeled year to
numbered segments of a decade

This allows you to represent a wide range
of tasks on a single chart and to condense
or expand the view - in conjunction with
filters - to investigate the short term and
longer term work clearly.

Change the Y ou might want to make broad

duration of a | adjustments to the timeline of an event,

task, on the which you can easily do on the Gantt

Gantt Chart Chart itself. For example, the resource is
1ll, or another resource has taken over
other tasks that the resource was allocated
to. In neither case has the task itself
changed, but in the first case the resource
needs a longer elapsed time in which to
complete the task, and in the second they
have less other work to do and can finish
the task sooner.

To make these adjustments, you simply
drag the right end of the time bar further
or back along the chart. This changes the
task end date to wherever you drag the
time line to, and adjusts the division into
complete and incomplete/overdue work
to maintain the percentage completion
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value. The work time allocated to the task
does not change.

If you drag the left end of the time line,
this moves the whole line without
changing its length or proportions; you
are just indicating that the task started
earlier or later and will finish earlier or
later by the same amount of time.

Grouped A resource 1s likely to be allocated to

work several tasks either simultaneously or
consecutively. In the Resource View the
tasks assigned to a resource are grouped
under the resource name, and a narrow
group bar displays in gray on the chart
against the name, spanning the period
from when work is scheduled to begin on
the first task to when work is scheduled
to finish on the final task.

Similarly, a body of work, represented by
an element, might involve several
resources starting and finishing at
different points. The resources are
grouped under the element name and the
group bar displays on the chart against
the element name, spanning the period
from when the first resource is scheduled
to start work to when the last resource is
scheduled to complete work on the task.
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If any adjustments are made that impact
the initial start point or final completion
point of the work, the end of the group
bar automatically adjusts. If any task or
resource in the group 1s overdue, the
group bar turns red to reflect that there is
a potential problem in the allocated work.

Filter the (This feature takes effect under your user
display to ID.)

exclude Right-click on the window and select the
elements by  'Apply Element Status Filter' option.
status The 'Excluded Status Types' dialog

displays; select the checkbox against one
or more statuses to exclude elements
having those statuses from the list.

You can select every checkbox at once by
clicking on the Select All button, and
clear all selections by clicking on the
Clear All button.

Click on the OK button to immediately
apply the filter, which stays in effect until
you specifically change it.

Filter the Right-click on the list and select the
display to 'Show Filter Bar' option.

include The Filter Bar displays underneath the
elements heading bar. Type a text string in the field
having above a column to immediately filter the
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certain
properties

Filter the
display by
Start or
Completion
date
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list for entries that have the text string in
the values in that column.

To delete a filter string altogether, click
on the blue cross at the right of the field.

If you no longer want to use the filter bar,
right-click on the list and select the 'Hide
Filter Bar' option.

The display default is to show current
tasks for which the end date has not yet
occurred. Right-click on the list and
select one of the options:

. 'Include Completed Tasks Within the
Last ..." - to display incomplete tasks
and tasks completed only within the
specified period; you can set this period
to 7, 30 or 90 days, or you can include
all completed tasks, or hide all
completed tasks

. 'Include Future Tasks Starting in ..." - to
display current incomplete tasks and
completed tasks (depending on the
setting of the 'Include Completed Tasks
Within the Last ..." option) and future
tasks that have been recorded and are
due to start within the next period; you
can set this period to 7, 30 or 90 days,
or you can show all tasks that have
been recorded but are not yet due to
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start

Identify Right-click on the display and select the
overdue tasks = 'Display Highlight For Overdue items'
option and one of its sub-options:

. 'Show in Red' - to display the
uncompleted percentage of the task
bars for overdue items on the Gantt
chart in red

. 'Show in Red to Current Date' - to
extend the task bars of the overdue
items to today's date, and display them
1n red

. 'None' - to cancel any overdue item
highlighting that has been set

Display Right-click on the display and select the
ONLY 'Show Overdue Items Only' option.

overdue tasks = The display shows only those items for
which the end date has passed but that are
not 100% complete. These items do not
have red highlighting.

Refresh the Right-click on the entry and select the
report 'Refresh’ option.

The content of the display 1s refreshed
and collapsed to element or resource
level.
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Reposition
the Gantt
chart to
automatically
show the end
date of a
selected
allocation

Reposition
the Gantt
chart to show
the start date
or end date of
an allocation,
or today's
date

Locate the
element 1n
the Project
Browser

Send a Model
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Right-click on the display and select the
'Go to | Auto Sync with Task End Date'
option.

Whilst this option 1s selected (with a tick
next to it), whenever you click on an
allocation the display adjusts to show the
end date of the task in the center of the
chart.

Right-click on the entry and select the
required option:

. Go To | Task Start Date

. Go To | Task End Date

. Go To | Today's Date

The display shifts to put the required date
in the center of the chart.

(Also available in the Report View.)
Right-click on the element name and
select the 'Find in Project Browser'
option.

The area of the Project Browser
containing the element is brought into

focus and expanded, and the element is
highlighted.

It 1s possible to send a Model Mail
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Mail to the directly from the Project Gantt View to a
resource selected resource if the resource's Author
name matches their:

. Enterprise Architect security user ID
(Security has been enabled) or

. Their workstation login ID (Security
has not been enabled)

Right-click on the resource or one of their
activities and select the 'Post Model
Message' option. This opens a Model
Mail message addressed to the resource,
for you to complete and send.

Save an Right-click on the tab and select the 'Save
image of the | Image to File' option.

Gantt chart to = The 'Save As Image' dialog displays, on
file which you specify the file name, location
and graphics file type to save to.

Save an Right-click on the tab and select the
image of the | 'Copy Image to Clipboard' option.

Gantt.chart 0 ' You can paste the image from the
the clipboard ' clipboard into your preferred graphics
package.

Notes
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. Items in the list pane can be filtered; right-click on the
column headings in the list pane to toggle the Filter Bar
between hidden or shown, or to edit the filter
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Resource View

The 'Resource View' tab shows the current commitments of
cach allocated resource in the project as a list of allocation
records and a Gantt chart of the progress of the allocations.

The display initially shows the resources and their overall
commitment; click on the 'plus-box' to the left of the name
of the resource to expand the entry to show the elements and
the allocation period for each element.

The display shows both complete allocations and those that
are still in progress; an internal filter hides completed
allocations two weeks after the end date, and incomplete
allocations one month after the end date. Tasks you can
perform include checking the:

. Dates on which specific resources or all resources are
currently allocated

. Elements to which each resource is allocated

. Dates on which a resource 1s allocated to work on a
specific element

. General progress of the resource in completing the work

. Specific details of the allocation of a resource to an
element and task or role

Access

(c) Sparx Systems 2018 Page 172 of 333



User Guide - Project Management 21 December, 2018

Ribbon Construct > Task Management > Gantt :
Select the 'Resource View' tab
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Element View

The 'Element View' tab of the Project Gantt View lists the
clements in the project that have resources assigned to them.
It shows the resources assigned to each element as a list of
allocation records and as a Gantt chart of the progress of the
allocations. An allocation can be partial, in that a role or
task 1s assigned but no specific resource has been identified.

The display initially shows the elements and their overall
resource commitment; click on the 'plus-box' to the left of
the name of the element to expand the entry to show the
resources and the allocation period for each resource. You
can then:

. Check the dates on which specific elements have
resources currently allocated

. Check which resources are currently allocated to an
clement

. Assign further resources to the element

. Check the dates on which a resource 1s allocated to work
on a specific element

. Check the general progress of the resource in completing
the work

. Check the specific details of the allocation of a resource to
an element and task or role

The display shows both complete allocations and those that
are still in progress; an internal filter hides completed
allocations two weeks after the end date.
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The 'Element View' complements the 'Resource View' and
'Personal Tasks View' of work allocation on the project.

Access
Ribbon Construct > Task Management > Gantt
or
Design > Diagram > View As > Gantt
Context Project Browser right-click on an open
Menu diagram | Open Diagram in |Gantt View

In diagram, right-click on background |
Open Diagram in | Gantt View

Project Browser | Right-click on Package
|Open Package in | Gantt View
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Report View

The Report View shows how your resources are deployed in

your project, displaying:

. A list of all elements that have resources allocated to
them, and the type of each element

. The resource allocated, and the role played by that
resource

. The start and end dates of the allocation

. The time allocated, expected and expended

. The percentage completion of the allocation

You can tailor the displayed information by:

. Hiding columns of information

. Grouping types of information

. Filtering the data by status

. Filtering the data by start date or end date

. Filtering any column to show only a specific value

Having displayed the information you require, you can print
it.

Access

Ribbon Construct > Task Management > Gantt :
Select the 'Report View' tab
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Report View Options

Option Action

Run the Click on the first icon in the Report View
report toolbar (the rotating arrows).

The report results display.

If you have the report open for a while,
you can update the information; either:

. Run the report again or

. Right-click on the content and select
the 'Refresh' option

Adjust Drag and drop column headings into the
column sequence you require.
headings Right-click on the column headings and

select the 'Field Chooser' option, to add
or remove columns using the 'Field
Chooser' dialog.

Group entries = Right-click on the column headings and

by column select the 'Enable Group Box' option, to

heading cluster the report information according
to your preferred hierarchy of column
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headings.
Filter Either:
columns . Click on the third toolbar icon from the

right (the spy glass), or

. Right-click on the column headings
and select the "Toggle Filter Bar' option

The filter field displays at the top of
every column.

Type in whatever text string you require
in the appropriate column to filter the
report to show only entries containing
that text string in that column.

Filter by In the first field in the toolbar, click on
degree of the drop-down arrow and select one of
completion these values:

. 'All' - Display all entries regardless of
degree of completion

. 'Completed' - Display only those
entries where the allocation is 100%
completed

. 'Above cut-off' - Display only those
entries that are more than a certain
percentage complete

. 'Below cut-off' - Display only those
entries that are less than a certain
percentage complete

(c) Sparx Systems 2018 Page 178 of 333



User Guide - Project Management 21 December, 2018

Filter
according to
start/end date

Print the
report
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In the second field in the toolbar, either
type a threshold value or increment to the
value using the up/down arrows, to set
the percentage completion for the
'Above/Below cut-off' options.

Click on the fourth toolbar icon from the
right (the funnel).

The 'Resource Filters' dialog displays.

In the 'Start Date' and/or 'End Date' field,
click on the drop-down arrow and select
the appropriate qualifier:

. 'After’

. 'Before'

. 'Equal To'
. 'Not Equals'

In the date fields, click on the checkbox
to activate the fields and either type in the
day, month and year or click on the
drop-down arrow to select the date from a
calendar.

The fields have an AND relationship; an
entry must satisfy both date criteria
before it 1s displayed.

Either:

. Click on the second toolbar icon from
the right (the printer) or
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. Right-click on an entry in the report
and select the 'Print' option

The 'Print' dialog displays, on which you

specify the printer to use and the

characteristics of the print job.
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Progress Bars

Progress bars are horizontal bands that show the degree of
completion of a task or process. They give a quick
indication of the current status of, for example, projects,
tasks or budgets, which can be useful for checking how
close a task or project is to completion or if a project is
coming close to hitting its total allowed budget.

Progress bars can be especially useful in large projects that
consist of multiple smaller projects, as you can display
within one element separate bars showing the degree of
completion of each sub-project and of the main project,
giving you an overview of progress at a single glance.
Separate elements within the diagram can contain further
progress bars for the metrics of the individual projects,
adding levels of detail that can, again, be assessed in a brief
review.

In Enterprise Architect, progress bars are implemented using
Tagged Values on elements. They are automatically added
to elements on a Kanban diagram or Construction diagram,
where progress or resource consumption are indicated.
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Release 10.2.5

Total Completion
I 1 59%

Budget

Total Cost
— ]| $270,000

Projects

Project Anubis
|
Project Hades

/N

Project Hades

Project Anubis

Cost Cost

— ] $150,000 ———————— ] $1.80,000

Progress Progress

[— 1 37% complete ———— | 329% complete
Tasks Tasks

Deploy Deploy

[ | [ ———— |

Design Help Topics

I ———— ] [ ————————————————————— ]

Help Topics

[E—— |

Implement

[ ————— |
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Using Progress Bars

You can add progress bars to any element that can show
compartments and that can display any numerical value
within a range, when displayed on a diagram.

Progress bars can be used to display things such as:
. The current progress of a task or project
. How much of project's budget has been used

By default a progress bar will display a value between 0 and
100 (inclusive); however, it is possible to adjust both the
minimum and maximum values to set any range of values
required.

This 1llustration shows an example of a default progress bar:

| Project Alpha |

Progress |

Creating a Progress Bar using a new Tagged
Value

Use this procedure to create a progress bar using a simple
Tagged Value that you create immediately from scratch.

Ste Action
p

1 | On a diagram, create an element that can display

(c) Sparx Systems 2018 Page 183 of 333



User Guide - Project Management 21 December, 2018

compartments (such as a Requirement or Feature)
and add a simple Tagged Value to it.

2 | From the Tagged Values window open the tag's
notes and add '"Type=ProgressBar;' (including the
semi-colon) and then click on the OK button.

Tagged Value Note x

Type=ProgressBar;

(You can add further options to the Tagged Value, as
described in the Additional Progress Bar Options
table.)

3 | Click on the element and either press Ctrl+Shift+Y
or right-click and select the 'Compartment Visibility'
option. The 'Compartment Visibility' dialog displays.

4 | Select the '"Tags' checkbox in the 'Show Element
Compartments' panel, then click on the OK button.

The progress bar will now display on the element on
the diagram, with the Tagged Value name above the
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bar.

5 | Inthe Tagged Values window, indicate progress by
typing a number between 1 and 100 into the "Value'
field for the tag. On the diagram, the appropriate
length of the progress bar 1s filled in green.

Creating a Progress Bar from the 'UML
Types' dialog

You can also define a progress bar Tagged Value from the
'UML Types' dialog that can then be applied to any element,
without having to set the Tagged Value notes each time.

Ste Action
p

1 | Select the 'Configure > Reference Data > UML
Types' ribbon option to display the 'UML Types'
dialog and click on the 'Tagged Value Types' tab.

2 | In the 'Tag Name' and 'Description' fields, type a
name and description for the Tagged Value. In the
'Detail' field type the option parameters and their
values for the Tagged Value. Click on the Save
button and on the Close button.
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B uML Types
- Stereotypes i~ "
Tagged Value Types Tag Name: e ——
Cardinality Values

Description: Current project completion

Detail:
Type=ProgressBar;
Text=#Value£s;

Defined Tag Types:

Type Description
Completion Current project completion

(The option parameters are described in the
Additional Progress Bar Options table.)

3 Select the 'Start > Explore > Properties > Tagged
Values' ribbon option to open the Tagged Values
window (if it 1s not already open).

On a diagram select an element, then in the Tagged
Values window click on the & (New Tagged Value)
button.

In the 'Tag' field of the Tagged Value dialog, click
on the drop-down arrow and select the Tagged Value
you created in step 2, then click on the OK button.

4 On the diagram, right-click on the element and select
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the 'Compartment Visibility' option to display the
'Compartment Visibility' dialog.

5 | Select the 'Tags' checkbox and click on the OK
button.

6 | Inthe Tagged Values window, change the number in
the 'Value' field a few times, clicking off the field
cach time. Notice the effect this has on the progress
bar.

Additional Progress Bar Options

A default progress bar will show the Tagged Value name
and reflect values in the range 0-100. You can change the
range values if required, and display text to the right of the
bar if more information has to be provided. The background,
border and fill colors of the progress bar are, by default,
determined by the currently-applied inbuilt diagram theme.
However, you can apply your own colors to one of more of
these properties.

Use these parameters to enhance the progress bar.

Parameter Description

MinVal Use the MinVal option to set the lowest
allowed value to be represented on the
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progress bar.
. Syntax: MinVal=<number>;

A progress bar with the setting
MinVal=10; will start at 10. Values lower
than 10 will not be shown on it.

If a maximum value (MaxVal) has been
defined, the progress bar will show any
values between MinVal and MaxVal
(inclusive); otherwise, the maximum
value will default to MinVal + 100. So, 1f
MinVal=10, the progress bar can show
values between 10 and 110 (inclusive).

MaxVal Use the MaxVal option to set the highest
allowed value to be represented on the
progress bar.

. Syntax: MaxVal=<number>;

A progress bar with the setting
MaxVal=300; will show values up to and

including 300. Values higher than 300
will not be shown.

If a minimum value (MinVal) has been
set, the progress bar will show any values
between MinVal and MaxVal (inclusive);
otherwise the minimum value will default
to 0. So, 1f MaxVal=300 the progress bar
can show values between 0 and 300
(inclusive).
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Text Use the Text option to define additional

text to display on the right hand side of

the progress bar. The text might be a

resource name or the current take up of

the total allowed budget of a project.

. Syntax: Text=<text>; - displays the
defined text string, such as 'David
Brown's Tasks'

. Syntax: Text=#Value#; - displays the
value of the progress bar Tagged
Value, such as '462' (where the Tagged
Value name itself might indicate the
type of value or unit)

. Syntax: Text=<text> #Value# <text>; -
displays the value of the progress bar
Tagged Value with text before and/or
after it, such as '$<value> of $100,000'

This illustration shows a number of
examples of using the Text option.

Project Alpha

Development

[ ——— ] $150,000 / $300,000
Implement

—— | Terry

Marketing

$250,000 / $300,000
Progress
E———— |  30% Complete

Compartment =By default, progress bars in an element
display together in a separate
compartment from other types of Tagged
Value (provided that the diagram and/or
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clement are set to display tag
compartments).

When there are several progress bars on
an element, each relating to a different
factor of the project, it can become harder
to distinguish between them. In these
cases it 1s possible to set the progress bars
to display 1n specific compartments in
order to increase clarity. This also
provides an additional level of labeling.
So you might have an element relating to
costs, and two or more compartments that
indicate costs of different departments,
where the department name i1s reflected in
the compartment name. Or compartments
that each contain two or more progress
bars indicating, say, the costs and
percentage completion of tasks in each
department.

Syntax: Compartment=<name>;

To add multiple progress bars to the same
compartment simply give the progress
bars the same compartment name.

This example shows the element from the
Text parameter example, but with the use
of compartments to aid in readability.
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BackClr

FillClr
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Project Alpha

Progress
—— ]  80% Complete

Budget
Development
[ ———————————
Marketing

] $150,000 / $300,000

$250,000 / $300,000

Tasks
Implement

Terry

Use the BackClr option to override the
color used for the unfilled portion of the
progress bar.

. Syntax: BackClr=<color>;

<color> can be one of a variety of values,
such as the RGB value rgh(198,198,198)
for a light gray color.

See the Progress Bar Color Options table
for a full list of available values when
setting colors.

Use the FillClr option to override the
color used for the filled portion of the
progress bar.

. Syntax: FillClr=<color>;
<color> can be one of a variety of

options, such as the hex value #0000ff for
a bright red.

See the Progress Bar Color Options table
for a full list of available values when
setting colors.
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BorderClr Use the BorderClr option to override the
color that 1s drawn around the edges of
the progress bar.

. Syntax: BorderClr=<color>;

<color> can be one of a variety of
options, such as the keyword elementtext
to select the same color as the current
element's text color.

See the Progress Bar Color Options table
for a full list of available values when
setting colors.

Progress Bar Color Options

This table lists the different types of value that can be used
with the options BackClr, FillClr and BorderClr when
setting custom colors for a progress bar.

Value Description

rgb(red,green = Using rgb values you can set the red,
,blue) green and blue color components to
create the color you require.

Example: BackClr=rgb(46, 139, 87);
//Sets the unfilled portion of the progress
bar to a sea green color.
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. The red, green and blue values each
have a range of 0 to 255

This option can be useful in conjunction
with the color pickers from the 'Layout’
tab as they give an RGB value for the
currently selected color.

hsl(hue, Using hsl 1s very similar to using rgb.
saturation, Unlike rgb, however, it 1s easier to create
luminosity) a lighter or darker version of the same

color by simply adjusting the luminosity,
or to increase or decrease the intensity of
the color by adjusting the saturation.

example: FillClr=hsl(197, 71, 73); //Sets
the filled portion of the progress bar to a
sky blue color.

. The hue value has a range of 0 to 360

. The saturation and luminosity values
each have a range of 0 to 100

Hex Values Colors can also be defined using a hex
value.

example:BorderClr:#000000; //Sets the
border color of the progress bar to black.

. Hex values range from #000000 to
#HTTTTE

HTML Color It is also possible to use the standard web
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Names color names when defining a color for
progress bars.

example:fillclr=aliceblue; //Sets the
filled portion of the progress bar to the
standard color 'aliceblue’

. Enterprise Architect supports the 140
standard HTML color names.

Element Using ElementFill, ElementLine or

Colors ElementText will set the color value to
the fill, line or text color of the
currently-selected element (that is,
ElementFill will apply the element's
current fill color).

Colors set this way can be further refined
by using the modifiers s:=<value> and
l:=<value> to modify the color's
saturation and luminosity, making the
color assigned to the progress bar a
slightly altered version of the currently
selected element color.

These settings can be useful if the
clement is expected to change color (such
as from the use of a Diagram Legend) to
keep the progress bars themed correctly
with the element.

example:backclr=elementfill:s=-10:1=20:
; //Sets the unfilled portion of the
progress bar to be the same as the
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element's fill color but with a 10%
decrease in the color's saturation and a
20% increase in the luminosity.

. s and I can be any value; however, the
results can vary depending on the
currently selected color (for example, a
luminosity increase of 20% might not
be as noticeable on a very light color
compared to a darker color)

none The none keyword is used to indicate that
no color should be applied to the selected
field.

example:borderClr=none; //Removes the
border from the progress bar.

Progress Bars with MDG Technologies

Progress bars can also be created within MDG Technologies
to define a consistent set of progress bars for use with
multiple projects.
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Personal Tasks

Using the Personal Tasks view, you can record and manage
your personal work within the project. This view displays
information based upon your identity as a defined Author on
the project.

Access
Ribbon Start > Collaborate > My Gantt
Work Category

Category Detail

Allocated Presents a Gantt chart on which you
Work record the work that you are currently
engaged in.

Project Tasks = Enables you to monitor and maintain the
work tasks that have been assigned to
you, or that you have created yourself.
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Review Allocated Work

The 'Allocated Work' tab lists the elements to which your
model Author ID has been allocated as a resource, where
your Author ID i1s the same as:

. Your Enterprise Architect security user ID, if security has
been enabled, or

. Your workstation login ID if security has not been
enabled

For each element, the tab:

. In the left-hand panel lists the roles or tasks assigned to
you as a resource on that element, for which the
'Complete %' field value is less than '100'

. In the right hand panel displays a Gantt chart showing
your progress in performing each role or task

You can add further work items for an element through the
'Allocated Work' tab; however, you cannot delete any

records. A record 1s no longer listed when the 'Complete %'
field value is '100'.

You or your supervisors can also add records through the
Resource Allocation window.

Access

Ribbon Start > Collaborate > My Gantt >
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Allocated Work

Select Allocated Work options

Option

Review
element
properties

Review
resource task
details
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Action

Double-click on the element name.

(Alternatively, right-click on the element
name and select the 'Show Element
Properties'option.)

The 'Properties' dialog for the element
displays; review the pages as required.

Double-click on the task item.
(Alternatively, either:

. Double-click on the progress bar for
the item on the Gantt chart, or

. Right-click on the task or role name
and select the 'Show Task Properties'
option)

The 'Assigned Resources' dialog displays,

which has the same content, format and

functions as the Resource Allocation
window, in 'Item' mode.

Should it be necessary to reassign the
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Create new
task item

Refresh
display to
incorporate
changes

Display the
Resource
Allocation
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item to another resource, click on the
drop-down arrow on the 'Resource’ field
and select the appropriate 'Author ID';
when you save the changes, the item no
longer appears 1n the list of tasks
assigned to you.

Right-click on the element name and
select the 'Add Resource' option.

The 'Assigned Resources' dialog displays,
with your Author ID in the grayed-out
'Resource’ field.

Complete the dialog as for the Resource
Allocation window.

Your work 1item can be edited in a
number of places in Enterprise Architect,
such as the Project Task Allocation
window and the 'Resource Allocation'
tab; the element to which it 1s assigned
can be edited in these and many other
areas.

To refresh the display with any changes
made elsewhere, right-click on the
display and select the 'Refresh' option.

Right-click on the entry and select either
of the options:

. 'Show Element Resource Allocation
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records for
the element

Display tasks
for today
only, or for
another day
only

Filter the
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window' (if the window is closed or

hidden)

. 'Find Task in Element Resource

Allocation window' (if the window is
visible but showing the details of
another element)

The Resource Allocation window
displays, with the details of the selected
entry shown in the fields and the other
resource allocations for the element listed
in the left-hand panel.

You can edit the details and, if necessary,
change the resource allocated to the
element.

Right-click on the display and select the
option:
. 'Show only Active tasks for today' - to

show only tasks that are in progress
today

. 'Show only Active tasks for another

day' - to show only tasks that were in
progress on a specific day in the past,
or that are scheduled to be in progress
on a day in the future; a calendar dialog
displays from which you select the day
to examine

The display default is to show current
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display by tasks for which the end date has not yet

Start or occurred. Right-click on the list and
Completion | select one of the options:
date . 'Include Completed Tasks Within the

Last ...' - to display incomplete tasks
and tasks completed only within the
last period; you can set this period to 7,
30 or 90 days, or you can include all
completed tasks, or hide all completed
tasks

. 'Include Future Tasks Starting in ..." - to
display current incomplete tasks and
completed tasks (depending on the
setting of the 'Include Completed Tasks
Within the Last ..." option) and future
tasks that have been recorded and are
due to start within the next period; you
can set this period to 7, 30 or 90 days,
or you can show all tasks that have
been recorded but are not yet due to
start

Identify Right-click on the display and select the
overdue tasks = 'Display Highlight For Overdue items'
amongst the | option and one of its sub-options:

items . 'Show in Red' - to display the
uncompleted percentage of the task

bars for overdue items on the Gantt
chart in red
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. 'Show in Red to Current Date' - to
extend the task bars of the overdue
items to today's date, and display them
1n red

. 'None' - to cancel any overdue item
highlighting that has been set

Display Right-click on the display and select the
ONLY 'Show Overdue Items Only' option.

overdue tasks = The display shows only those items for
which the end date has passed but that are
not 100% complete. These items do not

have red highlighting.
Locate the Right-click on either the element or the
clement in work 1item and select the 'Find in Project
the Project Browser' option.
Browser The appropriate Package hierarchy

expands in the Project Browser, and the
selected element 1s highlighted.

Reposition Right-click on the display and select the
the Gantt 'Go to | Auto Sync with Task End Date'
chart to option.

automatically = Whilst this option 1s selected (with a tick
show the end | pext to it), whenever you click on an

date of a allocation in the 'Allocated Work' tab the
selecte.d display adjusts to show the end date of
allocation the task in the center of the chart.
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Expose Some items might operate over a long
hidden period of time, and you might not be able
sections of to display the complete progress line for
the work item = the item in the Gantt chart.

progress To locate the start point, expected end

point, or today's date on the progress line
for an item, right-click on either the item
or the progress line and select the
appropriate option:

. Go To | Task Start Date

. Go To | Task End Date

. Go To | Today's Date

The Gantt chart shifts left or right to
position the required point in the center of

the display.
Execute If scripts have been defined for analyzing
Scripts the task data, click on the 'Scripts' option

to display the list of script names. Click
on the appropriate name to execute the
script on the selected item or items.

Filter the Y ou can refine the list of work items to
work items show only those containing text that
matches the filter item.

Right-click on the tab and select the
'Show Filter Bar' option.
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Capture an
image of the
Allocated
Work data as
a graphics
file

Copy an
image of the
Allocated
Work data to
the clipboard
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The filter bar displays at the top of the
panel; type in the filter text.

As you type, the items listed and the
Gantt chart are filtered to show only
items where the item names match the
text string.

The filter does not operate on the element
names.

If you do not want to use the filter,
right-click on the tab and select the 'Hide
Filter Bar' option.

Right-click on the tab and select the 'Save
Image to File' option.

The 'Save As Image' dialog displays, on
which you specify the file name, location
and graphics file type to save to.

Right-click on the tab and select the
'Copy Image to Clipboard' option.

You can paste the image from the
clipboard into your preferred graphics
package.
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Monitor Your Tasks

The 'Project Tasks' tab lists the tasks that you either:
. Own, or
. Are assigned to

You can use the tab to review the status and progress of
tasks that you are responsible for, and to modify and filter
the display of task information. You can create the tasks
through the:

. 'Project Tasks' tab itself
. 'Tasks' tab of the Project Status window
. Project Tasks view of the Resource Calendar

Access

Ribbon Start > Collaborate > My Gantt > Project
Tasks

Make selections from the options

Option Action
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Add or
Modify a task

Delete a task

Select
columns

Reorganize
tasks in the
list
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You add or modify a task through the
'"Task Detail' dialog, which displays when
you double-click on an entry (edit) or
blank line (create).

Right-click on the message and select the
'Delete' option.

You are prompted to confirm the
deletion.

Right-click on the column headings and
select the 'Field Chooser' option, which
enables you to add or remove specific
columns from the display.

You can also click on the column
headings and drag them across the header
bar to reposition the columns in a
different sequence.

Either:

. Click on the column heading and click
on the arrow head to list items in order
or reverse order, or

. Right-click on the column headings
and select the 'Enable Group Box'
option to organize the messages into
groups

You can also use the filter bar to filter the

display on an appropriate column value,
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such as the value 'New' in the 'Status'
column; to display or hide the filter bar,
right-click on the column headings and
select the "Toggle Filter Bar' option.

Set persistent | Right-click on the tab and select the 'Set
Status filter term filter' option.
The 'Filter by Status' dialog displays,
which enables you to select to list tasks of
any status or only of one specific status.

The filter you set persists when you close
the Personal Tasks window or exit from
Enterprise Architect.

Print the task = Right-click on the tab and select the 'Print
list List' option.
The 'Print' dialog displays, on which you
specify the local printer and the print
characteristics.
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Project Management Windows

The Project Management windows show the records of
these quantities associated with an element contained in the
model:

. Resources - the people who work on a project, who are
assigned roles and allocated tasks

. Effort - effort expended in work on the element

. Risks - risk associated with the element

. Metrics - metrics measured for an element

A separate window displays for each of the four quantities.

Access

Ribbon Construct > Task Management >
Resource Allocation

Construct > Change Management >
Effort

Construct > Change Management > Risks

Construct > Change Management >
Metrics
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Toolbar Options

You can add or delete individual items in any of the four
Project Management windows, using the window toolbar
options.

Icon Action

New Create a new item, calling the Construct
window at the appropriate page.

Delete Delete the selected item from the list.

Print Print the list of items.

Help Show this Help topic for this window.
Notes

. Click on an element in the Project Browser to switch to
the project management items for that element in the
Project Management windows

. Columns in the item list can be reorganized, added,
removed, grouped, filtered and sorted using the options
provided in the List Header facilities

. Right-click on the list to view the context menu, which
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you can use to also add and delete items in the window
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Testing

71

It 1s important in any project to perform quality control of
both the process and the output of the project; Enterprise
Architect provides several facilities for testing and
validating your model structure and content, including
Integration with the unit testing tools JUnit and NUnit

Facilities
Facility Description
Testing Create and manage test scripts for model
=) clements. Explore the Testing Ul
=4 supporting unit, integration, scenario,

system, acceptance and inspection tests.

Model Check UML elements, diagrams or
Validation = Packages against known UML rules
| (identified in configuring validation) and
| constraints defined within the model,
using the Object Constraint Language
(OCL). Define your own checks against
custom rules and constraints. See the
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Model Validation topic for more
information on setting up model
validation rules.

Testpoint Pass or fail application tasks, viewing test
Management | results in real time as the program
- executes and results are saved. See the
. N section on Testpoints management for
more information on setting up and
running automated tests.
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Test Management

il

> -
oo

Enterprise Architect is not only a UML Modeling
environment, it is also a complete Test Management
environment. Using Enterprise Architect you can create and
manage test scripts for model elements, developing unit,
integration, scenario, system, acceptance and inspection
tests; these can include test cases generated from xUnit
testing and Testpoint Management.

You can also import tests from other elements, generate
them from scenarios, and generate test documentation and
reports; you can indicate the presence of tests on an element
by displaying test information on the element in a diagram.

It 1s simple to attach even complex tests to any model
element. Keeping the model elements and the testing
documentation in one integrated model significantly
improves the communication between the test-team and the
software developers and architects.

The system's detailed search facilities make it easy to find
failing test cases, test cases not run and test cases that have
been passed; using the testing and search capabilities, it 1s
easy to navigate through the model and quickly locate
problem spots, design flaws and other critical issues.
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Test Tasks

Tasks

Create Tests

(c) Sparx Systems 2018

Detail

You initially create tests in the Construct
window.

Typically, you create:

. Unit tests for things that are being built,
such as Classes and components

. Integration tests to test how
components work together

System tests to ensure the system meets
business requirements

. Acceptance tests to test user
satisfaction

Scenario tests to test the end-to-end
suitability and functionality of the
application

. Inspection tests for peer review of
things that are being built using a well
defined process

These test categories are otherwise
referred to as test Classes; the type of
Class 1s internally identified by a value
from 1 to 6 corresponding to the test
types in the order as listed.

Page 215 of 333



User Guide - Project Management 21 December, 2018

Using Tests Tasks that you might perform via the
Testing window when working with tests
include:

. Import a scenario as a test
. Move or copy tests between test classes
. Import a test from other elements

. Import an internal requirement or
constraint as a test

. Create a maintenance item from a test
. Generate a Test Details report

Show test script compartments
. Create test documentation

Notes

. Most of the listed tasks relate to a tests for a single
element

. You can display the Testing window for an element on a
diagram, by clicking on the element and pressing the T
key

. You can make a set of tests available to a number of
elements by performing the listed tasks on a Test Case
clement and then associating that Test Case with each of
the other elements; the Test Case element also helps to
make tests more visible in diagrams, the Project Browser,
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windows and searches
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Create Test Records

When you need to create or edit a test record on an element,
for any of the six types of test, you can do so using the
Construct window.

Whichever type of test you are recording, you complete
effectively the same fields.

Access

Ribbon

Keyboard
Shortcuts

(c) Sparx Systems 2018

Start > Explore > Properties > Construct :
= | Tests | <test class> : (&
Start > Explore > Browse > Element

Browser > Testing > Add New <test
class> (complete Construct window

fields)

Construct > Testing > Tests > <test

class> : i (complete Construct window
ﬁelds)

Alt+3 : <test class> [ (complete
Construct window fields)

Click on the element on a diagram | Press
T
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Create a test record

Field/Button Action

Test Type the name of the test. This can be
any alphanumeric text string you want to
use.

Auto As an alternative to typing in the name,

click on [ to insert predefined
auto-counter text; i1f you do not have
auto-counter text configured, an
information message displays.

If you already have some text in the "Test'
field, it 1s over-written by the
auto-counter text.

Type Click on the drop-down arrow and select
the value indicating the type of test
(Load, Regression or Standard).

Run Date Click on the check box and then on the
drop-down arrow and select the date on
which the test 1s to be run (or when 1t was
last run).
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Result

Run By

Check By

Description

Input

Acceptance
Criteria

(c) Sparx Systems 2018

Click on the drop-down arrow and select
the value indicating the current status of
the test (Not Run, Pass, Fail, Deferred or
Canceled).

Click on the drop-down arrow and select
the name of the person who is to run, or
has run, the test. (Possible values are
derived from the Project Author
definitions in the 'People' dialog - select
the 'Configure > Reference Data >
Project Types > People > Project
Authors' ribbon option.)

Click on the drop-down arrow and select
the name of the person who is to check,
or has checked, the test run.

Type a description of the test; you can
format the text using the Notes toolbar at
the top of the field.

Type in the mput data provided to the
test; you can format the text using the
Notes toolbar at the top of the field.

Type the acceptance or test success
conditions; you can format the text using
the Notes toolbar at the top of the field.
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Results Type the results of the last test; you can
format the text using the Notes toolbar at
the top of the field.

Save Click on this icon to save the data you

have entered and to add the entry to the
Testing window and the Project Browser

Notes

. On the Construct window you can quickly add a series of
tests of one type or several types, using the & icon or the

=7 1con

. To access an existing item for editing, display the Testing
window for the element and click on the item; the details
display in the Construct window where you can edit them

. To delete an item, click on it on the Testing window or
Construct window and click on the Delete icon in the
window toolbar; in response to the confirmation prompt,
click on the Yes button

. A further possibility for generating and editing Test items
1s to right-click on the Testing folder in the Element
Browser - or the required item within the folder - and
select menu options to perform the required operation in
the Construct window
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. To change the element for which to create or edit test
items, click on the element in a diagram or the Project
Browser

. In the Corporate, Unified and Ultimate editions of
Enterprise Architect, if security 1s enabled you must have
'Manage Tests' permission to add, update and delete test
records
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Show Test Script Compartments

When you have created a Test record, it is useful to make
the test visible on its parent element. You can do this by
displaying the test within a Test Script compartment on the
element as it displays in a diagram. Any element that 1s
capable of displaying a compartment, and that has a test
assigned to it, can show test scripts in a diagram.

Show the Test Scripts on an element in a
diagram

Ste Action
p

1 | Open a diagram containing the element with the
attached test items.

2 Double-click on the diagram background to display
the diagram "Properties' dialog.
Click on the 'Elements' tab.

3 | Inthe 'Show Compartments' panel, select the
"Testing' checkbox.

4 Click on the OK button to save the setting.
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Each test item now appears in the test scripts
compartment of the diagram element. Items of each
type are grouped together so that, for example, all
Unit Tests on the element are grouped under the
heading 'Unit', and all Integration Tests on the
element are grouped under the heading 'Integration’.

If you click on a test item and the Construct window
1s open, the test details are immediately displayed in
the window. If the Construct window 1s not open,

click twice on the item.

Example

CCBookClientPanel

«SM_Activitys»
+ (CCBookClientPanel
+ GetBook: CBook

~  bookpanel(): CCBookPanel

test scripts

Unit

Valid Inputs Pass
Integration

Pass on output Not Run

maintenance

Issue

Run time New

Triggers New
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Move or Copy Tests Between Test
Classes

After you define a test within one test class (Unit,
Integration, System, Acceptance, Inspection or Scenario),
you might decide that the test either is better suited to
another test class, or forms a good template for tests in other
classes. If so, you can either move or copy the test to the
other class lists.

Access

Click on the element containing the test records.

Ribbon Construct > Testing > Tests > <test
class> > Right-click on test to move/copy

Start > Explore > Browse > Element
Browser > Testing > <test class> >
Right-click on test

Keyboard Alt+3 : right-click on test to move/copy
Shortcuts

Move or copy a test
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Ste Action
p

1 | Click on the appropriate option - 'Move to' or 'Copy

'

to'.
A list of test classes displays.

2 | Click on the test class to which to move or copy the
test.

A confirmatory prompt displays.

3 Click on the Yes button to confirm the move or
copy.

4 In the "Test Class' field in the Testing window
toolbar, click on the drop-down arrow and select the

test class you moved/copied the test into, to check
that the Test has been added.

Open the Construct window (the 'Start > Explore >
Properties > Construct' ribbon option) and make any
necessary changes to the Test record.

5 | If'you are copying the test to more than one other
test class, repeat steps 1 to 4 for the next class to
copy to.
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Notes

. If you move or copy a test into the Scenario class, some
unassociated data could be lost
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Create Maintenance Item From Test

If an element fails a test, one likely consequence is that a
Defect (Issue) item has to be raised in model maintenance to
correct the problem. You can generate this Defect item
directly from the test that failed.

Access

. Select the element containing the failed test, then use one
of the methods outlined here to display the Testing
window or Element Browser

Ribbon Construct > Testing > Tests > <test
class> > Right-click on test > Create a
Maintenance Defect from this test

Start > Explore > Browse > Element
Browser > Testing > <test class> >
Right-click on test > Create a
Maintenance Defect from this test

Design > Element > Properties > Element
Browser > Testing > <test class> >
Right-click on test > Create a
Maintenance Defect from this test

Keyboard Alt+3 : <test class> | Right-click on test |
Shortcuts Create a Maintenance Defect from this
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test

Alt+9 : Testing > <test class> >
Right-click on test > Create a
Maintenance Defect from this test

Create a Maintenance item from a test

Ste Action
p

1 | The system immediately creates the Defect item and
displays a confirmation message box.

Click on the OK button to clear the message.

2 | Open the Defects window (the 'Construct > Change
Management > Defects > Show Defects Window'
ribbon option).

The window shows a Defect item having the same
name as the test.

3 | Double-click on the Defect item to open it in the
Construct window, and edit the item as necessary -
you might provide values for the 'Reported By',
'Status' and 'Priority’ fields.
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Notes

. You can create Maintenance Defect items from several
Test items at once; press and hold Shift as you select the
Test items, and then right-click and proceed as before -
each selected Test item then generates a Defect item
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Import Scenario as Test

If you are creating a test for a scenario from either a single
element or many elements in a Package, you do not have to
manually re-type the scenario details into the test record in
the Construct window. You can generate the test into the
'Scenario' tab of one element from one or more scenarios in
any element in the model.

Within the Scenario test record, the scenario description is
copied to the 'Description' tab. If a scenario contains a
Structured Specification, its Action steps are also copied to
the 'Description' tab under the heading 'Structured
Specification'.

Access

Click on the element containing the test records.

Ribbon Construct > Testing > Tests > <test
class> > right-click on test > Import
element scenario(s) or

Construct > Testing > Tests > <test
class> > right-click on test > Import
Package Scenarios or

Start > Explore > Browse > Element
Browser > Testing > <test class> >
Right-click on test > Import element
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scenario(s)

Start > Explore > Browse > Element
Browser > Testing > <test class> >
Right-click on test > Import Package

Scenarios
Keyboard Alt+3 : right-click on test | Import
Shortcuts clement scenario(s) or

Alt+3 : right-click on test | Import
Package Scenarios

Import a scenario from a single element

The 'Tmport Scenario' dialog displays.
Field/Button | Action

Select If you are copying scenarios from a

element different element to the target element,
click on the drop-down arrow and select
the source element. The list identifies
elements that have scenarios that can be
imported.

Otherwise, leave this field blank.

Show related @ Select this checkbox to restrict the list of
elements selectable elements to those that are
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only
Limit
selection to

these Object
Types only

Refresh

Select items
to import

Import As

All
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related to the target element.

If you want to restrict the list of
selectable elements to only those of
specific types, type in those element
types in a comma-separated list.

Click on this button after changing any of
the field values, to refresh the list of
available elements in the 'Select element'
field drop-down.

Lists the scenarios defined in the source
clement. Select the scenario(s) to import.

If you do not use the 'Select element'
field, any scenarios listed are from the
current element to which this test record
belongs.

If you have selected a different element,
the scenarios come from that element.

Defaults to the test class of the Test you
selected to populate from the scenario. If
you need to change this, click on the
drop-down arrow and select a different
test class from the list.

Click on this button to select all scenarios
listed in the 'Select items to import' field.
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None

Import

Click on this button to clear the selection
of scenarios listed in the 'Select items to
import' field.

Click on this button to import the selected
scenario(s).

Import scenarios from the elements in a

Package

Field/Button | Action

Limit
selection to
these Object
Types only
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If you want to restrict the selected
clements to only those of specific types,
type in those element types in a
comma-separated list.

This version of the 'Import Scenario'
dialog lists all scenarios against all
clements in the Package; it does not
enable you to select a specific element,
but does enable you to filter the list of
scenarios to those from specific types of
element.

Click on this button after changing the

Page 235 of 333



User Guide - Project Management 21 December, 2018

Refresh

Select Items

to import

All

Import As

None

Import

Notes
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'Limit Selection...' field value, to refresh
the list of available elements in the 'Select
items to import' field.

Lists the scenarios defined in the selected
elements in the Package. Select the
scenario(s) to import.

Click on this button to select all scenarios
listed in the 'Select items to import' field.

Defaults to the test class of the Test you
selected to populate from the scenario. If
you need to change this, click on the
drop-down arrow and select a different
test class from the list.

Click on this button to clear the selection
of scenarios listed in the 'Select items to
import' field.

Click on this button to import the
scenarios from each element as Scenario
tests.
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. In the Corporate, Unified and Ultimate editions of
Enterprise Architect, if security 1s enabled you must have
'Manage Tests' permission to add, update and delete test
records
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Import Test From Other Elements

If you have created useful tests in one element, you can
import those tests into any other element through the
Testing window or Element Browser, and so avoid having to
duplicate the test information manually. You open the
Testing window for the empty, target element and then
select the source element that contains the tests to import.

Access

Select target element, then:

Ribbon Construct > Testing > Tests > <test
class> | Right-click on tests | Import tests
from other element

Start > Explore > Browse > Element
Browser > Testing > <test class> >
Right-click on tests | Import tests from
other element

Keyboard Alt+3 : Right-click on tests | Import tests
Shortcuts from other element or

Alt+9 : Testing folder | Right-click on
tests | Import tests from other element
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Import a test

The 'Tmport Element Tests' dialog displays.

Field/Button | Action
Select Click on the drop-down arrow and locate
element and select the source element.
This list identifies elements that have
tests that can be imported.
Show related = Select this checkbox to restrict the list of
elements selectable elements to those that are
only related to the target element.
Limit If you want to restrict the list of
selection to selectable elements to only those of
these Object | specific types, type in those element
Types only types in a comma-separated list.
Refresh Click on this button after changing any of

Select items
to import

(c) Sparx Systems 2018

the field values, to refresh the list of
available elements 1n the 'Select element'

field.
Lists the tests defined in the source
clement. Select the test(s) to import.

If you have not used the 'Select element'
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Import As

All

None

Import

Notes

field, any tests listed are from the current
clement to which this test record belongs.
There 1s no purpose in importing these.

Defaults to the test class of the Test you
selected to populate from the other
element. If you need to change this, click
on the drop-down arrow and select a
different test class from the list.

Click on this button to select all tests
listed in the 'Select items to import' field.

Click on this button to clear the selection
of tests listed in the 'Select items to
import' field.

Click on this button to import the selected
test(s).

. In the Corporate, Unified and Ultimate editions of
Enterprise Architect, if security 1s enabled you must have
'Manage Tests' permission to add, update and delete test

records
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Import Requirement or Constraint as
Test

If you are creating a test against an internal requirement or
internal constraint of an element, you do not have to
manually re-type the details into the test record in the
Construct window. You can generate a testing record on the
element from the requirement or constraint.

The test record 1s generated into the Construct 'test-type’'
window that you currently have open, and the requirement
or constraint description is copied to the 'Description' tab for
the test record.

Access

Select an element, then use one of the methods outlined here
to display the Testing window or Element Browser.

Ribbon Construct > Testing > Tests > <test
class> > Right-click on test list > Import
clement constraint(s) or Import element
requirement(s)

Start > Explore > Browse > Element
Browser > Testing > <test class> >
Right-click on test > Import element
constraint(s) or Import element
requirement(s)
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Design > Element > Properties > Element
Browser > Testing > <test class> >
Right-click on test > Import element
constraint(s) or Import element

requirement(s)
Keyboard Alt+3 : <test class> | Right-click on test
Shortcuts list | Import element constraint(s) or

Import element requirement(s)

Alt+9 : Testing > <test class> >
Right-click on test > Import element
constraint(s) or Import element
requirement(s)

Import a requirement or constraint as a test

Ste | Action
p

1 | On the Tmport Constraint' or 'Tmport Requirements'
dialog (the two dialogs are identical) review the list
of internal requirements or constraints in the selected
element.

2 | Click on one of the items to import as a Test, or
press Ctrl+click on more than one to import several.
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The 'Tmport As' field defaults to the test class of the
Test into which you are importing the requirement or
constraint details. If you need to change this, click
on the drop-down arrow and select a different test
class.

3 | Click on the OK button.

Each item 1s added to the list of tests in the Testing
window, under the appropriate <test-type>, as a
standard, 'Not Run' test.

Double-click on one item to open the Construct
window to edit the test details; thereafter, just click
once on the next test item to edit that in the
Construct window.

Notes

. In the Corporate, Unified and Ultimate editions of
Enterprise Architect, if security 1s enabled you must have
'Manage Tests' permission to add, update and delete test
records
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Test Documentation

After you have recorded a number of test scripts and results
against elements in the model, you can output the
information as a report in Rich Text Format, using the
'Generate Test Documentation' dialog. You can select the
types of test to include or exclude in the report and whether
to include child Packages, and enter the file location to
which to generate the report.

Click on the Generate button to produce the report.

You can also run a number of searches to show the results -
where generated - of tests:

. Not Run

. Not Checked

. Recently run

. Recently Passed

. Recently Failed

. Recently Deferred

. Run on recently modified elements
. Run in the last week

. Run in the last 30 days

Access

Select a Package, then use the ribbon options:
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Ribbon Construct > Testing > Report  (to
display the 'Generate Test
Documentation' dialog)

Construct > Testing > Not Run
Construct > Testing > Not Checked

Construct > Testing > Test Results >
<report type>
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Maintenance

/ |ff [,i 4 &, !

In the course of your team's work on a model, changes and
issues can arise at a number of levels, for problems that
apply system-wide through areas of the model and down to
within a specific element. A Change, very broadly, defines
an addition or alteration to a requirement, whilst an Issue
identifies either a failure to meet a requirement, or a risk in
meeting the requirement.

There are two mechanisms that can be used to identify a
change or issue, and the work required to resolve it:

. Change and Issue (or Defect) elements - structured
comments that identify a problem at system-level,
although they can also be attached to a specific element
from which a problem arises; both types of element can be
linked by relationships such as Association, Dependency
and Realize to one or more other elements that have to be
reviewed, and for complex problems can form hierarchies
Or groups

. Maintenance items - properties raised against a specific
element and recorded for that element in the Maintenance
window; these provide a distinction between Defects (a
failure to meet a requirement) and Issues (a risk factor that
might affect satisfying the requirement) and also include
Tasks, which record work 1tems associated with the
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element

Maintenance items are very specific, but if an item begins
to have a wider impact on other elements or the system in
general, you can translate that item into a Change, Issue,
or any other type of element that best identifies the
problem and its solution

Maintenance items are defects, changes, issues, tasks, events
and decisions that apply at the model element level. They
are properties of individual model elements that can be used
to record and capture problems, changes, issues, tasks,
events and decisions as they arise, and document the
solution and associated details.

Maintenance Tasks

Task Area Detail

Maintenance @ You create maintenance items in the

Items - Construct window. Typically you create:

Element-leve |, A defect to record a failure to meet a

1 requirement for the current model
clement

. A change to record a change in
requirement for the current model
element

. An issue to record a risk factor that
might affect the project being recorded
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for the current model element

. A task to record work in progress and
work outstanding for the current model
clement

. An event to record the action taken for
the current model element

. A decision to record the choice taken
for the current model element

Creating and | Tasks that you might perform when
Editing working with maintenance items include:

Maintenance . Moving or copying maintenance items
Items between maintenance types

. Generating new items of one type from
an item of a different type

. Creating elements from maintenance
[tems

Showing maintenance items on
elements in a diagram

. Adding a maintenance item directly to
an element via in-place editing

. Generating a report on the status of
maintenance items of specific types or
all types

Maintenance  To represent changes, defects and issues
- that apply to the model you can create
System-level | Change and Issue elements with - if
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necessary - subordinate structures.

To represent 1ssues and tasks that apply
to the progress of the project as a whole
and that are not related to model
structures, you create Project Status
records in Project Management.
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Working on Maintenance Items

Creating, viewing and modifying the Maintenance items -
changes, 1ssues, defects, tasks, events and decisions -
associated with a particular model element is quick and
convenient, using the Construct window and the
Maintenance windows. If a Maintenance window is open,
when you select an element in a diagram or in the Project
Browser, the appropriate maintenance items for that element
are immediately listed in the window, and you can select
them there to modify in the Construct window. The
Maintenance windows provide several facilities for
managing the maintenance items.

You can include the maintenance items in the document and
web reports generated on your model. The 'Document Setup'
dialog has checkboxes to show or hide element maintenance
items.

Access

Ribbon Start > Explore > Properties > Construct

Construct > Change Management >
Changes > Show Changes Window

Construct > Change Management >
Defects > Show Defects Window

Construct > Change Management >
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Issues > Show Issues Window

Construct > Change Management >
Tasks > Show Tasks Window

Construct > Change Management >
Events > Show Events Window

Construct > Change Management >
Decisions > Show Decisions Window

Facilities

Facility Detail

Maintenance @ The six types of Maintenance Item you
Item Types can create records for are each listed on a
separate Maintenance window:

. Defects - each recording a failure to
meet a requirement for the current
model element

. Changes - each recording a change in
requirement for the current model
element

. Issues - each recording a risk factor
that might affect the project, associated
with the current model element

. Tasks - each recording work in
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progress and work outstanding for the
current model element

. Events - each recording the action
taken on a requirement of the current
model element

. Decisions - each recording the choice
made on a requirement of the model
clement

Similarly, the Construct window reflects
the type of item you have selected, and

you can click on the =" icon in the
Construct window toolbar to select the
type of maintenance item to create
('‘Maintenance > <item type>').

Adding New  To add new items, click on the & icon in

Items the window toolbar on either the
Maintenance window or the Construct
window. In either case, the appropriate
fields for the item type are displayed on
the Construct window, where you create
the item.

The fields you complete for each type of
maintenance item are very similar.

Applying On the Construct window you can apply
Automatic an automatic naming/numbering
Naming/Num | convention that you have previously
bering defined, to each new item record. To do
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this, simply click on the [ icon next to
the 'Name' field.

If you already have some text in the
'Name' field, it is over-written by the
auto-counter text.

Element You can also use the Element Browser

Browser window to select and display specific
1tems on the Construct window; select the
'Start > Explore > Browse > Element
Browser > Maintenance > <maintenance
type>' ribbon option and double-click on
the required item.

Notes

. Columns in the item list can be reorganized, added,
removed, grouped, filtered and sorted using the options
provided in the List Header facilities
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Create Maintenance Items

When you need to create a new maintenance record for an
element, you can do so by selecting the 'New' option from
the toolbar of the Maintenance window or the Construct
window.

Access

Use one of the ribbon paths outlined here to display the
Maintenance window for the type of maintenance item to
create, then click on (& (the 'New' icon) to display the
Construct window for that item type.

Alternatively, display the Construct window directly ('Start

> Explore > Properties > Construct > = > Maintenance >
<maintenance item type> : i,

Ribbon Construct > Change Management >
Changes > Show Changes Window

Construct > Change Management >
Defects > Show Defects Window

Construct > Change Management >
Issues > Show Issues Window

Construct > Change Management >
Tasks > Show Tasks Window

Construct > Change Management >
Events > Show Events Window
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Construct > Change Management >
Decisions > Show Decisions Window

Create maintenance items

Option Action

Name / Event | Type the name or a short description of

/ Decision the defect, change, task, issue, event or
decision.
Auto As an alternative to typing in the name,

click on the [--] button to insert predefined
auto-counter text.

If you already have some text in the
'Name' field, it i1s over-written by the
auto-counter text.

Reported by / = Click on the drop-down arrow and select
Requested by  the user name of the person who initiated
/ Raised by the maintenance item.

Date Defaults to today's date as the date on
which the maintenance item was raised; if
necessary, change this by clicking on the
drop-down arrow and selecting a different
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Status

Resolved by /
Implemented
by /
Completed
by

Date
Resolved /
Date
implemented
/ Date
Completed

Priority

Version / ID

Description
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date.

Click on the drop-down arrow and select
the appropriate status of the maintenance
item, such as 'New' or 'Complete’'.

Click on the drop-down arrow and select
the user name of the person who
completed and closed the maintenance
item.

Select the date on which the maintenance
item was completed; click on the
checkbox to select today's date or, if
necessary, change the field by clicking on
the drop-down arrow and selecting a
different date.

Click on the drop-down arrow and select
the priority for completing the
maintenance item.

Type the version number associated with
this defect, change, task, event, decision
or 1Ssue.

Type a longer description of the
maintenance item; you can format the
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text using the Notes toolbar at the top of
the field.

History Enter any notes or references to previous
occurrences of this maintenance item;
you can format the text using the Notes
toolbar at the top of the field.

Save Click on this button to save the record
data.

Notes

. To edit an item, click on it on the Maintenance window;
the item details display in the Construct window for
editing

. To delete an 1tem, click on it on either the Maintenance
window or the Construct window and click on the - icon
in the window toolbar; in response to the confirmation
prompt, click on the Yes button

. A further possibility for editing and deleting items i1s to
right-click on items in the Element Browser window and
select menu options there; select the 'Start > Explore >
Browse > Element Browser > Maintenance >
<maintenance type>' ribbon option

. To change the element for which to create or edit
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maintenance items, click on the new element in the
Project Browser
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Move or Copy Maintenance Items

After you define a maintenance item of one type (Defect,
Change, Issue, Event, Decision or Task), you might decide
that the item either is better suited to another type or forms a
good template for items of other types. If so, you can either
move or copy the item to the other types.

Access

Display the appropriate Maintenance window using one of
the methods outlined here.

In the Maintenance window:

. Right-click on a maintenance item | Move to | <item type>
or

. Right-click on a maintenance item | Copy to | <item type>

Ribbon Construct > Change Management >
Changes > Show Changes Window

Construct > Change Management >
Defects > Show Defects Window

Construct > Change Management >
Issues > Show Issues Window

Construct > Change Management >
Tasks > Show Tasks Window

Construct > Change Management >
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Events > Show Events Window

Construct > Change Management >
Decisions > Show Decisions Window

Move or copy a maintenance item

Ste Action
P
1 | Click on the appropriate option - 'Move to' or 'Copy

'

to'.
A list of maintenance item types displays.

Click on the item type to which to move or copy the
item.

A confirmatory prompt displays.

Click on the Yes button to confirm the move or
copy.

Switch to the appropriate type version of the
Maintenance window to ensure that the item has
been added, double-click on the item to open it in the
Construct window and make any necessary changes.

(c) Sparx Systems 2018 Page 261 of 333



User Guide - Project Management 21 December, 2018

5 | If'you are copying the item to more than one other
item type, repeat steps 1 to 4 for the next item type
to copy to.
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Create Elements From Maintenance
Item

A maintenance item identifies a defect, change, 1ssue, event,
decision or task concerning an element. The maintenance
item could itself be represented by an element 1f it has wider
implications for the project or identifies - for example - an
actor, activity or action that requires further definition.

You can create one or more elements from any maintenance
item, using the Maintenance window. The new element is
connected to the maintenance item's parent element by a
Dependency connector. The original maintenance item
remains unchanged as a characteristic of its parent element.

Access

Use one of the methods outlined here to display the
Maintenance window appropriate to the maintenance item
from which to create a model element.

In the Maintenance window: Right-click on the maintenance
item > Create as New Element

Ribbon Construct > Change Management >
Changes > Show Changes Window

Construct > Change Management >
Defects > Show Defects Window

Construct > Change Management >
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Issues > Show Issues Window

Construct > Change Management >
Tasks > Show Tasks Window

Construct > Change Management >
Events > Show Events Window

Construct > Change Management >
Decisions > Show Decisions Window

Create an element from a maintenance item

Ste | Action
p

1 | Onthe 'New Element' dialog, complete the fields.

In the 'Type' field, select the required element type;
you might create:

. An Issue element for a Defect or Issue
maintenance item

. A Change element for a Change item, or
. An Action for a Task item

You can, however, create a wide range of other
clement types should any of these be more
appropriate.

When you click on the Save button, the new element
1s added to the Project Browser. You can drag and
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drop it onto a diagram from there.
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Show Maintenance Items in Diagram

When you have created a maintenance item, it is useful to
make the record visible on its parent element. You can do
this by displaying the record within a maintenance
compartment on the element as it displays in a diagram. Any
element that is capable of displaying a compartment, and
that has maintenance items assigned to it, can show the
items in a diagram.

Show maintenance items in a diagram

Ste | Action
p

1 | Open a diagram containing the element with the
attached maintenance items.

2 | Double-click on the diagram background to display
the diagram 'Properties' dialog.
Click on the 'Elements' tab.

3 | Inthe 'Show Compartments' panel, select the
'Maintenance' checkbox.

4 | Click on the OK button to save the setting.
Each maintenance item now appears in the
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maintenance compartment of the diagram element.
Items of each type are grouped together so that, for
example, all Issues on the element are grouped under
the heading 'Issue', and all Tasks on the element are
grouped under the heading 'Task'.

If you click on a maintenance item and the Construct
window 1s open, the item details are immediately
displayed in the window. If the Construct window is
not open, click twice on the item.

Maintenance Compartment - Example

CCBookClientPanel

«5M_Activity»
+ CCBookClientPanel
+ GetBook: CBook

~  bookpanel(): CCBookPanel

test scripts
Unit
Valid Inputs Pass
maintenance
Issue
Run time New
Triggers New
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Changes, Defects and Issues

If your work in managing a project identifies issues, defects
or required changes in the model rather than internal to a
single element, you can represent these using Change, Issue
or Defect elements as structured comments with which you
can track and manage the problems.

. A Change element corresponds to a change in
requirements for the current system

. An Issue element corresponds to a failure to match the
requirements for the current system due to newly arisen
organizational or legal factors such as staffing problems,
changes in laws or guidelines, or business unit
restructuring

. A Defect element corresponds to a failure to match the
requirements for the current system due to a flaw in the
model, system or process, such as a missing element or
module, or no inclusion of a necessary actor

You can also define any specific work to be done in
researching or resolving the problem using Task elements,
and assign resources to these or directly to the Change, Issue
or Defect elements internally, in Resource Allocation, or
externally as Actors.

The use of maintenance elements provides a broad scope for
managing changes, defects and issues, providing the facility
to fully define the problem and its resolution with Linked
Documents, both internal and external Notes, and
Composite Structure diagrams including Interaction and
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Activity diagrams.

You can create Change, Defect and Issue elements in
various UML diagrams (especially Maintenance diagrams)
and connect them using Realization, Dependency,
Aggregation and other relationships to show what model
elements each problem affects and how each is resolved.
Within the element 'Properties' dialog for Changes, Defects
and Issues you can i1dentify the problem as the element name
and record relevant management details, such as owner and
dates.

A useful tool 1n managing problems and changes is the
Relationship Matrix, in which you might - for example -
link staff (Actors) through Realization connectors to Issues.
Each highlighted square in the Matrix indicates the
responsibility of a staff member to work on or correct a
named Issue.
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Issues

In your modeling, issues concerning the development of the
system or model might arise; more formally, you encounter
a failure to meet defined requirements for the current
system. You can represent this failure using an Issue
element, which is a structured comment containing
information about the issue and the measures taken to
manage it. The element is rendered as shown.

Issue Elemant [

You can link Issues to model elements that are responsible
for the issue, using Realize connectors. You can also create
a hierarchy of related Issues using Aggregation connectors.
Each Issue element has a status band at the left end, which is
color coded to visually represent the value of the 'Status'
field in the element properties. The element has an
identifying 'T' in the top right corner, which you can hide if
you prefer not to show it.

You can create Issue elements on most types of diagram,
although the Maintenance diagram 1is specifically designed
for displaying and managing them. You can also create your
own issue-management diagram as a Custom diagram. You
can add the Issue (and other) elements to the diagram from
the Diagram Toolbox, or directly to a Package in the Project
Browser.
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Add an Issue to the model using the Toolbox

Ste Action
p

1  Open the Maintenance or Custom (or other) diagram
to define the problem.

2 | From the 'Custom' pages or 'Common' page of the
Diagram Toolbox, drag the Issue icon onto the
diagram.

3 Ifthe Properties window is not already displayed,
press Alt+1 on the element. Record the name and
details of the Issue, in the Properties window.

Add an Issue to the model using the '‘New
Element' dialog

Ste | Action
Y

1 | Identify the Package in which to record the Issue, in
the Project Browser.

Right-click on this Package and select the 'Add
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Element' option.

2 | Complete the fields on the 'New Element' dialog - in
the '"Type' field, click on the drop-down arrow and
select '[ssue’.

3 When you have created the element, record the name
and details of the Issue, in the Properties window.

Notes

. To toggle display of the letter 'T' in the top right corner of
the element, select or deselect the 'Show stereotype icon
for requirements' checkbox on the 'Preferences' dialog,
'Objects' page
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Defects

In your modeling, problems in the development of the
system or model might arise; more formally, you encounter
an obstacle to meeting defined requirements for the current
system, through a defect of the model, system or process.
You can represent this failure using a Defect element, which
is a structured comment containing information about the
defect and the measures taken to manage it. The element is
rendered as shown.

Defecti D

You can link Defects to model elements that are responsible
for the problem, using Realize connectors. You can also
create a hierarchy of related Defects using Aggregation
connectors. Each Defect element has a status band at the left
end, which 1s color coded to visually represent the value of
the 'Status' field in the element properties. The element has
an 1dentifying 'D' in the top right corner, which you can hide
if you prefer not to show it.

You can create Defect elements on most types of diagram,
although the Maintenance diagram 1is specifically designed
for displaying and managing them. You can also create your
own defect-management diagram as a Custom diagram. You
can add the Defect (and other) elements to the diagram from
the Diagram Toolbox, or directly to a Package in the Project
Browser.
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Add a Defect to the model using the Toolbox

Ste Action
p

1  Open the Maintenance or Custom (or other) diagram
to define the problem.

2 | From the 'Custom' pages of the Diagram Toolbox,
drag the Defect icon onto the diagram.

3 Ifthe Properties window is not already displayed,
press Alt+1. Record the name and details of the
Defect, in the Properties window.

Add a Defect to the model using the '‘New
Element' dialog

Ste Action
P

1 | Identify the Package in which to record the Defect,
in the Project Browser.

Right-click on this Package and select the 'Add
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Element' option.

2 | Complete the fields on the 'New Element' dialog - in
the '"Type' field, click on the drop-down arrow and
select 'Defect’.

3 When you have created the element, record the name
and details of the Defect, in the Properties window.

Notes

. To toggle display of the letter 'D' in the top right corner of
the element, select or deselect the 'Show stereotype icon
for requirements' checkbox on the 'Preferences' dialog,
'Objects' page
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Changes

In your modeling it might become necessary to change an
aspect of the system or model; more formally, you need to
request and manage a change in the defined requirements
for the current system. You can represent this change
request using a Change element, which is a structured
comment containing information about the change and the
measures taken to manage it. The element 1s rendered as
shown.

Change Element L

You can link Changes to model elements that are impacted
by the change, using Realize connectors. You can also
create a hierarchy of related Changes using Aggregation
connectors. Each Change element has a status band at the
left end, which 1s color coded to visually represent the value
of the Status field in the element properties. The element has
an identifying C in the top right corner, which you can hide
if you prefer not to show it.

You can create Change elements on most types of diagram,
although the Maintenance diagram 1s specifically designed
for displaying and managing them. You can also create your
own change-management diagram as a Custom diagram.
You can add the Change (and other) elements to the diagram
from the Diagram Toolbox, or directly to a Package in the
Project Browser.
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Add a Change to the model using the
Toolbox

Ste Action
P

1 | Open the Maintenance or Custom (or other) diagram
in which to define the problem.

2 | From the 'Custom' or 'Common' pages of the
Diagram Toolbox, drag the Change icon onto the
diagram.

3 | If the Properties window 1s not already displayed,

press Alt+1. Record the name and details of the
Change, in the Properties window.

Add a Change to the model using the 'New
Element' dialog

Ste Action
P

1 | Identify the Package in which to record the change,
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in the Project Browser.

Right-click on this Package and select the 'Add
Element' option.

2 | Complete the fields on the 'New Element' dialog - in
the 'Type' field, click on the drop-down arrow and
select 'Change’.

3 When you have created the element, record the name
and details of the Change, in the Properties window.

Notes

. To toggle display of the letter 'C' in the top right corner of
the element, select or deselect the 'Show stereotype icon
for requirements' checkbox on the 'Preferences' dialog,
'Objects' page
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Maintenance Diagram

A Maintenance diagram is a type of Custom diagram, an
extension to the UML model. It is a change management
tool, used to record:

. Requests for change to the model structure or project
process, as Change elements

. Issues that impact the development and progress of the
project, as Issue elements, and

. Groups of tests that can be applied to many elements
rather than specific elements, as Test Cases

Each Change, Issue or Test Case element can link to other
model elements in the project, to illustrate how they
contribute to or are impacted by the item, and how they
must be modified, removed, applied or extended to provide
a solution. This includes identifying areas of work,
represented by Task elements, to which resources can be
allocated as either external (Actor) elements or internal
properties (resource allocation).

You generate Maintenance diagram elements and
connectors from the 'Maintenance' pages of the Diagram
Toolbox, although you might also make frequent use of
connectors from other pages.

Example Diagram

Example Maintenance Diagram
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Maintenance Diagram Element Toolbox

Ilcons

Icon

1  Package

if_‘l Change

X Test Case
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Description

A Package is a namespace as well as an
element that can be contained in other
Package's namespaces.

Issue elements represent a failure to meet
defined requirements for the current
system.

This element represents a change in the
defined requirements for the current
system and can be used to request and
manage the change process.

A Task element represents a task that
must be performed in relation to an
clement.

A Test Case 1s a stereotyped Use Case
clement. You might use it to extend the
facilities of the Testing window, by
applying element properties and
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1 Entity

Test

Defect

capabilities to the tests of a feature
represented by another element or - more
appropriately - set of elements.

An Entity is a stereotyped Object that
models a store or persistence mechanism
that captures the information or
knowledge in a system.

A Test element represents a step in the
Basic, Alternate and Exception Paths of a
Scenario created in a Use Case or other
clement.

The defect element represents an obstacle
to meeting defined requirements for the
current system.

Maintenance Diagram Connector Toolbox

Ilcons

Icon

A Aggregate
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Description

An Aggregation connector is a type of
association that shows that an element
contains or 1s composed of other
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elements.
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Example Maintenance Diagram

Very simply, this example diagram depicts a request for a
change (C) to a process represented by an Activity element
(Transfer WH Receipts to Active Stock). The change
currently involves the Task (T) of reviewing the interface
between two recording systems, one of which could be
affected by an Issue (I) concerning an external stocktaking

system.

-

Warehouse Receipt/Stocktake Update

ol il bet Teln

1
sfraces
I

Review Interface Tk

Transfer VWWH Receipts to
Active Stock

|

|

|

|

I
TUSED

I

- |
oy v
WH Receipt D Paterial Code Stock Level
Log Reference Increment
_'__,..-""
=
A
I
|
|
Stocktake Counter
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Update Package Status

Often a complete Package structure moves from one status
to another (such as for release) in one operation. To help
facilitate this, Enterprise Architect supports a 'bulk' update
of Package and element Status, Phase, and Version, which
also provides the option of defining the scope of the update.

Access

Ribbon Design > Package > Edit > Advanced >
Update Status

Update Status across a Package

Field Action
New Status Type in or select the new status of the
Package.

New Phase Type the new phase.

New Version | Type the new version.
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Modified System set; you cannot change this field.
Date
Set Date Defaults to selected to apply the Modified

Date; if necessary, deselect to ignore the
date stamp on the change.

Recursively | Select to apply the changes through all
update all child Packages of the selected Package;

child deselect to apply the changes to only the

packages selected Package.

Include Defaults to selected; if the changes are to

Elements apply only to Package elements, deselect
the checkbox.

Include Defaults to selected, to update the

Element element requirements' 'Status' field;

Requirements | deselect to ignore this field.

Include Defaults to selected, to update the
Element constraints' 'Status' field; deselect to
Constraints ignore this field.

OK Click on this button to update all required

elements to the new status.
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Applying Process Guidance

Developing a model of a system or architecture can include
any number of complex processes that require common,
structured methods and carefully organized checkpoints at
important stages. Enterprise Architect helps you to quickly
set up the organization of such a process by providing a
range of Process Guidance templates, each of which
includes stages, annotated steps for the procedures at each
stage, links to supporting information, and Checklists to be
completed to ensure all the required objectives have been
achieved before starting the next stage.

Each Process Guidance template consists of an Activity
diagram, with Actions describing each step of the activity
and one or more Checklists next to each Action listing the
sub-steps. You generate a Package in the model, from a
selected Pattern, and tailor the structure to match your own
procedures. Users can then follow the procedures, starting
from the initial node and working through each step,
checking off each item on its checklists until the task is
complete.

The range of process areas and procedures supported by this
feature is extensive, and will be continually added to over
time.

Access
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Ribbon Design > Package > Insert > Insert using
Model Wizard > Process Guidance

Other Project Browser caption bar : = >
Management > Process Guidance

Project Browser caption bar : = > New
Model from Pattern > Management >
Process Guidance

Context Right-click on Package | Add a Model

Menu using Wizard > Management > Process
Guidance

Keyboard Ctrl+Shift+M > Management > Process

Shortcuts Guidance

Apply a Process Guidance Pattern

Using a Process Guidance Pattern to set up task guidelines 1s
Very easy.
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Model Patterns Diagram | Process Guidance | Application Patterns VEA Examples

Installations
Modeling Tools
Model Domains
Publishing

Model Simulation

Execution Analysis

v Y i T v

Database Engineering

A

Create Guidance Add To:  Simulations

In the 'Add To' field, click on the & icon, and locate and
select the Package to hold the task guidelines.

Then, in the main panel, click on the white arrow against the
process area to select from, and expand the groups of
Patterns until you locate the one to use. The corresponding
Pattern diagram displays in the right-hand panel.

— -
b Installations BPMN Simulation - From Example Model

[* Modeling Tools

[> Model Domains This process steps you through using a BPMN Model in the supplied EAExample repository, as a starter for viewing a

[ Publishing simulation of the model, as well as setting Break-points for debugging the model.

A Model Simulation

> Dynamic Model Simulation S

l> Executable StateMachines [ Open the EAExample.eap model supplied with Enterprise

[» SysML Simulation Architect
4 BPMN Simulation I [0 From the Project Browser open the diagram
: - - : Open EAExample [0 -Example Model Analysis and Business Madeling BPMN 2.0
5] BPMN Simulstion - From Example Model _ : Examples Process Diagrams Book Lending Example Book
Start Here

[E] BPMN Simulation - From Example Model {.. Lending Example

BPSim

[» Execution Analysis

[» Database Engineering '\5

[0 From the Ribbon: Simulate - Dynamic Simulation - open the
views

[0 -simulator = Open Simulation Window
OpenSimulationviews |—————————23 [] -Breskpoints -

Click on the Create Guidance button. In the Project
Browser, the Pattern generates a Package and an Activity
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diagram named after the Pattern, and two child Packages
containing the Checklist elements and process elements.
You can edit these objects to tailor them to your specific
process.

4 [C1BPMN Simulation - From Example
% BPMN Simulation
4 (3 Checkiists
[Bl «Checklisto Open EAExample
[l «Checklists Open Simulation vie
i

From Example

[El «Checklist= Seta >
[} «Checklists R A O 5::menmm Simulate > Dynamic Simulation - open t
[ «Checklist» v ie [0 - Simuistor > Open Simastion Window
[E] «Checklists Continue the Simuls Opensimulationviews [~~~ ~~~ 23 [ _greypnn s
4 EProcess O -tocats

® Open EAExample

® Open Simulation views

® Seta
® Ry
®y

~
un the 0 [ Select the ‘OnLoanRepy’ Activity in the diagram
= e a Set a Breakpoint e e [ Giick on the Add Breakpoint icon (green)in the.
“Breakpoints and Markers view
® Continue the Simulation
@ Done

Y ou can reduce the number of Patterns shown in the
'Process Guidance' tab, by filtering the list of Pattern groups
displayed. Click on the = icon in the panel heading to
display the 'Filter Groups' dialog, on which you can clear or
select checkboxes against each of the seven Pattern groups
to show or hide them on the t».
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The Project Status View

The Project Status view documents tasks and issues that
relate directly to the current project, and lists the statistics of
the project.

Access
Ribbon Construct > Status > Tasks and Issues >
[Project Status tab page]
Tabs
Tab Detail
Tasks Review major project tasks that require
attention.
Issues Review events, occurrences and

situations that impact on project
development and delivery. You can also
generate a document report on these 1ssue
items.
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Project Review the project statistics, on the

Statistics 'Project Statistics' tab. This simply lists
the numbers of Packages, diagrams,
elements, connectors, elements of each
type and element features of each type in
the project.

For certain items, such as element risks,
metrics and effort, if there are no
instances of that particular object type it
1s still listed but with a count of 0.

Notes

. You can add or work on an item in the 'Project Status'
view by right-clicking (context menu) or double-clicking
on the blank or completed item line

. The 'Project Status' view context menu has options for
filtering tasks and i1ssues by status; you can also rearrange
the sort-order by clicking in the title bar of the column
that the items are to be indexed on

(c) Sparx Systems 2018 Page 292 of 333



User Guide - Project Management 21 December, 2018

Project Tasks

The 'Tasks' tab of the Project Status view provides a
convenient "To Do' list of major project work items that are
not recorded elsewhere, and can be used to track events such
as requests or corrections.

Access
Ribbon Construct > Change Management >
Status > Project Status (Tasks & Issues) >
Tasks
Notes

. Right-click on the list to view the context menu, and
select to add, modify or delete tasks, or to set a status
filter

. You can re-organize the display of the listed tasks using
the List Header facilities for reported information

. To print out the currently displayed items, select the 'Print
List' context menu option

. You can transport task definitions between models using
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the 'Configure > Model > Transfer > Export Reference
Data' and 'Import Reference Data' options
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Add, Modify and Delete Tasks

This topic explains how to add, edit and delete project tasks.

Access
Ribbon Construct > Status > Task & Issues
Start > Collaborate > Calendar > Project
Tasks mode

Maintain Tasks

Ste Action
p

1 | If creating a new task:

. Double-click in a blank area of the 'Tasks' tab, or
on a cell of the Calendar

If editing an existing item:

. Double-click on the item on the '"Tasks' tab or
Calendar

The 'Task Detail' dialog displays.
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2 | Enter or update these details of the task, selecting a
value from the field's drop-down list where
appropriate:

. The task name

. Automatic naming - if you have set up automatic
naming conventions, click on the Auto button to
insert the predefined element name and counter
text; 1f you already have some text in the 'Name'
field, it is over-written by the automatic naming
text

. The task type
. The task owner

. The expected start and end date for the task (select
the checkboxes to activate the dates)

. The current status of the task
. The person this task has been assigned to
. The task priority: high, medium or low

. The expected total time for the task and the actual
time expended (in complete units; the type of unit
must be agreed across the project)

. The percentage completion

. The phase associated with this task

. A description of the task

. Any progress history appropriate to the task

3 | Click on the Apply button.
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4  To create another entry click on the New button or,
to close, click on the OK button.

5 | To delete a task:
. Right-click on the task and select the 'Delete’
option
. Click on the Yes button on the confirmation
prompt

Notes

. 'Owner' and 'Assigned' fields are filled from the Project
Authors, Resources and Project Clients
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Project Issues

Any 1dentified issues can be recorded against the current
project, using the 'Issue Detail' dialog from the 'Issues' tab of
the Project Status view. For each Issue, you record the
description, date, owner and status.

Access
Ribbon Construct > Change Management >
Status > Project Status (Tasks & Issues) >
Issues
Operations
Operation

Add, edit and delete Issues

Generate and view a rich text format report of your issue
list
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Notes

. You can transport these 1ssue definitions between models,
using the 'Configure > Model > Transfer > Export
Reference Data' and 'Import Reference Data' ribbon
options

. To print out the currently displayed items, select the 'Print
List' context menu option

. You can re-organize the display of the listed tasks using
the List Header facilities for reported information

. In the Corporate, Unified and Ultimate editions of
Enterprise Architect, if security 1s enabled you must have
'Manage Issues' permission to update and delete Issues
records

(c) Sparx Systems 2018 Page 299 of 333



User Guide - Project Management 21 December, 2018

Add, Delete and Modify Issues

You can maintain project issue records using either the:

. 'Issue Detail' dialog from the 'Issues' tab of the Project
Status view, or

. 'Project Issues' dialog
These two dialogs have very similar fields.

Access

Ribbon Construct >Change Management > Status
> Project Status (Tasks & Issues) > Issues

Maintain Project Issues

Ste | Action
Y

1 | If creating a new issue:

. On the 'Issues' tab of the 'Project Status' view,
double-click in a blank area to display the 'Issue
Detail' dialog, click on the New button
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or

. On the 'Project Issues' dialog, click on the New
button

If editing an existing item:
. On the 'Issues' tab of the 'Project Status' view,

double-click on an item to display the 'Issue
Detail' dialog

or

. On the 'Project Issues' dialog, click on the item
within the 'Project Issues & Discussion' list

2 | Enter or update these issue details, selecting a value
from the field's drop-down list where appropriate:

. The issue name

. Automatic naming - if you have set up automatic
naming conventions, click on the Auto button to
insert the predefined element name and counter
text; if you already have some text in the 'Name'
field, it 1s over-written by the automatic naming
text

. The issue priority

. The date the issue was raised

. The issue status

. The 1ssue owner

. A description of the issue

. The name of the person who resolved the issue

. The date on which the issue was resolved (select
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the checkbox to activate the date)
. Any comments on the resolution

3 | Click on the Apply button or Save button.

4 | If the 1ssue 1s closed (and all the 'Resolution’ fields
are completed), click on the Close Issue button.

5 | To create another entry click on the New button or,
to close, click on the OK button or (on the 'Project
Issues' dialog) the Close button.

6 To delete an 1ssue:

. On the 'Issues' tab, right-click on the entry and
select the 'Delete' option, then click on the Yes
button on the confirmation prompt

or

. On the 'Project Issues' dialog, click on the item in
the 'Project Issues & Discussion' list, ensure that
the 'Resolution' fields are complete, then click on
the Delete button

Notes

. You cannot delete a Closed 1ssue through the 'Project
Issues' dialog
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. You can filter the list of issues by status, to include or
exclude:
- On the 'Issues' tab, all 1ssues or just Open, Closed or
Under Review issues, using the 'Set Term
Filter' context menu option
- On the 'Project Issues' dialog, closed issues, using the
'Show Closed Issues' checkbox
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Report From Project Issues Dialog

This topic explains how to generate a document report on
your project issue records, from either the Project Status
window, or from the 'Project Issues' dialog.

Access

Ribbon Construct > Change Management >
Status > Project Status (Tasks & Issues) >
select 'Issues' tab > right-click and choose
'Create Report'

Generate a Project Issues report

Ste Action
p

1 | On the Project Status window, click on the 'Issues'
tab to show the 'Issues' page.

2 Right-click anywhere on the 'I[ssues' page and from
the context menu, choose 'Create Report'.
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The 'Save As' dialog displays.

3 | Browse for and select the appropriate file location.

In the 'File name' field, type the file name for the
report.

4 | Click on the Save button.

A status message displays when the report has been
generated.

(c) Sparx Systems 2018 Page 305 of 333



User Guide - Project Management 21 December, 2018

Report From Project Issues Tab

This topic explains how to generate a document report on
your project issue records using the 'Issues' tab of the
Project Status view.

Access

Ribbon Construct > Change Management> Status
> Project Status (Tasks & Issues) > Issues
> Right-click on Issues list > Create
Report

Generate your project issues report

Ste Action
p

1 | Right-click on the 'Issues' tab and select the 'Create
Report' option.
The 'Save As' dialog displays.

2 | Browse for and select the appropriate file location.
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In the 'File name' field, type the file name for the
report.

3 Click on the Save button.

A status message displays when the report has been
generated.

4  Click on the OK button and then on the View RTF
button.

The report displays in your default viewer.

Use to

. Generate and view a document report on project issues
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Report Output Sample

This 1s an example of the output from an Issues report.
List of Project Issues: 24-Jul-2010 9:47:00 AM

Issue Date/Owner Description Resolution

Test servers will be delayed |24/07/2014 Eloise Norman |The test server builds have been delayed | Closed: 24/07/2014 Geoffrey
because the particular (unusual) memory | Sparks
requirements to match the customer's site
are not available on shore. They are being | The machines will be built and
sourced from Singapore but it will delay the delivered using standard memory

builds and delivery of the machines. and the proprietary memory will
be added later. All performance
tests will be delayed until the
memory is available.
Public Holidays 24/07/2014 Joanna Stoat The schedule includes staff worling on Open: 24/07/2014

public holidays. A mumber of staff have
indicated that contrary to what they stated
earlier they are not available.
Compiler Version disparity  |24/07/2014 Eloise Norman |A number of the developers have Under Review: 24/07/2014
downloaded different versions of a number
of the compilers. This has lead to
unpredictable builds impacting on testing.
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Use Case Estimation

Project estimation is the task of working out how much time
and effort 1s required to build and deploy a solution.

The Use Case metrics facility in Enterprise Architect
provides a starting point for estimating project effort; using
this facility you can get a rough measure of the complexity
of a system and some indication of the effort required to
implement the model. Like all estimation techniques, Use
Case metrics requires some experience with previous
projects to 'calibrate' the process.

There 1s additional information available on Use Case
metrics on the Sparx Systems website.

Access
Ribbon Configure > Reference Data > Project
Types > Estimation Factors
Processes
Process Description
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Calibrating These values must be carefully calibrated
in order to gain the best possible
estimates:

. Technical Complexity Factors, which
are values that attempt to quantify the
difficulty and complexity of the work
in hand

. Environment Complexity Factors,
which are values that attempt to
quantify non-technical complexities
such as team experience and
knowledge

. Default Hour Rate, which sets the
number of hours per Use Case point

Estimating Once you have entered all the calibration
values, you can estimate the project
timescale through the 'Use Case Metrics'
tab of the QA ReportsView.

The estimation process also draws on
information on Use Cases recorded on the
'Resource Allocation' tab.
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Technical Complexity Factors

Technical Complexity Factors (TCFs) are used in the Use
Case Metrics estimation technique.

The EABase.eap model contains a default set of TCFs,
which you can add to or modify using the 'Estimation
Factors' dialog. This set of factors should include all factors
that could affect the technical complexity of the project
environment.

Access

Ribbon Configure > Reference Data > Project
Types > Estimation Factors > Technical
Complexity Factors

Maintain Technical Complexity Factors

Ste Action
p

1 | On the '"Technical Complexity Factors' tab, either:
. Click on the New button to add another TCF, or
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. Click on the required factor in the 'Defined
Technical Types' list to edit it (go to step 3)

2 | In the 'Factor Number' field, type the appropriate
TCF number.

3 | Inthe 'Description' field, type or edit the TCF
description.

4  In the '"Weight' field, type or edit the technical
complexity weighting.
This indicates how much technical complexity you
assign to a factor; for example, 'the system i1s to be
developed in ADA' might warrant a higher weight
than 'the system is to be a shell script'.

5 | Inthe 'Value' field, type or edit a value representing
the degree of influence the factor has on the project.

As a suggested gauge:

. 0 indicates no influence

. 3 indicates average influence
. 5 indicates strong influence

6 | Click on the Save button.

7 | Examine the 'Defined Technical Types' list, and
scroll across it to show the 'Ex Value' column
(Weight x Value).
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The summed Ex Values yield the 'Unadjusted TCF
value' (at the bottom of the dialog).

The 'Unadjusted TCF value' 1s combined with the
Environment Complexity Factors to skew the overall
complexity up or down, depending on the level of
technical complexity and the corresponding level of
environmental support.

Notes

. The TCF Weight evaluates its respective factor, but is
irrelevant to a project; the 'Value' field assesses each
factor's role within a project and, for most purposes, 1s the
only field requiring adjustment

. The supplied factors and their associated weights are
defined by the Use Case Points Method, although they can
be adjusted to suit a project's specific requirements

. You can transport the Technical Complexity Factors
between models, using the 'Configure > Model > Transfer
> Export Reference Data' and 'Import Reference Data'
ribbon options
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Environment Complexity Factors

Environment Complexity Factors (ECFs) are used in the
Use Case Metrics estimation technique.

The EABase.eap model contains a default set of ECFs,
which you can add to or modify using the 'Estimation
Factors' dialog. This set of factors should include all factors
that could affect the general design and development
environment, including team experience and knowledge,
team size, expertise and other non-functional environmental
factors.

Access

Ribbon Configure > Reference Data > Project
Types > Estimation Factors >
Environment Complexity Factors

Maintain Environment Complexity Factors

Ste Action
p
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1 | On the 'Environment Complexity Factors' tab, either:
. Click on the New button to add another ECF, or

. Click on the required factor in the 'Defined
Environment Types' list to edit it (go to step 3)

2 | In the 'Factor Number' field, type the appropriate
ECF number.

3 | Inthe 'Description' field, type or edit the ECF
description.

4 In the 'Weight' field, type or edit the environment
complexity weighting.
This indicates how much complexity you assign to a
factor.

5 | Inthe 'Value' field, type or edit a value representing
the degree of influence the factor has on the project.

As a suggested gauge:

. 0 indicates no influence

. 3 indicates average influence
. 5 indicates strong influence

6 | Click on the Save button.

7 | Examine the 'Defined Environment Types' list, and
scroll across it to show the 'Ex Value' column
(Weight x Value).
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The summed Ex Values yield the 'Unadjusted ECF'
value (at the bottom of the dialog).

The Unadjusted ECF value is combined with the
Technical Complexity Factors to skew the overall
complexity up or down, depending on the level of
technical complexity and the corresponding level of
environmental support.

Notes

. The ECF Weight evaluates its respective factor, but is
irrelevant to a project; the 'Value' field assesses each
factor's role within a project and, for most purposes, 1s the
only field requiring adjustment

. The supplied factors and their associated weights are
defined by the Use Case Points Method, although they can
be adjusted to suit a project's specific requirements

. You can transport the Environment Complexity Factors
between models, using the 'Configure > Model > Transfer
> Export Reference Data' and 'Import Reference Data'
ribbon options
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Default Hours

Setting an hourly rate 1s the most difficult factor in an
accurate estimation. Typical ranges can vary from 10 to 30
hours per Use Case point.

Studying the Use Case Points Method, from which this
variable is defined, can help you to understand its role in the
estimation and facilitate selection of a suitable initial value.

The best way to estimate this value 1s through analysis of
previous completed projects. By calculating the project
estimation on a completed project for which the Use Cases
and environment are configured within Enterprise Architect,
you can adjust the hour rate to render an appropriate value
for your unique work environment.

Access
Ribbon Configure > Reference Data > Project
Types > Estimation Factors > Default
Hour Rate

Set the default hour rate per adjusted Use
Case point
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Ste Action
p

1 | Inthe 'Duration' field, type the number of hours per
Use Case Point.

2 In the 'Hourly Rate' field, type the cost per hour.

3 Click on the Close button.

Notes

. The values you enter are stored as local settings on your
computer only

. This option is also active in the 'Lite', read-only version of
Enterprise Architect
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Estimating Project Size

Enterprise Architect uses a simple estimation technique
based on the established:

. Number of Use Cases to be built

. Difficulty level of those Use Cases
. Project environment factors and

. Build parameters

This technique 1s of value only once you have developed a
couple of known projects to use as a baseline. Please DO
NOT use the provided 'guesstimates' as a real world measure
until you have some real world base lines to measure
against.

Access

Ribbon Click on the required Package in the
Project Browser, then:

Construct > Status > QA Reports > Use
Case Metrics

Complete a Use Case Metrics Estimation
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Field

Root Package

Reload

Phase like

Keyword like

Bookmarked

Use Cases

(c) Sparx Systems 2018

Action

Confirm the root Package in the
hierarchy.

All Use Cases under this Package could
potentially be included 1n the report.

Re-run the load from the selected
Package, usually after you change the
filter criteria.

Include Use Cases with a phase that
matches the wildcard value in the field.

Use * to match any characters; for
example, 1.* for 1.1 and 1.2.

Include Use Cases with a keyword that
matches the wildcard value in the field.

Use * to match any characters.

Include all Use Cases, or only those that
are tagged, or those that are not tagged.

Check the total count of Use Cases in the
estimate.

The Use Cases and their parameters are
listed in the panel underneath this field.
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Include
Actors

Technical
Complexity
Factor

Environment
Complexity
Factor
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Select to include Actors in the estimate.

Review the parameters that describe the
degree of technical complexity of the
project.

While the 'Unadjusted TCF Value' comes
from the 'Technical Complexity Factors'
tab of the 'Estimation Factors' dialog, the
other values compose the Use Case
Points Method formula.

Modify these fields with caution.

The final project estimate is directly
proportional to the TCF.

Review the parameters that calculate the
degree of environmental complexity of
the project, from factors such as
programmer motivation or experience.

The listed parameters compose the
formula calculating the ECF, defined by
the Use Case Points Method; the only
parameter affected by the project is the
Unadjusted ECF Value, derived from the
'Environment Complexity Factors' tab of
the 'Estimation Factors' dialog.

The final project estimate 1s directly
proportional to the ECF.
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Unadjusted

Use Case
Points
(UUCP)

Ave Hours
per Use Case

Total
Estimate

Default Rate

Re-Calculate

Report

View Report
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Check the sum of the Use Case
complexity numbers.

Check the average number of hours
assigned to easy, medium and difficult
Use Cases.

You cannot change these figures.

Review the detailed breakdown of the
final figure.

You must tailor the hours per Use Case
Point figure to the level that matches your
type of project and capability based on
known previous project outcomes.

Set the default number of hours to be fed
into the final calculation.

Re-run the estimate, usually after you
change the hours or Use Case point
number.

Produce a rich text formatted report from
the current estimate.

Display the last-generated report.
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Monitor Change Events

You can automatically monitor work events in your project,
using the Model Views facility.

Guide

Aspect Detail

Model Views @ This facility enables you to:

. Automatically refresh a search in a
View at an interval that you define

. Notify you if the results of the search
change between two consecutive
searches

Y ou can therefore use Model Views to
monitor various events in the
development project, depending on how
you set up the search in a View.

Example You could set up a search to detect:

. Change items, or Issue items, so that
Enterprise Architect would notify you
as new items were created

. Element Status, Type, Phase, Version,
Priority and/or date of last update, so
that Enterprise Architect would notify
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you as items were progressed to:

- Fall 1n to the level of work
represented by the search categories

- Move out of the categories into the
next level of work

. Tagged Values, so that - again - as
items were changed to satisfy the
criteria of a sequence of searches, the
progression of items through a set of
stages could be checked and managed

Personalizati = People responsible for different stages in
on a process could have their own Model
View searches so that:

. As a development, validation or
authorization task falls due the
responsible person i1s automatically
notified, and

. When the work is complete both the
next person in line and the overseeing
manager are notified

Notes

. This facility is available in the Enterprise Architect
Corporate, Unified and Ultimate editions
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Model Watches

Enterprise Architect provides you with the facility to watch
for a range of activities linked to your user ID, across not
just one project but any or all of those to which you have
access. This helps you to stay up to date with changes,
developments and conversations in the projects in which
you are working or have an interest.

Specifically, you can set up a Watch list to notify you of:
. New model chats

. New model messages

. Recent element discussions

. Recent team reviews

. Recently flagged watched items
. Recently modified diagrams

. Recently modified elements

. Active tasks

. Tasks ending today, and/or

. Tasks overdue

You can monitor for these events in the project or projects
from a specific date onwards, or over a rolling interval of
time such as the previous seven days.

Access
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Other Start page > Recent drop-down arrow >
Configure Watched Models

Configure a Watch List

Manage Models =

Showing Activity From:  3L/08/2017 -

Relative Time
Connections New Configure Delete
Enabled Connection Name User Name Password

b test

Ste Description
P

1 | Inthe 'Showing Activity From' field, click on the
drop-down arrow and select the date from which to
start monitoring events.

If you want to accumulate information over time,
leave the 'Relative Time' checkbox unselected to
collect the data starting from the set date as the
absolute date.
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If you want to show information gathered only over
the previous fixed interval, select the checkbox. The
system then calculates the interval between the set
date and today, displaying the length of that interval
next to the date field. Adjust the selected date to give
you the interval you require. The system will then
provide information gathered only during that
interval, rolling forward.

2 | Click on the New button to add a project to the
watch list. A short menu displays, offering options to
access the project through a:

. Local file path - a browser displays through which
you locate and select the project file

. Connection Wizard - the Windows 'Data Link
Connection' dialog displays through which you
can open a model on a DBMS

. Cloud Connection - the 'Cloud Connection' dialog
displays; ensure that all the connection details are
correct

. Connection string that you have copied - the
'Connection String' dialog displays; paste the
copied string into the 'Enter Value' field and click
on the OK button

The name of the project displays in the 'Connections'
panel, with the 'Enabled' checkbox automatically
selected. At any point, if you want to drop the
project out of the watch, you can simply de-select
the 'Enabled' checkbox.
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In the 'User Name' and 'Password' fields, type the
login parameters necessary for the system to open

the watched model under your ID.

Click on the connection name and then on the
Configure button. The 'Model Watch List' dialog

displays.

Model Watch List x

Check each item you wish to view.

Display

Mew model chats

Mew model messages
Recent element discussions
Recent team reviews
Recent watched items
Recently modified diagram
Recently modified elements

Tasks active

MBI AR A A AR LS

Tasks ending today

Select All || Clear All

Click on each checkbox to select the items to
monitor, or to clear selected items as required. You
can also use the Select All button or Clear All button
to act on all items at once, and then select or clear
individual items. When you have made your
selection, click on the OK button to save the

changes.

On the 'Manage Models' dialog, click on the OK
button to save the model Watch and close the dialog.

To check for any events picked up by your watchlist,
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on the Start page click on the 'Models' drop-down
arrow and select the "Watched' option. The list of
recently-accessed projects 1s updated to show just
those included in your watchlist.

The message 'Querying watched models' displays,
followed by a login prompt for each project that has
controlled access. Type in your login parameters.

Under each project name, a summary list of the
watched items and events is displayed.

You can review the flagged items by clicking on the
watched model name and running the appropriate
Model Search or displaying the Discussions window.
This closes the original project in which you checked
the watchlist.

5 | After you have checked the Watched projects, and if
necessary, you can click on the 'Models' drop-down
arrow and select the 'Configure Watched Models'
option to update the watchlist configuration, as in
steps 1, 2 and 3.

If 1t 1s necessary to remove a project entirely from
the watchlist, on the '"Manage Models' dialog click on
the project name and on the Delete button.

If you have finished working with the watchlist,
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click on the 'Models' drop-down arrow and select the
'Recently Used' option to restore the model list to the
full list of recently-accessed models.
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